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- Windehill T
0¥ Windchill FAHHI_FOOI FIRESE FHES TR
D I 281 e 55 s (P) 3 422

WIS ALV 2 sS4, T RES RIS e — A a2 A RS
AIEBLIN . XN, ATRMEH] “ARSSEEMR” (Server Registry)
5o T8 A 53 3 1 R 25 8%

HER: BREMER RS A b ez i ss a5 MO IS5 o, B
WHE “<Tis54%>" (KNO SERVER>), RJaA AeMlbrik s awid .

1. i “THE” (Tools) > “HRE#/IFME” (Server Registry). 54T I
“HRE-B$FME” (Server Registry) X} iFHE

2. M “MRSER” (Servers) WETNR FIRIRSS a8 511 R Ik FEIIR S5 4%
3. By “BHER” (Delete). RGN EMMIN.

4. Hii “BE” (OK). UEHPEA “SCtFE S Hids” (Folder Navigator).
“HRES#EME” (Server Registry) Xf iHHEH ¥ AR 55 25 513 DL A H ST
AT 1R P A O A R 12 R 45 o
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R BRI ST AL E SO AL H =%

fif F TAEX

PDM RG]

R AEANERL B S5 2% U AEAHL AL H] Pro/ENGINEER,  #548 m) LA H]
“MR5FEMR” (Server Registry) X T HER: H T ORAF SCA IR IAAL E BE X
AAPLH o

1. B “THE” (Tools)> “HREBIFMIE” (Server Registry). 54T
“MRE-BBFME” (Server Registry) X iHHE,
2. MIRSS#FIERPERE “< ThRE% >” (KNO SERVER>),

3. i “@E” (Set). MBPHA —AFEkIR I RS AIR ST “<T
k448 >” (<NO SERVER>) ¥ & .

4. Hifi “5CH” (Close).

5. M “3CHF” (File)> “WETIEEHZR” (Set Working Directory) K i%
B IAFEH .

M55 asiEde L EIEIE “AREMBWIEME” (Server Registry) X 15 HE K AL H
BEXTIHAE R VFIEHAT DA $4E -

1) Pro/ENGINEER 7+ I} Windchill PDM Jle554% .
e F RS

3% 1y sl o 6 R 5 i 2

TREBRN AL CARARAE T Windehill PDM 454D .

FESR IR O T % T %% Pro/ENGINEER % %1 Windchill PDM i 45 #8 1) 3L A%
R, BUAERT CAIFGR T M TAEIX .

EH AR TAER, Windchill PDM R4S 884 45E T H T8 B A 10 A%
ME X 3. BB A TAEX . TAEX R EAE Pro/ENGINEER H 7 4t
T P PR R B 2 22 AN DL S AT B A A . ATl SR R ER I R )
PLAS B AR H P W s D SR R IR, AR XA B3 B ST 454

TAEX EZH T AFAE S P A s A i H . 4% PDM H -,
830 5 25 ) PDM RSS2 Hols e v SRS HE Bl R B B 1 TAEIX R, DBk
AR MGER. BHEERS RS ERITH, Bk 78250 A nT
PUE s TE . e T B, WA S SoA H P A = s i 2,
MR AT R NERAE o KL NBRAE S5 1 v 23] Windchill PDM i
%45, ARG ARG 45 LI H AR BRI UE, AR VF LA P e R U R FME
%Jﬂﬂéggﬁﬁﬂﬁm)\ CRYUE PR SR BE D Hctf i I A w] AT W s 44 4
JooaeE Tt
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Windchill PDM 45 %% IF &l i TAF X % 3] Pro/ENGINEER .
Pro/ENGINEER 2 & f1 TAEX 8 EAE 2,  DAHREAE HAh N HFE 7 o 2
FER AN R P B SRS B

. PDM RG] LLEIE 2 A TAEX . RGN ENFZ AT, D)
REARH AL, DUNE RO RN IUH G — D AR, JF SR % I
H & K S5 Bt Hodis 73 It

B THEX

7E Pro/ENGINEER 1 AU Vi a5 o A5 11 TAEX $E 4t T 523811 PDM LI RE,
BR ke AT LA ) A5 | 43 16 Pro/ENGINEER 23 . Al TAE X i 2247
AN NS IE R R 25 s ity AR DX RIS S a] . s mT DL A R 4548 URL M
PRAZYEAS (541 Microsoft Internet Explorer) A TAEX . {Hig, 7EIX
Pl OL R, B LRETT ) R4S At 1 TAE X R A 23 m] . Rk, a7 H %) PDM
PRAVER DI HAURBE T e R & A3 . A V(S B, S Wi AR
PST TAEIXAE 2-13 505 HR R N 200 2 R S7 0] B s (0 Th e LAt

BETHEX
PSR H I % R 55 s e, TR T AR AG 50 A H ARl T A
DX R A7 AT JLAT o At n] DU 55 IR 55 4% B kb AT AT, JFAER
JREFHEL TAE. ARFENGER, HS WELYs ] TAEXAE 2-13 5015
M2 TAEX ThREITig.

TAEX AT {E Pro/ENGINEER 1 Windchill PDM 25 %% 2 [ i 55 M
Windchill PDM Jil 55 % K12 sl ie i) A A 20 A0 ik AR X S8 . 1 i 10kt
TR 3 S H e A Y VR T LB B2 A\ Pro/ENGINEER i3, {HH 4 x4k
Do n G H TAEX o V8 T Ul ik N 00 B s h & B/ s 8) 1
VEX I 5248 1%) PDM Zhiig, (HARERGS) TAEX . Mar iy b s s & F 1 TAEX
BB A TAEIX AL T 2 BRI fE

WEER “THEX” (Workspaces) B K B 1EIN

BTN, #E10 IS FrameMaker 1% TAEX 20, SR7Ew S H T 2onikde
] Windchill H /" &£ 52 17,  Solution Name H' ¥ “ T/EX”
(Workspaces) ff# (35 L FSCEDIR LY “RIOTHEX” My
Workspaces) UL P8R AnlH o i DL N Ak Rk e B 2o 1 1L T

1. £ “FER” (Home) LR, et “SEHMEF” (Utilities) #H%, R
JRikHE “EHIEIM” (Preferences) #iik. I “HwiEMH - EHET” (Edit
User Preferences) Ui [f] .

2. iy “8/R” (Display), A5+ “CAD- TIEX” (CAD
Workspace) & 4%. HIL “CAD - T{EX” (CAD Workspace) [X 1 .
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3. W EIEHE, LURH CAD LAEX, REHid “Big” (0K). “THE
X” (Workspace) #f4 H Hi {4 ] I bR 30730 BB I
THEXEH
FEATT Y, R 2 o) TAEDCE B ARSI . {5 B
Bl TAEX
IR TAEIX
HHOEs) LAEX
R RIS TAE X
B2 TAEIX Dfie
TRE O A7 A P
M Pro/ENGINEER @14 T {EX

AT eSS 4 BRI 2 A TR . A “BRSG3EMR” (Server
Registry) X[ THHE F1¥) “FEE” (New) a2 17EF Ik s54 BAVESHT TAEX . B
TAEX K A BRI 8 TAEX .

LAEHT AR

1. #idi “TE” (Tools)> “RE-2$1FME” (Server Registry). HFif]JF
“PRES2$TEME” (Server Registry) X ifHE .,

2. MIRSSARPIR T, JEFEAEIL EAIEUH TR RS54

3. fF “HREE3IEBN TAEZE)” (Server Active Workspace) #5r, i
“BFrE” (New). HIHF “fIEFH LIEZME” (Create New Workspace)
X HE .

4. R TAEX A FRIF N “ ETF3C” (Context) FI&HZEFE 1 H 3.

5. B “BE” (OK). B TAEXKG I “ RS 283E3h TAE= A7
(Server Active Workspace) #|5K DL “SCHFJe 34y 7 (Folder
Navigator) H,

M Windchill H 1)5 TAEX
A AT LLLZE Windehill FPAIZE TAEX

1. M\ “BEITIEX” (My Workspaces) i+, #idi “GJ&” (Create).

“BIEEF TAEX” (Create New Workspace) Ul [fIRF 2 HH o
2. EINARRAOELE, O TAEXES BRI
3. Hili “BiE” (Ok). Hr LAEX ST I

PDM RG] 2-11



R QU B AR O ARE 3 TAEX

MR LAEIX
AU “BRITAEX” (My Workspaces) B IHER LAEX .
1. RS TAEX, Bl B R SCEmi-R B “THEX” (Workspaces)
T A TAEXIIRE “EFITHEX” (My Workspaces) UL 2
HI
2. IEFREMER T TAERX FF R RAS TR ) “HIER”  (Delete).
T AE X EAI A B A 0
TR TAEX, A2y /2 LLR 451
o IBICTEMIBRES) TAEX .
o VARG AR I H B TAEX . R ‘”ﬁﬁf’ﬁ#)\lﬁﬁﬁﬁiﬁﬁfﬁﬁlﬁﬁ
TAEH@JIYEEEP HIEA B IH MG R, S AR A
3-30 UL,
B RE B TAE X

A Windchill fl45 a3 #0 BRI Fdg e —/ME8 TAEX o 1580 TAEX &1
JA AT PDM #4F 1) H bx TAEX . 7E Pro/ENGINEER 21 /8], f&0] LA
ffH “TAHEX” (Workspaces) LI 8 503G s TAEX

P B R — RS2 L AR TIEX
1. i “TR” (Tools) > “MREB[/IFME” (Sever Registry). ¥F1 T
“PR&S2$EME” (Server Registry) X iFHE .,

2. BEHGEAFIRTAERX, BEHRAT LT — IR A

— HEERESBHXRERLE —F “MREEE” (Server) LR, 7
“MRE52$IEZN THESH” (Server Active Workspace) 41| HE ik $%
AFERTAEX, REHT “BIE” (Activate).

TAEX A E St

o WREPEE R RS Ay LA TAEX, BRI TAEX 20,
Pro/ENGINEER ¥k & iEH I H .

o A RO HAB AR 25 28 L HA TAEIX, W) Pro/ENGINEER A4 H 3
WS UEHRIE o 0T DO 218 I H ARAE 2 TAEX

HER: 7E Windchill 1, ErTLIN “TRFTIEX” (My Workspaces) U [
s TAEX
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TR FONT AL T AR X

IEWATETHATER, FMRES4E ERES) TAEX &R 2 H i Fk R VR
BT E o /E Pro/ENGINEER ik A X W0 a4 h & 1 30 TAE X 324t T 5¢
A1) PDM Bfig, RO E AT AVT 1) A0 5 | 45 ) Pro/ENGINEER 231, ASHl T
VEDX AT NS IR i Ik 25 A i AR DX AT A L3 ). 8t mT DA
FI %% %% URL 7F A #4823 Pro/ENGINEER 2 i (F 007 30 S5 38 (43l

Microsoft Internet Explorer) & F TAEIX . {H&, FEXFMEHT, & AE
U7 0] Ik 5% 2% v 1K) TAE X R A SL23 8] . R, AT H ) PDM #8480 JF BAXR

BT e HES AP . HRFEANE R, 1HS W AEX 7 S S A %A
FE 2-16 GU—15 PRI N 200 Vi s R0 37 0] W 4 1R = FR RN 2R LR AR

B ) TARX
U A LI 208 BT 5% o B, AT AR T AR BB 2 b sl ) A T AT
DX e A7 I H LA o ‘”&TU@%%H&”\%&%%I&%IVE JFAER
JE R AR AT

DA 2K T 5 RS A8 B AT AR — S8 i Sy = i

o SRS ASHIERRITR, KAWL

o RINCVERET PDM #4E (Bt Rl Bk, RIBRRME T4 .

o BSZCTAEN, WA BT AN SE L AT PAYS ) TAEXIH -
— Pro/ENGINEER Wildfire “3Cf£” (File)> “4TFF” (Open) X ififE

o
— U FHISS” (Folder Navigator) Pk £ TAF X IAE ik A2\
FBEAS TP IFR “3XEFIER”  (File List) HTML UL [

EE: U7 (File)> “4TFF” (Open) X iHHE LI H K RRCAS / /)
AR KL

o YT HHEH) PDM R4, En]HET 5 Pro/ENGINEER [F)8¢ ¥ ik .

« W Pro/ENGINEER Wildfire & F' HLAVF v E I 45 2% H 3R15 T e vFn]
UE,  DUFE S VF AT IR IR 45w W T 3E#20,  Pro/ENGINEER K23 i%:45, Kl
BT ERVERE. 41 Pro/ENGINEER Wildfire 5 Windchill Ik 45 %%
X 21 by T e A s, U2 ] Pro/ENGINEER 852 VF AT AIE .

o fERAT B (FERE SRS ASER LR AT, AR AR A IR SS i
APEP IR LN (R gAr ) Prifr Lz .

« WERCZMER T TAEX RS Sim L, AR SRS As EERRY, W4
PR G AE (AT I H R A X
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o YRGS BEFAELLNT, W AEAAAE DB MUK CAD LR U2 B RH
CAD #i#, B G HT CAD AL I [R5 R 1) A X 1 IR 55 45 ity
PAFEM . EROZAEHBT “Eav s Thae, SLIhRES T A8l
PELLFE AR IS CAD X% . CAD BRI FR AR b i, Hili T
Pro/ENGINEER ] H 1], ‘& # R $r s bE .

o WIRAEMRSS BN AR O F ) 8) Pro/ENGINEER &% (/b HA—
ANCEEM M TAEXD , 8 Wk e G W RIWIT T 5 4 28 1%
B, IBAAE RS 2 T AE LI, Pro/ENGINEER AN S Bon TAEX .

H T Ui TAEX, NPT F TR & RS54 vl A A, ol
“CH” (File) > “¥TFF” (Open). “3CHF” (File)> “HE” (New). 1T
A FH () PDM 454 ek i i) “BRS528FMR” (Server Registry). — E.
HATERE,  Pro/ENGINEER #4 W — 45 15 FIR 5 4% vl FH AW B o sl
BUE, ALV TAEX

BN LR

B RSS2 BT AR, WEHAT LU NI AR

1. 7F Pro/ENGINEER Wildfire “fR&#$7FME” (Server Registry) I “fR
%287 (Server) MEWiF I, P HIRSS sty “BETHE”
(Work Offline).

RYH R EAER R ZRS 25 ) TAEX I H B N A CRIE 80 &
HEAFBERED o “HREBBIEME” (Server Registry) 1) “ARE2%”

(Servers) GHSH “IRAE” (Status) FIIAES B8 “HE” (Offline).

EE: “BZ&T/E” (Work Offline) 1441 - B8 T 4T £F £ 1K 55 25
T Oa B iissds, RSB E R “ELT/E” (Work
Online).

BEAAESRAS

2-14

TR S5 AR PR LRAS, W IAT L IR

1. 7F Pro/ENGINEER Wildfire “fR&2$1FME” (Server Registry) 1] “HR
%287 (Server) Uik b, EREUFIELIIRS A “HERTAE”
(Work Online).

WA MRS TH, ERGEPER, H “RE” (Status) 51 FEHRE Sy
“YEZE” (Online).

PERE: WIS BRI, SRS AT O ELIRGS B
ik L.

¥ Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill 7 [¥] Pro/ENGINEER # 4 & HL 15 5



2. WURFBNEEAD), B T/EXK “F2P I/EZR” (Synchronize
Workspace) 7%, FIF RS #% 10] 8 O 20 & A2 (1A An] B8 24 S0 B A b =
AT, IR b

3. WURTFE, EMA “EdZ” (Rename) fir A AH N X TAEIX B £k N 61

I H Ay 4
R FER
FEANE I AR X A8 75 B8 F A Ml Bt b 0 28 RAEAR ISR . 3kl
AERIH o M WIRRR FHZEAF . Pro/ENGINEER $21LLR TR HLA
WA R B AR
o BE AR S II AL E
o R EIEGAT RN O RS AT R O] g A A 1)
o SRR AR /N R KE
o WERRIRS A T TR 47T H
o ERRERRE TAEX T A7 H
T SRR B AR
BRAIEOLR, T TAEX #2400 Mb 1) SO 2 A7 ik 48 ]
config.pro dm_cache_size it B0, W] DUE U I Z2 A7 K/ MR I K E . i
NI I IR 1 B
BA ISR S

1. #is “THE” (Tools)> “R4-2$1FME” (Server Registry). Fif]JF
“RRESZ$EME” (Server Registry) X iFHE .,

2. By “BEHEZEHE” (Cache) LUk, “BEEZEL” (Cache) LT UK
TF, HAP BRI E A

- TR REEZA K/
- O B
— A A

T8 BRAF A AT X iy T A

1. i “THE” (Tools) > “HRE#/IFME” (Server Registry). 54T I
“HRE-B$FME” (Server Registry) X iFHE .,

2. Huli “REBEAE” (Cache) LT, “FEZEAF” (Cache) IUHIAFITIT-

3. By “EEZfETE” (Cache Tools). H1TJT “HESHFEEH”
(Cache Management) X {5 HE .
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4. Wi “fIE” (Location) FIKH kS48 551010 “+7 Kbr., “frE”
(Location) 713K e 7, HWoRik e IkSs 48 LT LIEX.

5. ERFETAEXIFRT “TERREESES” (Clear Cache). 1L TIEX M
TH AW % o

SEa
ik “ERE2BEME” (Server Registry) X iFHE 0] DA AT K2 H0 TAE X &
FEIIRE  (MER TAEXBRARM -
BENEM RS 23 SLFF 2 TAEX o 38 TAEX &85 8447 PDM ##
ERH AR TAEIX . #F Pro/ENGINEER 2 & #AR], T LMEH  “ R4S M
F” (Server Registry) X[ 1HHE & oG 2h TAEX .
REAR S 0 T el B AT B TAE X, BRI T TAEIX R -~ 51
TAER P S RIEEA R
“THEX” (Workspace) UL A “ANAFIXE: TEXER, TEX TR
PRI TARD et o FEATI T, S0KE 1A AR 1940 &) LA SAE &AN X s mp
PATWR LA
TAEX 38
TAER SEHAL T TAEX TS, JF HA S ol N TAEX R R E . 1T
1@&%%@/&\ “ i,fq: ” (FllE)\ I3 %ﬁﬁ-ﬂ ”» (Edlt) %[] I3 m ”» (VleW) %ﬁ .
“ICHE” (File) et 7 L T-ANEUH 0 H A EI0 H AL R s A .
“URiR” (Edit) SRS I TEIT I E LA H A TAE X 1 e 10 (1) 45
E. “FE” (View) KPS HTEE “HEEFHSR” (Event Manager) 1)
Bk, FHEERTIES) TAEX RN EREYIR,
Fra TE1T FHEEE
TH wEHE
imig E
i
£ i XHE
i BEhEBEER{Y
EiHREE
L
FINELEE TiEEB®ERm
EHw S
FEpF:
I
[6]3F TiEE
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EEE TAEX A, E R “3cfE” (File)> “Hige” (New), LnJ LAz
Br CAD XA ECHT B AF. Wt iesE “3CF” (File)> “4TH” (Open), 0]
DL FRAE T LAFT IR SR AN s 100 H (145 B 0TIl /£ Pro/ENGINEER 14T Jf—

AERZAS CAD SCRYRTY SO, s 4T IF 5% 2 1 H (1) ProductView K4

ARG TAEX PSR I i fe s

AT T AR XS LR

PDM RG]

EiEsh TAE XML T sh TAER R 74, ROV IRE s TAER R
Pro/ENGINEER £ & F1Z LRl e A7 KL, RILAE “SC” (File) 2%
B EYRAE FH AR 2B T

“fIEHr CAD LFY” (Creating a new CAD document)

+  “ff Pro/ENGINEER "'§] JF#57” (Opening a model in Pro/ENGINEER)
o “k#&” (Upload)

< W

o “[APTAEAEM)” (Synchronize Workspace)

FIRE, ARESh CAEXH) “4h%8” (Edit) SCHRGEHE LR LET:

)

o “HINKBETAE” (Auto Associate Parts)

o “ICEK” (Associate)

«  “JrEy” (Disassociate)

MBRST 0 B 485 A A 1) T AEIXAX 5 Windchill 2 2RIk 55 45 3 TAE X Py 25
A SR AF ) AT o S B TETGURH 1t = B T3 3l AR XI5

12 “3CHE” (File) Sic 5 JoiZAd i LR &30

o “fEHr CAD X#4” (Creating a new CAD document)
e “L#” (Upload)

o “IAPTAEZ A" (Synchronize Workspace)

HE: “4TH” (Open)> “4E Pro/Engineer” (in Pro/Engineer) &I ZE T
SHL_E 255 Pro/ENGINEER (1500 A4 H

FERST I WAs PR B TAEXH) “Gis”  (Edit) & FLIE 00515 8) TAEX )
S IEITAR[A o
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THEXTAE

TARX T AFPAL T TARXSERIE Ny TAFX THAAR S i A AR
X IhfE. 5VF2ERAE 00 1 T HRAS R, AR TR A7)
RO (W5 - BE) ARG GRAE - X5 o KA BT
MG T AR AR e TR H 5 T A (DX (A 2 A2 AR X
QU H o ZAE IR O8> TAEX T HAL P ST, 15 IEH TAEIX
TP —ADREAIHE, AR5 T HA P R EPATIERAE . R
BeAE, EORGEFEIH, Wi s W i, s e sl &N e,
RS VRGN SGIERE NI A e . B A X sk P i
AT Fhoifg, R i@ e hag. R 7issh TAEX THA.

H =
IIEL  FEER
TEEL

B Ay Hy fy = | & |
ta# B E oy sl B SRR BT fEE cao
Bk I

TAEX A%

5 TAFX 4, ARG TAF X A T HRA RIS S 3 AR X & 107
o FEARIE SN TAE R VAT LU R A

. “L#” (Upload)

. HH

o “HBIKRESTM” (Auto Associate Parts)

«  “fil# CAD 4" (Create CAD Document)
LEAMSZ I B 25 A ) AR AR AL LU T HA A %
o “L#” (Upload)

s “fil# CAD 3(FY4” (Create CAD Document)

TAEX “TiFIR” (Item List) A H & G B A F 88 &A1 H 151
. TAEX “TH%IFE” (Item List) ER LA H KR, Hph Rk
By XA BRARRPIRGL . SEEPE, TIEX “IFFR” (Item List) £
6 ARV I PR B AT BAE R T .
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R T WP T AR X “HFIR” (tem List) FA% h 030 H , JfB0]
T “B4E” (Actions) FH I EAR

“RE” (Status) B TAER SR HE R iR
B i FERTIMBBIRE. R S RE R
(All) EEHEL ;—h _
4% THER S r He | 013
BB — ———
H. I % [J 000000DOOG 0000000006, prt & ;
I [ CUPFRT cup. prt @ [Efy
PETEENN C& (1 LUDPRT lid. prt @ Ektty
;E;}%E?Wi& r ([l LUNCH_TRAY ASM lunch_tray.asm @ [BfEL
EE: EALE @ [ PISTON_PIN.PRT piston_pinprt @ Bk '
A AR R : .
MRE (Ctr) 5 @ [ PLATE.PRT plate.prt @ BREL.  «gpe” (Actions) 51E
—YERE (Shift) kS A TIERXRAE T
R (Type) ShESEER HAREAGTIRAE.
TR ARAE
“PRPE” (Actions) H1 & —/MTEIbR, FEAEIARRR AT H AT EEAE .
KRR, AT DL AT — A bR I AT IR IR E . LR 2 bR
YES S SEEINPIIE
@ — i ERR AT LA IR E B4 S L
Im — i EIAR S LLZE Pro/ENGINEER 3] 13 H
e — 5 b B AR AT PALE ProductView HH 4T FFIIH .
8, — R RS AT OTAR I H A R .
#y, — P RS AT LOTAR I H AR o
i — bR A AR .
ma

TAEX I FHEAT LR =S AN A X e
o DA — TAEX A S rT A AR DR AT T AT #A
o TAEX AR — TAEX TR S R A TAEX 6.

o IAEIX “TF|FE” (Item List) X% — TAEX “TNF|FR” (Item List) &
S BIEBRER MBS RIPTABH MR ek, TEX “DzR”
(Item List) kg A R AL T 5 b th AN 100 H AHOC 44T
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HEEITEXFPRIAE

Pila] TAEIX

ORI R AR VR 2 ot s . BEERde e T RE A L f LT AN A
FER R, SR TR AR AT R AR, O T B AR
ERIYSEEPSE

TR T RS 4s 5, AT LN “SCf S48 7 (Folder Navigator) 195 i)
IR 55 A IS B TAEIX

TR BV RIRSS & 103G ) TAEXN, ] DUE A 32 A BRI .
REAEHIREAVE T A AR DCERAE, 5% 55 48 B0 TR S5 4 o

BN A IFRAR” (Folder Navigator) W4 I TAEX
1. 76 “CHEISFHie” (Folder Navigator) H 2 kIR 45 o M G 8 TAEX
2. B TAEX Rl TAEX A 29K I AE Pro/ENGINEER 3B #5 H

B TAEX I H HEy

AT TR AR X A A AL, e nT LA iRy P A 30 1 1 0 2 b
X AR H AT HE -

FHAAS AL I B o 0 H s

KTREUE

2-20

Pro/ENGINEER Wildfire H () R 2 ek (45 TAEX “TFIR” (Item
List) X&) BArABARE, MRS BosmiH gk, AT woRh
BRI R E 10 H 2R 8, i ] “RIEVEEES” (Table View
Manager), %&0] DUE 6l TAEX DU /R B8 0 10 5 AR & Pk

T AR BRI b Bt A R B R IR R, BERRAEAT R A T
FEZPR I TIA AR . SRR . AR B AT e (AL B
Htl S ae ) AR BB . Ik, RN BEEME B LA 52
LT —AWEEAT R B, iy Bk R VR RS . X BT HERP LA R
XHAT PN T A R E AR S AL, A B S R 1 H AR

RS BT ARG ERARL I, L dn e o) GEL R 3]
T I JE D, IF T DU SRR A R BLAEAT FR A R € T H .
W LUEFE RGP AL, AT RAR PR A ) “REE Y (View) BT
%?ﬁqﬂﬂﬂjTﬁ%%ﬂl’& JH RV B O3t mT LUK 8 2R S I 21 86 31

# Pro/ENGINEER Wildfire &5 Windchill At ] Windchill H1/] Pro/ENGINEER (4 & BLFi5 7



EERENE

ARG R A

PDM RG]

BRI K ZE T el b

X Wk ae e i i NS P G Brine 2 N TR W S R (RS ST
(R B AL

AL B AR5, Hoh L FE R bl sl B Oe L E
gl P P A BOAR I, BLAC AN S P B0 HAN 30 7 vl LY
F P e SCHRIREIE
ANfiE INARAE T A% T I3 LA 271

“TRRML” (Item Status)

“IH A7 (Item Type)

RGN LAZ S AU I o

AR LA BB IS, R AR LR — A, R
WAL N 1t

n DU RS LI o R B T AL, AL 2 = iR ks LA
DU A% 10 MR P A 20 ER AL

FER: LIEMBR ARG FAE PG w] DUINBRAE 2E G a0 e i

A DADRAE BT AR AN G 4 o R RAR AL I, O LT ARG OR (1 2 3 b A
XL

MRS KT B -

1.

MEHEARER ) “FE” (View) gk P g PR e .

2. RASARFIEAT B AR s ML I A A5 K 1) LA LA B ARV BT AR IR I e A T

B, AT ], A “RIEVLEIE S (Table View
Manager) £l 2 5 il L 1&] o

EAT LA R AL, B QIR IRL IR, DURE o I S A (1 57
Wiiye, VAR TR o Bon B e A T AR UE . AEBAT AR OGHRAE RS, ST
LG “HET (View) SIRSHANTZHD BEAT G4 -

AT LR DT WL 5347 BT, A SO AL I DL R ORE L0 B A A% (17
LA
AU R R ST QI E BRI . “HLE” (View) FHusIZRrh A,

TEORAF AL . REAS T AT LAER RGP L B D3 Bt R el DA R Al
(i A S G AL
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Vi ) FEAS AR B B B g
T ) 5 R [ L -
1. EER R
2. fERM bR R R, il B

“REVEEER” (Table View Manager) K241 77, #EIVIRERT
RIS RS . YT SR BN,

FERE: W TN “REVEEHEEE” (Table View Manager) IH i id (1)
BTG LAAM R LA, TGV I T 2 o ) o 8 £

FRISWEE S

FREETE 5T
% ]
e jalli=3
- ER | [ v s [oow [us
™ Demo B3 2 THEEIE demo 2005/0/11 14:38
[T MyCustomiew B THEETFE  demo 2005410411 13:46  Supports my work
[C R CAD I mE IEEIE FE 2005/08/11 13:48  System view far Workspace...
o RERY mE ITEERFE i 2005/08/11 13:48  System view for Workspace,_..
[~ +EilE = LEETIR i 20050811 13:48  System view for Warkspace,..
el FH A% A0 11 7 B8
“REVEETEIR” (Table View Manager) 51|} 7 1] LLEFE LLAAAT LN — 0
A I 3L A B

- “BAER” (Save As) Wl — Hk s (LIS A7k B HLIE)

o “YURER” (Edit) & — Gk E E

o “MBR” (Delete) = — MHERIEE IV AT LA E £/ MHLIEL .
.« “WOE” (Activate) 21 — I E KL I O B RS (K3 S R
JEAN, “RUER” (Create) B A fu VIS OIEH IK RAWLIE ,

fE “RIEFVEEEEZR” (Table View Manager) 1 5. “BFEA4” (Save As)
‘g B “BIE” (Create) &5 I, Kl “BIERIEME” (Create Table

View) % L. (W Hd “4iig” (Bdit) 7, HINE DKL HRN “HiE
FHAWE” (Edit Table View), {H'e L0 H M 7 REER- . ) HE
1K B0 228 g R A% PRI R 0 oM U = AN D R
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“BWEAR” (Set Name) — I T-Ha7E HLIE 144 B AN B B

“BEZ” (Set Columns) — H]T-LEHF BB/ (151 IF 0 kAT HE?
“BELIESR” (Set Filters) — JI TR E MRSzl pir 22 7 1) 1 H
LR ST AN R 4 5 | s e 1 B 3t sl 4R R AR AL B R i A7 2D B

SIERISHAE

i
ST 1 EBEK 2 BB 3 BETER

*H#R: |

F:  LIERETIF=
. &

SE1: REAK

ROV B, ERTDMEH L R P BORTEE  (WERIEAEQIED B2 s
CUSRIEAEG0 SR ) LI K42 FR AN B -

“RFR” (Name) — 5 E LM AAFR  GRASFIH P BRI 44 R b 200 nE— D
“FA” (Table) — AL PTG HIIRAS  CR AT 9iR 7B
“PiBH” (Description) (RJiE) — AL

HER: FHALUERE “KRMEIEFAF” (Publish to all users) 5 EHELL
faxe BT F P ] i FH SRR

s “F—g” (Next) DIgka D “2. &EF|” (2: Set Columns).
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PR 2: §EY

flEREWE

[y I

£l 2 @EN

ol %7 ERRA

FgER: |gg5 |

Bt [2% -

ETX -

TR

wE E=T

T R R e

11T STHETR
IR FITERF #1E

52T LR - #am | (L
B WA

= WE: <] | LioEw AT
SURT A IS

SRR £ TR
S B4 1D

Heetias

&

i i _

e ~|

e 2 0, Rl LR 2 WoR M F M BRIy . “RATAFI” (Available
Columns) (VL) FIEE i, 45 R VPR T 5B AT A
A “BIRK%]” (Displayed Columns) X1, 7200k A VF BB E WoR
BRI o

T LR SRR 2 A o T 5
1. M “TWH%)” (Available Columns) X35 B 5L o 51 . 4 A] LU
Mk (EH Cr FNEHER: (A Shift) .

IR EA I A RS, BT RE & AE “ BnE3”
(Displayed Columns) DX 3. #0] LA LU A7 —Riad g n] H
HIHIH 3

— f£ “TNHZKAE” (Item Type) 2 “XJ %KM (Object Type) K741
b, EPEDUH M. B TR, D] se R E A R R T
DL &2 :

“HE” (A (ERDO

“Workgroup Manager CAD 3 1%” (Workgroup Manager CAD
Document)
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“Workgroup Manager CAD 3CR4#EAR ” (Workgroup Manager CAD
Document Master)

s
S
PP B Es
AP FB A HoAt 72
WTDocument
— f£ “BY” (Attributes) AR TIEPERIERA . IETELE.
“HEE” Al (BRI
“R4” (System) (FiAIfk)
“n[Z8” (Soft)
“ZRIN” (Miscellaneous)

2. By “USin>” (Add >) FEEM YIS ] “BREIF1” (Displayed
Columns) XIFH. (i “BBR <” (Remove <) ¥ “ BIREIFI”
(Displayed Columns) [X Ik )ik 2 5% sh %) “T]F%)]” (Available
Columns) X1k,

3. fF “B/RHI%]” (Displayed Columns) X1+, M _EF| T ke T
SEBRFAS TR N AE B Y . Bl “m B” (Up) Bt ) m L
®ah—A4r, B “TRE” (Top) ¥ ARz 2FR M. HH “mT”
(Down) FiL M50 N sh—47, TH “JEE” (Bottom) ¥ 51| # 5) 3
TR TR o

4. Tefae TE SR R IENT )G, GHRd “TF—22” (Next) LIgkgb
BRO“3: WEILIESR” (3: Set Filters).
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SE]3: wETIES

RIS IAE

OOm
S| 1 BEEH 2 WE : GEAED

RN R B 4L

= ¢ N EBM  EEF M
Wi kE s RO
b
e
IR E
BT
PR FRER
B
THER - 7 hn =
B
Sl |
£
EiREH
EFY
g 48
e
A

[e% ] [ws ]

TEH 3 2, SEn] LR E BN SRAE R AR R A AT T Bon I H . “AT I8
£” (Available Attributes) 4145 & I A2 70, BEIEGE PR DAEGS In 2147 142 1)
“NFRIEH:” (Applied Attributes) XK+ .

AL N i R e AT T

1. M “HTHKBEM” (Available Attributes) "% — N Tl £ AT
H R I H g M. BRIATE DL N ARG R @M. LR ik %,

LN EIEIN, BRI DR 2 SORT,  DURLAE T i 5 It
H B EARHER 7 B

2. {EEUBTRM NN, 1AL K AR RIS AT . A0S AT
“ZT” (Equal to)
“AH%” (Not Equal to)
“MT7 (Between) CHUE T HIEHD
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TR B

PDM RG]

3. EFEAAHE. BuRTEYE, EHT BTN
—  ERWHIR — e RE RO BMEN IR, CAD SCRYRAY
— WANTFBC— . AR BUE. ST, RA. AZUID
Rl DA SCAR AT B TERCAT (%) BOCA 745 Sl AT 1417 -
—  HP/NEA — NS A A H B E R H D TR .
FESCLERGOL N, BN BERT RE AV BEE H Ve B ey o2 H .

4. Hii “BRin>” (Add>) M “FTHBEME” (Available Attributes) [X
e AR N2 “NARIEM” (Applied Attributes) 513 1.

5. MRTEEF L LI 3 M 4 Dgkei @ ing] “NAREM” (Applied
Attributes) X1+,

6. ¢ “NHAMKEM” (Applied Attributes) 1) | 4w AT L JEF N, J5
HEARIE BRI, AREAEH “RARIBHE” (Applied Attributes) X35
LS EAFRE F s, JHsds “NA” (Apply)s

TR AEREFES AU, A N R BE oo M o

7. EPEICHIMRLBERIN, AR)E il “RHER” (Remove) LUMIER (AT JEHI 1
RLER .

8. kP “AFFILA” (Match All) SIEHE LU < 5 RN A1 b (K AT A0
JUIHRVCE R AR LETR H o G RIS RRRE U 2 A R UL
FC (R BT AT T H AR 2 s K

9. Huili “SEM” (Fimish) LU RALIEI QI / i oxih, JFiRIDIE] “RAEH
EEFESR” (Table View Manager).

FER: RO N, LiE R T RE S EORBCE 2R s E 10
HIRM, filtn, EACERATERER (BB W&, WU FRERCE A
“ICRESM Ty CAD EET A “CANSERERIIH ) True”

FE AR B AN RAE DU A AR BRI IS, 7 A o i A R DL
XA REAR R R, WURAE BG4 TS 0L, REuki(E “IR%)
&” (Item List) LM i 2 Wor P51, X8| i 5 R os IR BLIN AT 5
FRNTEOL &, ARGUH AR B 3% S EHE S ) A7 T AT H S8R Pl b 51 1)
Lo BVEATHREL, ARRCARBAES TS L, T RSE7s s om0

R,

BEAh, ARBUAT A HHs e A oI b TR IR AT ERAR I I T 224 R
SEBRAFTHE A T IR A PR 5 .
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DU B RARGLE QT

“ILEDRAL” (Share Status)
“HARAS " (General Status)
“CIBEMIPIRE” (Modified Status)

“CIRWBUEE” (Status Messages)

“ILEDRWL” (Share Status)

“FEERM” (Share Status) 71 W7 T H 8005 i H 5 PDM AHC I TRIR
FIAF5, UERHINT

£ — L HIH  (§UEH T Windchill PDMLink)
= — L= H PDM ({i&H T Windchill ProjectLink)
® — [ PDM & (f\& M T Windchill ProjectLink)

“CHAIRA” (General Status)

“HIRAE” (General Status) 51l o T H THRIHIUE HORE MRS, Ui
WR:

4 — R

o — LS A TAER AR (TR R Scrp vy il (f) AR X A
(L EIRYE )

#* — Bt
— mn R

— KRHEE—ADUH (X3EHH T Windchill PDMLink 1 Winchill
Foundation & PDM)

3 —BUE (DUEHTAERA & & A 1 TAEX ARG, ANTE
AT

“OBEMITIRE” (Modified Status)

“CREHHRE” (Modified Status) 5] T2 15 O AT TAEX P MBS T
T, RUE

— OBk
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“CIRWAE B (Status Messages)

BEEWHRER

i H AR B

PDM RG]

RIS E” (Status Messages) 140 & FH 48 B 1 S5 K R0 7 5 F 18 1R 1°F
T, IRUEYY BAR A T AL I RS R AT HAB L. R 2 4 EOE H THE
T, 0SS e T R AT S . IRk B A B IR S L )
SR T HEUR, W™ R U5 T BT 3 i R

R4 2 i BAR LR R T HBOR U N (R ™ ERE R 1 SR P HEP) -

o — UEMR: <EERZUPTESCRHEE >

o O —ERR: <EEE S ULIIME SO S >

o AR < PR R ULIIME SO S >

o B —f(5E: <EHRUNHMESCRHE >

I I B TARED SRR AT P B EAR @, Rl AU R I H (5
SO OORRfE “ PR R B0 “JaPE” 0D o T H (145 6 5 75 10
HEARAGE CRATAHRIMER) . IFRAL T I H AT 3R AR 1 41
o WU IR IS B O 0 CAEX R RS (B, R IH D 5]
e FI A (i, R4S CAD SCRYD , A5 RITHEIFAMILRT Py 2577 fie
PSR [, BRI SR BRIk DL, J0 K mT A mT REARAT P AN o

EE: B TAEX S CAD SCRY AT REAE T AL AT, fr LA
Pro/ENGINEER Wildfire B nJ DA 7 TAE XA BT, o n] BLE R 2 3643 1)
U AR i H A B R o 5 TAER A . (R
SRAE T LUK SRR R s N T AR, ARSI A I, Pt e ATk
HHEA R ARG ST . )

FETAER A, sty @, W2y SR AT TAEX MR E B,
RN RILAE MR T @, AT DA I 3001 23 525 [ R (19 £ 5L 0T
Mo AEREEN, TAEX RGBT b8l “g1 TER - <3 >
MIEIA" (Workspace Copy of <item>). Fr&l I [HI A2 45 i) 2 T2 3245 (B il A

(A5 S UL PR e . AR R P U BT AR “ g < T > B
MER” (Details of <item>).

DAUR &1 SRR e 7 AR D IS ST f D) g

T A5 L DU 5 =PRIk S P B T B (R
CAD SCH) A TRt BRI F A5 S 0 R IR ) A% X ko
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T H &

T F A S T T A T AR H e AR R AR R A E . XL E
(FrB I b

“ZHZR ID” (Organization ID) — 4515 CAD SCRY R II4LZ

“FHRF= 8 | F7EE” (Responsible Product/Library) — #5315 CAD 3¢
FY I i BAE A 22 bR S

“9%5” (Number) — %75 CAD UY1K 45

“Z” (Name) — 7 CAD SCRY 144 FK

“3CfE4” (File Name) — /R {E ) CAD SRS LZEN 21 CAD A4
“RRA” (Version) — 7k CAD SCREE T RROR/IN A

“SE2RAY”  (Instance Type) — F CAD SCRYFR UM R S L 38 FH 34
e ARG R I H

“ORFE” (Status) — (BUHIAE TAER A S Wos T CAD SCAR4 TR EA

—  LARXRSS A EIA < A A g s B > — b “JUamiEgnfs 57
AR VAR S S TR 2R GE M TR T H (i 50D

— TARRKAMIEIA < JSURIOTEANE B > — b “Jstq i s &7
FEAR AR AR S TR e GEM T eger il HG I 742
A3 H A B R 00

- TAEDOBTEEIA

“HBIEEIRE” (Database Status) — o/~ F—F CAD SCRY U 2

- K

—  HH <otherUsersName> Fi; i

—  HEAES A TR AR

- HEXNZR WP ILERIED

— REmE R CM PDM £ 2 50H D
- <FH> ARBEATH)

- KA

“TAEXAMRAE” (Workspace Status) — /s LU F—Ff CAD SCRS 1) TAE

- B
— TR S CERERIH S EE I H A D
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(SEESEPSS

PDM RG]

- fEARNUES (CRAEARPBESIH, Bk B3N
- REX

R LRI “EARPUES” M “AETAER PN RE.
“BIVEN FFEF” (Authoring Application) — Fril G CAD SCAEFHE
) CAD T H

“PIE” (Location) — FriHl CAD ST YAt FEAAAGAL S (LR 3
AISCAEI

“$iE” (Description) — %W.s kT CAD SCR/NBCAS ) i W R
“HIBA&FR” (Team Name) — Bty CAD TSR 1 [41 A ) 44 F5k
“RAE” (State) — [ CAD TR A= i JE BRI 4

“BAIE” (Created) — <G CAD SCRARAR ) H I ]
“fIEEE” (Created By) — W nfild CAD SURYRIMR K 7 1) 44 Bk
“BHE” (Updated By) — Wonfi /55 CAD STRYBN IR HI J (1) 44 FR

“LREFH” (Last Updated) — ‘Bon i 1& o CAD SCEYAAR (11 H HAAN
i (]

“KRIFFRR5EHEL? 7 (Dependencies Complete?) — f5H JE BN T
CAD U IPTATHAE RS B (s True B False)

U R 26 FJ7 8 os T30 H 1) PTC Product View Express (PVX) A& AT (M
S0 A A PR N S s Hh U7 ) S S TN, {7 Windehill w4
K55 (WVS) EIED o dn BB IEAE DT )6 A5 2 U ) TAE X AL, )]
ﬁﬁ%ﬁﬂ%ﬁ%ﬁﬁﬁﬁﬁﬁﬁif/ﬁg IR H AN WA E B
HH .

G LTI bR LU R EHE (B, SORTUH B (). TRk
() BB T GBI LK 2 A5 R ) BURR $2A RS 2l Blb vl LU 4 &
% TS, sk [Q T LK EHER RS A .

LEAHAAEAERIREH I, W F U e 4ty “HE <WHE > K
HHER” (Go to Details of <item>) %, DL 210 H 4df 152 A H15 B
iR

FERE: ZNRA NS b Bt R, #2825 PVX. WRAR ke
PVX, HDIERLHHR 0 PVX RSt ik, A won B



TR T Pro/ENGINEER 50 (1 J0 LR L [

Q ® @ @ 3

o VTS NI Hh o T 388, IXEE SRR T LA & CAD 30y
FIE S fEE R, FEITHA “HEM” (General) Fi4 Box T =K
o “WZA” (Content) KASELML T /E4 CAD SCRY N 21 CAD SCAFHIfE
Ho “BiE” (Attachments) B¢ “B¥E” (Attributes) £A4% th %1 H 7 I35 H (1)t
A B

ARG DI T AR [F] BRI AR SR . WGP VR,
STRPBR T, JF R MU A IR B S SRR . ] A A BERR R T
ROEAEAAR R TAEXIUH 5 BT, S RAE B E A e A/ P K
I5LH PR 5

AR DT H AR AR
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AR DA T R A R U T AR AR DR I8 ikt . B, T
PEDC “RIR Ry RS Toik s ANE R TAEX P MRAE R R o M, X T
C EE B TAEX (HARRAD (B QI MR, R B AE e i1 A
X BIMGHY” R, AR R E A IS “BIRGH” it

A DX REAS A3 i 80 T p g e DA R 3 S T e R I B O A R
Sy

“HEM” (General) — 2 15 U AE ST BOA R, EERT =
R

“WZA” (Content)— % T CAD XY T=E (CAD ) NE
“BifE” (Attachments) — %1 T CAD CRYMIIRENZE CnHA)
“BM” (Attributes) — FI|HH T CAD SCRY 1) Jg 1 f2 HoAH .
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“THEX - #HXEBM4” (Workspace Related Parts) — 275 “ i85 ”
(Describes) 4%, R T 5 CAD SCROCHRAA:, B 12
B CERPRERD , A BT (PR «

o “TAEKX - CAD XR4%Z51” (Workspace CAD Document Structure) —
WOR TR IR ITH I “BRIGERHIRE” (Model Structure
Report), UL 3% ZIRGMFIHIH AT “fEREH” (Where Used)
EL

«  “THEX - HTF” (Workspace Used By) — Won T “THEXHEHT”
(Workspace Used By) #4%, &SI H T H CAD ST H AR AT
RERH

+ “IHEX -Z&%” (Workspace References) — Z/n T “THEXRS%”
(Workspace References) &%, &5 T CAD SCRZ #1110 H Al
WA R FRRR

o “THEX -Z%H” (Workspace Referenced By) — n T “THEX -5
%7J5” (Workspace Referenced By) %1%, %%V T 2% CAD XY
(PII0 H RIS o RS

+  “THEX - #&” (Workspace Family) — B/n T “JEER” SHME “HK
H” (Family Tree)

OnFeo )T A A

PDM RG]

NI H K] CAD SO SOt R & A M AAE I H - (e
MIIH D Bf5 R, IFRAE T B 2 1f5 Bl .

O e A A PR S T P R ) FH B DA R % 5 T e e ) S s (R4 R
R

o “HI” (General) — Hn = AEH:
~ “WA” (Content) — ¥ T CAD CRYEZ (CAD UfF) W
—  “KHF” (Attachments) — F1iH T CAD SCRIMIREN A (IR
— “BH” (Attributes) — FIJHH T CAD SCRI R PE S HAE .

o “HEEAE” (Related Parts) — 7~ “PiBH” (Describes) £, &
I T 5 CAD SCRYCBERESAE, BEA E25A (EMpEE ), A
B (ZNPEEED .

«  “FxAEE” (Associated Changes) — /RN A%

“EBIRE” (Problem Reports) — #1l i T Ab T AR JRZS H LA
CAD SCRSRRAATE Sy 52 5 1 (R 500 1) BT A I i o5

“ZFTH{ER” (Change Request) — 51t T 4b T- KA ekaS HUL CAD
SCRSRRASAE kg 52 5 (A B30 0 BT A Ak A% T3 SR
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— “ZAFHEEHIEM” (Affected by Change Notices) — 1) T i &
PUR &R I AR S5 2 A T R etk 2 H BL CAD SCRYhi
AAE R Z W 5, B CL CAD SCRYRCANAE A dse e 73 211 5 ECN
P55 SRR (R H Al

— “BJEFERAREES” (Resulting from Change Notices) — 41/ T
BT 52 BORAS B2 RAT T CAD SCRYIRAS A AR 55 15 . B,
E A3 2B RS, CAD RYRA 521 ECN 145 8k

“CRYZEH)”  (Document Structure) — B T AR EE R H I H 730
1] “PERIZEFIIRE” (Model Structure Report), LN %2 IR EERI51H
BH AW (—HEBITZENE) 1) “ERES” (Where Used) K4 .

FER: “MEARBOL” (Where Used) KA 5] i/ /L 58 24T & AL
Bl IT /B fidl p FRIREIT 2. QURAS “EE” (Reset),
W) 2 I A IR LA R AT =2 AL

“HT” (Used By) — %Wox “FT” (Used By) &i%, IRMEHIH TAH
CAD SCRAII H IR A7 K R

“2%” (References) — i/n “&%” (References) #/4%, 1ZKA&%H
T CAD XCHZ 1o H FUKAF R R

“2%7” (Referenced By) — /x “Z%7” (Referenced By) £ 1%,
ERIEYIH T 57% CAD SCRIRIITH FUK A7 % R

“WR” (Family) — Wox “JER” ity “HEM” (Family Tree)

“FLZR” (Baselines) — 7 “FEZR” (Baselines) X 4%, %KMV H
CAD SCH e () A7 Jk 2k

“RRA” (Versions) — 7Rk “FRA” (Versions) &H%, 1ZEMHAIH T
CAD SCAS )T A IAT A

“ONRAS G g ” (Iteration History) — o~ “/IiRAS i Sidsk”
(Iteration History) 4%, %E£MEHIH T CAD IR T A ILA /IMRA

“HarRBREIER” (Life Cycle History) — o “Aay A 22
x” (Life Cycle History) 4%, 1ZRMEFH T CAD TR T 2E a4
B B

“HIEEHNFFIER” (Save As History) — En “H#EIH” (Copied
From) fil “FH|Z” (Copied to) 4%, XML HHIH T CAD X
FAIATIR A B A CAD SCRSH il “ 5547k 7 EeEa) gt n o H

“PrEPIFER” (Location History) — Zo~n “fLE [ Sidx”
(Location History) 4%, 1%EM51H T CAD SCRI R A A7 B AR B A
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“EAIEIER” (Rename History) — .8 “EAyL i Ridx”
(Rename History) 4%, X3R5 H T CAD SCRYW B LLHT I 44 FK

“¥UiT” (Subscriptions) — .7~ “FHiT” (Subscriptions) X H%, 1%L
FIH T CAD CHII BT ] F4F

“Z4” (Signatures) — W “%44” (Signatures) KI5, 1ZEIEHIH
T CAD RT3 254 S AF

“FHRHEFE” (Related Processes) — i.n “AHCiHFE” (Related
Processes) &A%, 1XRMEHIH T & CAD SCRI I BT 2R
5 B T A I H AR

NPT S B U NI TRDiR=iL e U S N Bl BV v U (EP B P =2
2" (Go), EABRTLITFANS I H AT HERAE o A AOAH N P F R 2 L
P (EEI =P O S A MBI EFSWN R

A I H B R 2R RS TG T I SRR IR AR 341

B
¥

i TAEDCRAS I @ IR AT BASRAS TAE ORI H (R (7]
e AL I H RS ) G AR ) DASRAG 2 3L 22 w5 H 145
o fFRITH S R 7 =MIRMAE . BHMGEE. BGgERMHE. FHE
GO _E A5 B AANA] T B A B kT

T H JEAE TAFX b i AE A IS )
T H 2R 2 i ) PDM IRZS

iR “SCHEFHAE” (Folder Navigator)

I T MUAS” (Folder Navigator) & P SR VPRSI AR R IR 55 4% . TAE
XFSCHALE A TR 5ok, “XHFIe S8y ” (Folder Navigator) $fit
TR 2 H AT IR A I PR =

GRS
FE, 5

T “ICHFRFHA” (Folder Navigator) H1i) Wi 3L 4

CUAIE A" (Folder Navigator) A& — AR 0] FETF AT, & Fo 14148 i) S AT ]
FEM RSS2 A0 TAEIX o G4k, Sl v L) SE a] v S2A LR U5 18] (AT ] 52
PERGE . LN SCARIEINT 326 5 [P S N 258 HH IAE Pro/ENGINEER 3]

Yo TS “SCPFIE T NIAR” (Folder Navigator), iy &) IR
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SR S

A SRS (Folder Navigator) €158 F -7 ) SCE R G LUK
Pro/ENGINEER 401 1) HeAth A7 & 1 T0L 2 15 A

21 ) Pro/ENGINEER Tl H

S u] — Xt AR WO e HaE i PTC 2 rh LKy 1) i 3
SCAFRLE G B P FEVFATHIED o
PIATIEM IO M55 2% — SE P ATas st Tilad “RSHHEM R (Server

Registry) X iEHEE MO BT RS 2% (S TAEXD) o X6 M AR 45 2%
Al LA 4% Windcehill R4 28, Pro/INTRALINK k452881 FTP R4 2% .

AMSCAE RGN /L — H3TIF “ AR FHAS” (Folder Navigator) i,
ARSI RGO M BE R AR, HR 8 H s i SRt

W EAR R — (GEH T Windows) IS ias on T 80T LLVG ) 11 X 2%
EWITEEL. AT HAT R R T B R R v SRR o

fER “3CHIEFHIA” (Folder Navigator) ¥ E F RS 5%

EREH “ERESS2SIEMER” (Server Registry) X iFHER — P77k, &
ATUAE R “ S0 AR (Folder Navigator) K 45 2% B8 BOCh 2545

L.

N

fE “ SR (Folder Navigator) HH, #x #8338 4 32 IR 45 2 1K IR
9%

A AT I PRGESC A
3.

iy “EBHRHEE” (Set as Primary).

M “HF2HES” (Folder Navigator) H 5 it THEX

TENAER] “ARESFJIEMER” (Server Registry) M IHHEM —Fh A T77%, &
AL “SCfEJe S /igs”  (Folder Navigator) 58 Bt TAE X

DI [R]— R 55 4 L AR

1.

FERREM R, Rl ERSS R5 1A “+7 bR, Windchill ST 24T
It

I “TAEX” (Workspaces) X9,
HHATAT ARG B TAEX, SRJE MIRFERE e se “BiE” (Activate).
7t “HBTAEX” (Change Workspace) X 1l HE A TAF X H B K.
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DI 21 S AR 55 g 1 AR X
Lo FERERIR o, 3% 50— NI S5 & L TAR .

2. A M AR, SRR IREESE bk s “REATE” (Set as
Primary). JEIREFT T AN EEIHGHE, SRR i P AT H

3. AR TEAE P
— “R” (Yes) — MIBRS UG IR P A 0 H MG L€ 1R AR X
— “F&” (No) — RE PRI FTAT I H I Fas ik o2 (1 TAEX
“HRH” (Cancel) — U B S AR X IR K

BE
“ICAF A (Folder Navigator) 2R A I LA, & AV
DR 55 A RSO R G
S ERST A%
AA HAL TAEX
SRS TAFIX .

DR ER B B

fE4# ] PDM KRG, %A LL3REUE 2% Pro/ENGINEER 1 Windchill ZhHE 1]
.

WA SR BN AT ¢ Pro/ENGINEER 32 Pl 2 11 5 Bl

{7 T Pro/ENIGNEER SR L) “FEBh” (Help) w4, Vil
Pro/ENGINEER 7 B0 B0, B R SCHISSHE B . AR R BRI P ARSSE E

I e T2 HARB A 1y, 3 A2 BRI SR e I H s 1, SR LA 7
LYy “WBhLT, ERd “#BY)” Help)> “#HBhH.L” (Help
Center). iX¥ 73] JF Pro/ENGINEER 7§ BP0 £ 00, A8 g8 ] LA b
BEATH B FE . R BT LR 3 b7 (Site Map) #EFE DL
SR BRI 515K

FRIUA S M I H 8, G “#Bh” (Help) > “iXR
24?2 7 (What's This?) X85 5 1] _E R SCHSRHT “3Bh” B R
A DL IR AT TS I AR5 B 328
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Pro/ENGINEER BALE BB R
Pro/ENGINEER 7 By o 42 BE D BE DX S5 i HEC AL B o AN DhfE X 3k 1) HY
T F81A4H¢ Pro/ENGINEER Fb [ 5 .

BT AE NI REX s AN DR R A R

2517: BRI K Pro/ENGINEER H15 PDM AHK i & (35 B, 135 8% 2
“HWWyrha»” (Help Center), i “ZEffi” (Fundamentals) DIREX I, K5
EH “UMESEIEEHE” (Collaboration and Data Management).

W 3RECE ¢ Windchill N F2 5 11 35 1)

1F Pro/ENGINEER 31 % 2% 48 ] Windchill 5, %8 0] LL AN B 1)
Windchill 51

o TN Windehill 5T b SR AOHS & ek s A S AR, i
AT L B AR P “HBY” (Help) 41 [2] .

o SORBUEAEAA IR ALY, RN AR B bR Y “HEBh”

(Help) 4%
PREFER TP “HX”, WRd “EsHMmES” (View Other
Topics) %4 .

FER: WRTTEAG SR, W sorE B, AT DU Bffbn v i
“HiBh” (Help) HEEFATIZITI AL B o

Windchill BeHLH B 4 HE 5 R
FEAS BEIREX I “ H k" A58 m AR L B I H a8z .

R LT BN Windchill FRE&4EHH ) Shaede it 7 3CF %kl . Windchill
I AE IS e 05 T DA o AR B 188 R e IR, ZE 45 1Y Windchill fA
B 1 2 TT RE S R 1 U I SCRY AN ]
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3

PDM FEA#AE

7£17) Pro/ENGINEER VEMt PDM k%545 f5, 5t vl LAEE H ' TAE A - aa 4
PDM R4 | . AmAY—L/E PDM F4di (K% WG sh, LA s FH
PDM #:4E. %Fra 3], v M Pro/ENGINEER 3¢5} Pro/ENGINEER 3 '
A AR X DU R TR AT — RYIERAE.

FH Thg
S PDM ERVEUAETI H e 3-2
S Ll = K1Y A 3-5
R I H 3-6
NI H e e 3-18
T T H . 3-24
FEIH CERIHBRIME] TAEXSHD) o 3-31
I TAER BRI oo 3-35
A TR I H A R A 3-36
B R R B . 3-40
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A4 PDM #AEWEIH

7% PDM #/E (Operation, tHFRA Action) FIFEAME 48w AL H |
PATEAEM DT H 114G . BAREAG TR AES THEXR P H—N0H, (H5E
Z g e h— B AN RERCA G, A BN A AR A I H R SCHR ) £
AT, FES R E IRCE (Rofrel R 47, B0 TR A2 sl A1
BMED o AR AT AR ZEH T PDM S SIIAf U150 H .

HAR A LIAE Windehill H V2 A7 BT GIATEAE, EHTAEX 2 PDM $4f:
ARG . JHIRIN, BIEF - ADEULNIH . SRS Fdaid B P il R AE
ozl BRAF OIS B, 1 HAN R E I HAE “IRFIZR” (Item List)
B AL AN PR T 20 SRt RESRAT e 4 R £ A5

1. WHGIESFE — R IERE TR %

2. WIS ERAR SC I H — WA A mT L A0 o AN s B AR O
T H

3. BIHARERE — WA Boks U BOe VRS BEE Pt (O C &

4. HEBRANT EHIH — 7T DA G R R A A 2D B AR I H

5. BCEIEW OFEPHATEAIER 3D — f& e EIATBRAR I K dnfr 3t £
T H

RKTRFRARLHE

AT R AR HESR, X TR 5 A AL AT 250 PDM #4545 [ il &
M H , ABESXLET H 2 (8] (0 H S50 H SR o AR AF R R AL LA
SCRSH O AT R R AP A AR KB DCO) OX R AEBEE RN (FF

D TARXEE R i — AN ETD

WA BB, B RO AR BEBRER ™ 5 5 K AR A S AR, 1SR O AR B
PRER CAD SCRRIM S5 . ANERIIR 1L E I H 2 42 CAD SCRY, #yn]
DAREFEAE— R i%, B3RS AR AT CAD SCRY 2 (R AEAS 0T 5CHK .

B, SFARIURE E 1) CAD SCRY (5B ot db P .

CAD RSP B AT H 31
RIRIFB AT 200 5 A5 A2 300 H 512
RIS “M” WiH, HT:
~ WERE B ZEHIELLHR. WE. A
— WA S (. T0D

BRI, B, 4R

Nl == 2 P
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WAFXS G == 4l
R AR T H A1 b 2 2 528 BEREZR (1 — P 7 R AR A R 2R
- AR A AHIERIH  (CAD 3CM . SCRD

« CAD UM 22 5 PR (0 B AT RRAS I S IO RRCAS - CIBAT iR / /)
A

o WURIERE TR IEAZAE FIL, W) CAD SCRY TG A A
2R ¥ —HB )
2 TAR R RAF O R AL BB B AL i, RS CAD SO T

D (8 FRASAS AT $i5 1) £ P AR PR R S 8 A 35 R BB P RRCAR 1) T PR
B, ISR Z SO AL i3 o

AN N B B A < 0 H

PDM FE A 4

FETTAGHAT R RATIT, S AERRAT U _E (R 8 H 2 454 (K] e a5 Tt
HAER A RAF IO S vl oy 2 B 452 B AE L IR SR BRI AE:
BB 2 F T H AT AT A o RARICHIZIFRRE 2> 78 bR 45 B A2 |
I AE T HAR R o EA IRl LUAE MR P A R E TR 1 A

HHFFEMA TR
!
T 1 REW 2 BEEIET
FMETHE [Wi_pool | EEQ. SN RE. BFG KIEHg. BE
mAK (B, HEW) wE: [FAE ] H
# b i1 “ X = “
W mAEmE b B cho T HEREA L BE
Ell  E | mrraw [ | | wsan iR |
r & Windchill POM Al @ HREIEE F 200540410 15:16 EFETLIF
r [ cup.pr cup.prt A @ FRIEE R 2005410411 11:47 IEFETAE
r O tray.prt tray.prt A @ EFREHETEAER 200510411 11:47 IEFETAE
C& O lidpn lid prt A1 @ BRI R 200510411 14:23 IEFETAE
& [ platepr plate.prt A @ BRI R 200510411 14:23 IEFETAE
r [Olg lunch_tray. asm lunch_tray. asm A @ HREIEE F 200510411 11:47 EFELIE

WA TUH AR R I , 5ot BRI H 1947, ARJafE T HAS
MG (RO Ml N RAEEAR, LA e] ] AAIOGITH .
FELEE ARG H SO0 1 PR B S B b nT M B AN AR SC I H o 2R
X385 (K H AT AT ARG I H - IR Bl b T ARS a3 . mT I
MHNRIEFEZ AT

il WHARREAZ MRS, PR, HEZ R OGER

TH I, %30 H KA A OCAR AT REAE I A3 BT — AT H
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A LAAE BT A A 384 i BRI LU R TR Ay 2

“EHE” (Parts) T/ W — NN CAD SCRIVR DN / I T A E
e

“TFHIE” (Generics) 4/ 3 — Jyik 5z CAD SRS BRI / M
ey T8 A

“We” (Family) 48/ 28 — 5k 52 it CAD W / MG BT Ak b
VR WO, WA SRR I BRI .
“EI4%” (Drawings) 1= / B — ik [ CAD SRR / MG 45 PR 4

“CAD 3A%” (CAD Documents) 24 / 28 — ks (3B F / 7= 5/
T 3= VP20 () CAD A%

“fEFIREIL” (Where Used) T / o VRN / MG Pk 2 30 1 935

“3CR4” (Documents) T/ Th— Vi / BT L5 26 5 IR / 7= b 56
) SR

ER: MfF. EYUN CAD SRR oRAE Ty “gkmt” &b Sl
AP R IAT (K3 A R LA DO B RO 328 5 (K300 H 5
AR R BTG I, SRR R AL T AR SRS (2
KA SR I HLAT N 85 )

wERE

My “BCE” (Configuration) §2, NIETHIRE & I H 1 BRI H I 4E
GWEAE. ARG R, WES IR ClUEE 4-36 11— 1A IR ER
BTSRRI

gn AR BT E 15 1R

RS IH Proe AT “HEBR” (Exclude) X, MIRAEHHERR
BIH o ZIH AT S B R ERMIERE, fa R MR 3E— 2D
BAE P HEERIZ I .

PR “HEBR” (Exclude) (FEIEE BHRER K30 H AT A5 Al H
[P H FIR T, JERMERZL M BRZe . WERAEFRER AT H e, 4 2]
BAEH DR, RJERME] “WEEI” (Collect Items) 2V 5%, I {/745 1.
AHEERIVIUH - (Vo8 SRR I H A LR 2D .

Crl3k) BEAMERA eI H BRI 48 € I 2R BN L RUURIR A, il
“EHE” (Reset) 3.
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BRI, 5 CAE R L n] AR AT Al st B AR AR (K F A 0T, SR BB A
sy P BB O K s T AN w11 2 ¥ (L P B i BU i 2 i i el ES IR P (B
(1R DR FEA

WEIMHNE

PDM FE A 4

7E Windchill #, A7Z5E45r A LR SO sefbde (B Sef) o FERTE
ANTGH I H 430 T AN . BARERIAL B 2 th TAE X EC & Y40 e
(0, EERIER R, DL “HBAE” (Set Location) = r
LK “WBAE” (Set Location) X iFHE, IR EMNFFINIE . AN RVFE
B G SR NI RE R i B AL E s (HE, AEHBEAE Cn “F38)” f
“HAEATD B, DR “HwEBALE” (Set Location) X FHAE

FE: ZAKIH A S Windehill J5 8E 8L BRI, BAUEH] “#3h”
2 (o

EFX:  [Windchil PDM  ~] «mathsE

X% [

At indchill POM

“WEPE” (SetLocation) X[ iHHER /R~ THew L N /&R “EF
X” (Context) fl “3CfF” (Folder) *Bt, — A3l Wos iy LA R AE
(AL B PR 7B, LR — 210 T i) S A «

o “Bi—/MIE” (Previous Location) %= — Y7 & hEF i & Ny — on bt
REo RPN, BRI BRSO I E AT R B ORI 2R
Ji 2 T s R

o “m_E#B1—E” (Up One Level) 1] — M\BARK SCHJ 2 IRFER] TR —

S B SO R AT D o BTN, XERHER SRR, BARoR T —
R R SCAT IR — S J 2 IR SO B 5 4+
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“BUBB A" (Create New Folder) ¥ — 7E 4 7% ) (1) 30134 )2 K
A B S

“HuméEE” (Hot Links) 5| — TP (M Windcehill i A%
HORAEI URL) 5K . HabAREER LW~ A5 TH
5%, Windchill PDM _bF 3CH PR SO0 B R R i 2

“YIMZEPussEsE” (Add to Hot Links) &5 — 5 4 57k 52 10 30478
BIPRHBEEY 2R

BEFE BRI/ SR, IR A e AR G DUBRS A
AR

L3 18 il NS VO B S VA

1. M “LETF3X” (Context) FHrglRHFERE—/ L F3C, &% L FCMINZ
SN B BoNAE “3XR” (Folder) 413 7B .

2. M “3CMER” (Folder) 414 F BUT ik — NI IALE . Hili “4TFF”
(Open), WIEE] N —HRZR N— 2RI IR E AR,
T 4 H 45 € AL B R AE A B A A p B

3. MREE, i “Bi—AMIE” (Previous Location) © . “[i F#zh—
J2” (Up One Level) & 5f “GI@#FCfEI” (Create New Folder) 1 o]
D0 0B I A

4. B “BHE” (OK). R ANIHWERSEN R/ i E.

B ORI P T A BRI PR A

1 il “HOEBEBE” (Hot Links) Sl, “fIE” (Location) 1 r T ff
R A A B B PO R 21K

2. MARFREL, 7R PRsU R SO e Ah R b R M A

3. By “Bhie” (OK). RGN AUHWERIREM LT3/ HE.

ERIEE, TTLMET “YRINZEHdEEE” (Add to Hot Links) 55 75 bkt
B 4 0 A R T

RAFA LI A

A )\ Pro/ENGINEER Wildfire F1 T /EX F /7 Sl v 15 9 - 22 CAD %k & 2
B HIE, DIULRAEHCIEMIEH, 2R EASETEX T HI.

AfLUEH “LRAE” (Save) B “fRAFFF LE” (Save and Upload) iy 2K {17
Pro/ENGINEER 3Cff. “fRAE” (Save) fir & 7EH5E M H g P BRI/ &40
b, EREAHAERSG L OAENHS (TAEHS , (HFRH

Pro/ENGINEER Wildfire, #&1 T/EH& 0 LUZ PDM RSP TEX . “ L
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REFIH

#,” (Upload) 1% ({EJ5 H181T) 1E PDM Jleg5as EA& % I (A vh N
ARTRAFIIH, EASKANE . “{REFEFHE LE” (Save and Upload) fir %
23 [F) I AT X PR IR A

Pro/ENGINEER H{RAFC I H , {HAELL NAE I R 4b:

% H E H s R BE R ERAF AT H o AEIXFAEOL R, IUH fRAF 21 T
X

BB AL save objects WE N all. fEIXFHFHNL T,
Pro/ENGINEER £ 1 91 (1) i A5 1 H s R A7 21 TAEX o

it AL save objects W E AN changed and specified,
M4 R H 2R P I TZIH o fERXMEOL R, Kok
Pro/ENGINEER £ 1) 55 £ 5 8 (K2R AT 5% ) 58 S50t H DA AE AT
.

XPARAETH BEAT 7 50, Ty B B Sk
propagate change to parents WH N yes.

LRA7 I H K5 A1 73 4% 20K item name.item type.version number #3014 40,
WER AN N AAFRA “bracket” IFRAE, e BTG IR AT I ST A4 FR
bracket .prt.l. FRRRAERE B 445748 K bracket.prt.2.

HER: 905 AT AR RSN ST RG] W — 72 TAEX
VAR I S O Wt | Nk (N

g, Y MAT ) Pro/ENGINEER  (CRi%#: Windchill R4 #88¢ TAEX )
TAERS, WAl ARG SRS (Bl . . /partname) FIRIH, WK

A FH [R]— BR AR RO T H O A7 B LR h H s BRI, W AERS R FIA7E4if

ZIEHE TAEH 3, TH W RESRAFAEA IR H Sk o AT A 12 44

RHEI LN . BSE, W SEM T Windchill RS 2%, i H\TAE H s
RIH, NI E ¥ ORAF 2SS TAEX

ER: EiefmE ] L 260 74T

7E Pro/ENGINEER F #7151

PDM FE A 4

B4 Pro/ENGINEER 231 A2 10 H -

1. g L) 80 “32f” (File) > “{RFE” (Save)o “{RIFXTH” (Save
Object) XJ THHER 25 HIIHL .

— WRVHIRAE TIH, W “LRAEFXISR” (Save Object) X iFHEH %A
AT HESHFMIET . fd “HE” (OK) 5ERRAT.

—  WERDGTAR AL I, 15 21D 58
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2. “EIHIEE” (Look In) HE ) H S n] LLE LR Hd— I
—  (EXEHLE) Windchill AR50, HEWEs) TEX, FHEL “< k%
MARE > W < TAEX A > #aUFH
TR —HFX (BRI ]R 4 .

—  {E Pro/ENGINEER Wildfire A% #% 3| Windchill 45280, Hkn LA
& LU HoA—Tii

o “TRAICAY” (My Documents) (fY[R Windows V&), A
7524 Pro/ENGINEER 231 "P 88 TAE H s sl jiy AR 5 H Ok
L3 5 —H & g .

© TSR BEE R T H K.
o ERVTRVDATIT ORAF DRAFREIA B84 SR IR H 3k
3. FERERINH s S RPET I H oK.

FER: vl e Ui AR H

4. £ “FERIZFR” (Model Name) HEH, EZNBR 14 Fofs L. 2Lk HE
iR, 3 ll
5. Fuli “Bi” (OK) LR EIE “ERIEE” (Look In) HEH Wos iy H

3 WERE AT HE, REHd “HE” (OK). Pro/ENGINEER
T X 30K 2 R o

TRAFII H B3 7R~
TERIEFE] Windehill )55 2510 -
o RARKBCE LI override store back WHE N yes, X SRA7 ik
FEFRAG H s
o IR BRSO ORAT B DT ) B H s, D G AR I
file open default folder. fff LA E EINFEE M P FF
TRAF . DRAF R A AR ST H 3%

o WMREHFEMHHKNEMNR, M H override store back WHEN
no, NPKACE LT save object in current WHE N yes, LAEY
B H s AT

© BUARSUOUT, Pro/ENGINEER Hx fEXS 40Tk T (A AT T 3R
PRAFBRY . AT DAl I B S A a6 5
save modified draw models only fERFRLRAT LRI fRAFAAY,
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MR AR AR, IR R A LT compress_output _files WH
N yes KIEAA AT o SRS N 48 ORI TR 2K, AR
INEAR GG A — 8 =0 2 — T HEATE &R & g a2

A FrameMaker CAD ¥{#E 65 CAD 344

R OR AT B TAE DR B A 5 BRSO R ) CAD S0k B mT BLATAE:
DAL FRIT A A1 CAD 3R (FEUER R 45 CAD ST IR D o

LN TAEX a8l CAD 3O, 15HAT LT AP %

PDM FE A 4

1.

MLAEX ik “3XfF” (File)> “HFHER” (New)> “CAD H4”
(CAD Document), . “flIE CAD X#4” (Create CAD Document)

#4. “BI% CAD JCR4” (Create CAD Document) % [ 14T JF, JF 7R
W “1: G CAD XX#4” (1:Create CAD Document).

FE A7 BOP A AN BGE R H -

“Y98'5” (Number) — $i A\ ()% 5 D520 EME— .

R WR S IR E N Bags, Wb BUE AR 8)
1, FHHABETFIIHAG T

“ EF3IC” (Context) — MERML R H £ hik e —A R, BRIk
B, RESERTEXK LR,

“LF” (Name) — ¥ NHT CAD AU FR. BRIASAFR S 905 AH A
“SCHHFAZFR” (File Name) (4 757B — i AB CAD XA &%
ff] CAD A4 0R (B3GR R 4D .

ER: WREM T A S IhEE, XA (File Name) $5 A i
AN Bl WERARRA SRR, WaAE “SCEAFR” (File
Name) *H ] H 3040965 o

“REL” (Type) CLIUFBD — EFITH IR,

“RERR” (Template) — AN HrF1 & 1 AT ATRLH P EAT 16 95

“PLE” (Location) — Hir N A2 BN AELE 52 1 S ) v BB AR A7
CAD XCRIRISCA . Hdr “WM” (Browse) ¥ilin “HEAME”
(Set Location) U{[fl, AEEGEFEIRSS4s B SCAHEALE . ek b
CIRYSHIEES a3

“PiHA” (Description) — R T £ N CAD SCAY UL .
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HE: “8S” (Number) B “3CF4FRK” (File Name) ) 4 0575 7B
AN SEHEATT Ry 24 R G T SRS, CABIEEBTI H I, RGP R A
Sk CAD SCRY ()G 5 F1SCAE 44 5 Jg 4 35 24 25T 4E. Windchill Foundation Fl1

PDM i 55 Windchill PDMLink 3% y5 8% 51~ Windchill ProjectLink i H
HfE—,

il WREE T WonASUE Bl SUE kI, WSS ety RE
“HZ1ID” (Organization ID) Ifi. WIEREREIMTHL, N “4g5”
(Number) FBHE2 FahfmA (RS H T B 3hg 5 D6 .

3. WREEIN G AN REEEAT, EIETT “AIFISCERERM” (Create
and Associate Part) & iEHE.

ER: EBAECIEITH A AE QIS5 I, fERF5 CAD SO A
NLFRHK

4. i “TFT—3$” (Next). I “2. fgEBMH” (2:Specify Attributes)

B, MRIETE R E CAD TR EE.

ER: S P BYH T I A Em . RS TR, T AR JE

(%) R FME K A TR CAD XY . i FoRTE e, W m) A% & P (1) 1)

KAUENK BT RN CAD SCRY RV ERAE I R Gedse i il AR 2R 5 S

ST A RBR A, e RIE R N R g .

WFVERIRRE N, BEMA AR B P R THR, PARIEHE .
5. i “5ER” (Finish). RGRIE)EFEE K CAD CAY.

HEE: WIRAE Windchill PDMLink R 45-#% E TAEX @14 CAD SCRY,
M T CAD SCRS IR SCAFKs 25 48 ok bR SCB g AR SCA: .

BROATGOL T, Bl i) CAD SRR A B Pk i) B R 3

A CAD ¥ QIR #4454

3-10

CAD gt g, Mk Gl @ b 54 R CAD U450 Hh 1 &
/N CAD CBY, RGBT X% AN Solution Name, H]£F Solution Name
BUEE /= g5k . AERT NI,  Windchill #) ZEKE S F CAD SCRYTR] 1) 5¢ Z 1)
@A gn, HITE A O, . ARVE AP (B R
8 H OIS 7E &5 A0 B gt vp A Sl TR 0 ) S BT AR B2 R G IER
(B2 WHBEFR) Jeda BRI (B, KRB et , Hidr CAD X
PR, AR S et
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# CAD SCRY IR AL 344

B B R

EEzIPS S s

PDM FE A 4

FEANEE CAD OB S22, e I Qe Al A JF & CAD 32
REAHORHE . ARTM0, 2 /0A7 AN I D 3 SOICTR T 1% 4541

M 7r FrameMaker T “fRFEFF _E#” (Save and Upload) fiv %, 1t
TAEX g CAD 3CRY, A2 7E HTML UL HiiH] “gg CAD XX
B4” (Create CAD Document) % [k 6 % .

EXFGOLT, TAEXIRGE T “B3hREERMH"” (Auto Associate Parts)
e, FIEAEREIEREZ A CAD SCRY, ARG IERE— Yo (i ] S R e e
RE B IS ANE Bt AT OB SORY S B BAT 1

E.fE Solution Name H 8 155 CAD SCRERE Y (1 Ak 41 o

EMIEULT, ff] “5REBR” (Associate) i 4 ] LUERE CAD 3CFY, RS
R m ] N TR A N A A . “SREBR” (Associate) i 214 2
VPAEE BB, M A RAIE N CAD SCR . XA 2 A RIS 7ERE IS
JUT A 4

FIFH “B3IREEEF” (Auto Associate Parts) 72 1] LL A 2 &I HLA
R REC R CAD SCRY, o W R BAF A VS EC 34, DD et — A4
FIOCHEE] CAD SCHY . UMb DI REMRIE LA ST AR, R “B3hk
BXER4”  (Auto Associate Parts) T 5¢ il

FER: MR QU A g S e s UGk ol U B O BRI
FIE. AREAMER, WS W (Windchill ZZEHHAITHT) -

F B RIKHBAE LN BEAE LL T 2 AF I A 2R

BRI R, SCR 2 Cae Ao th BIGHUA R, 1M 200 Ay
CHZRICTD AESs HBNHE B A BB  A AR AR H 2 TAR D o SCRGA
IR B AFAE IR i R AL H 1) AR X

FEFR IO, QRN SCRGIR MR I — A, ) “ A ) JRHKH
7 (Auto Associate Parts) iy %43 ZBE %R, FFAEFHEHIG N Wos
— SRR A

L RPN, WEREEBEA R CAD SCRY AL TR AN
AR, “HABNKREGT” (Auto Associate Parts) iy4 43 ZME Tk SRAER
KN CAD SCHY o W PTIEXRT G A My & 1A sk 2, W s—
FREN R



EE-IPQEIIH]

3-12

RIS BAFE G« HENREKHT” 1A 2K
BRRIEFER B A BRSO, AR GEAE Bl e R B AR A . 2R
LB, WIRGAEMIF A B Qe “ B+ 8, JFERRAEA
PR TR QIR B ORI WIRR SRR, MR SR & b3 s AR R 3

LIt

MIAEX LR CAD XY I “ BEIRBEEE” (Auto Associate Parts)
i, “BBIREREMH” (Auto Associate Parts) JUHI HIIL, FoA A7 py-43i H 471

R

AR T FEBOCHE AR SO NI A W R ARA B IA A,
MRS B “ R &5 B BN A 154+ (Search found no existing
parts). WIHEREIHLE, WG R R PTIRAES | W5 BT BB A -

51 L]

Johrd 4l WH ANRIERE, EREE IR R R X S

KA A L T SO RIS X B B AR

%5 TRIERE SR, e R S O B 1S
ELE RSN IS

Bir SR PR SCRS (BT TR

g5 WRAE LRI LR A R BG5S
o O A O B B PR A A5 S DI R B L

AR RIS AEF AT R N I 4k BT A4 8K o

A KEK 7RI RE SCRA ALK i ORIE CEBhsgs)) .

BREk AE A NRAIRR, RV ST SR AR A
PANETIPSIS

SNSRI T SO UK HT ORI, P25 A AR SSAR B AT ] BE 4

PERI UL 2 WL A&

51 L]

TehsL 5] W AR, RIS X R R IR 5

KA B LT SOR SR A LR BN S - r o

%5 SRR IEE SR, g U A A B B S
PR B I R R R

Bir R PTG SO BT TR

s TR BWE—ATEBG TR E 5 P SCRAH SRR K A

INETRS
W BEAT REAE T LAGAR IR, X HR T3k 1 LRI

WHE

¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R




51 L]

HRAF AR %gﬁﬁ?&,ﬁ?%igﬁﬁiﬁﬁ%ﬁ%%#
IR
b5 BEAT REAE AT LAG AR K, X HR T3l i 1 LRI
BH

frE (AN SO P BRSO RIS W% L, AR nT LA
D A8 281 i L e P AP 1) S SR

KIR WE AT, PR E AR

LA WA FRBIR, o9 FniE s v E B RAL

B EREk A —ATRAR, &RV ST SR AR AT
PANENTPSIL

LHBRBAAE, EHATEL PR

1. AR, 2 QBRI SR, RGIES “4wig” (Edit) >
“BFNREREH” (Auto Associate Parts). HIL “ BFREE M (Auto
Associate Parts) UL[f]

H a8 XL 8B £

HEHE 0 W)

X 12|
0E B
B

r JJ_ 1T WS Wit S e

HHEAE R

HEFE 20
X =
2 H B
B
r &8 | ev | sees [wesw | aE E: K | xn |
T O PISTON_PIN.PRT A piston_pin.prt [windehill oM Fo [make =] [eaoh =] [E0FE0 <]
O | PLATE.PRT A plate.prt Jnsindchill FOM B [Make o] Jeaon -] [EHE -

2. RUEILA OGRS T AR OCIE, IR, T “BEeER”
(Modify Association) 51| 5 i G,

3. RERUOHCERR . B, BUBIEm S MK R B
Chn Rt A ) B IR T SRV

4. WUR A G5 EIEIBCE N IT, JF H A SRR EHl, R ELA
RS RE ) “BB3NAT” (Move Rows) fir 4, AT WA 1R
BRI . HEER s AT RN “L” (none) [FI17T .

=

PDM FEA B 1 3-13



5. FEAE—ANERT, TR “HERR /&7 (Exclude/Include) X 7t 3
KRR DI H 5 sl e bR . HERRIEATUH B, & T ERAT R H
IS 2Lt M B 25

6. i “LLE” (Location) 7 14240, “RIE” (Source) 1 “ERINE
f1” (Default Units) #|HP (¥ N hroi3, DL e H P I B HE, 4 —AT
AT EAE

7. Bl “WaE” (OK).

FEE: RMUEE “%E TAEXIEIR” (Edit Workspace Options) & 1]
“EM” (General) EII-RHHa5E

K¢ CAD TR SRER B AF

3-14

Windchill 75544 FIFH S CAD U G 2500 R, IFAEREB AR Wi T
—HYERFX TR

KFF WAKS ) CAD SCRYFIERAEXS S, Al “REE” (Associate) 172 1] K
AR . X CAD SO, R ERAEABR ook i, 7S 4
VEWIRAN S FEN 2. CAD SCRYREAS BUTHITP ) “Uimg” sk« i
T7 A5 B EREBAEF CAD SCAYRIYHTOC R, BIE CAD SCRYBEERIA .
LEREL CAD SCRHT, RGHUTRR (A3 K.

R RMEREAGER T 5, By e s OR H ROt R a8 O B A RS

FEZRICH AR AT 5 BT AT CAD SCRSZ RN RIC R, T A BRI (22,
4n Windchill # RN IE “AEH] 7 BE, ARPERE “fEHD BERAERA
IR

ANAE B R R AN R AE QG I, AR CAD SCRY [a) #3755k
CAD SCHSHT “Uii” TAFEEYRNG B AL eE, Ak B ek
CAD R4 .

FERE CAD SCRS RIS A
L AE AR AR 25 AR ORI 1 CAD SCHY .

ER: G LUERZ A CAD SRS MR, AEULtE oL, Pty
SCREER BB AT S SO ] HAT BIARR ) PR

¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R



2. EFE “YRIB” (Edit)> “REK” (Associate). I “REEZE” (Associate
to) VLI,

ZB:E CAD 34 LID.PRT {Demo Organization) - lid.prt A

HEE caD TEFRES

ERHRITA
[l
(ol |2
HEER I%%B 'l
fE IF'ans Library =l
ITEE |W1_PDD1 vl
B (0@ H 03 wE. [FE -
~ ERRE
P e pren wE | zomm |

3. RO ERNE L CAD SCRIAH IR IRAE . 25 90K WoR e “IEFEER
BXHIE4”  (Select the Parts to Associate) U1[f] I,

RFEE R IR SCE

BRI
~ W%
c K
HREN (25 -
&E [HwE =]
€swa . [ > Windchill PDM
- X EAE
S
T zme lmeE  |WmEE |HEe s o LeERe

r {Sj WG 0003 0000000034 A, (Design) ETELIE demo 20054010 18:35:19 15T

4, EPREESCRIAHOCERIAY, AREHRE “Hie” (OK). i M o
INFE “RERZE” (Associate to) T AT H .

PDM FEA B 1 3-15



E&IHE

5. BOAGOLT, ARGl CAD SCRIAPTRE A F 1] 1) B . A
fir 8 CAD SUR RSN Ak A e, T5AE “ ERPHER” (Active
Link) 7B My & ks “L” (None).

6. Hili “HiE” (OK)-
7. PATHZRIN

TR KBRS G ATk Windchill A4 G R NERR O 23 1 45 440 1A #5350
PRI “AEH” (Uses) #iE#%,  MMT € MORHEERAE

PLGUFOREL, WA EAE— X R TEAE BT . £Ei A e (s B v b
By “MRICRY” (Related Documents), 1] W nAHICEE) CAD XY, 7
CAD XCHYVEZI{E Bt Feh “AHSCERMH” (Related Parts), mJ7E “i
BH” (Describes) 3 i s AH IR IE )4

KNG, 5 CAD SCRYSCHRIFFAF RV A ™= S 458, %454 o AE T A
K “FERgER” (Product Structure) LI,

W ALR I H 22 4= M7 5 /E PDM RS a% L, BTG 61 oAt FH P AR )
U, WATLMEH “ E#” (Upload) fr 4. — FLORAF TIH, BIArLUEH]
Pro/ENGINEER ] “3Cf” (File) > “{R#73F L#,” (Save and Upload) iy
A, N TAEX R “ E#” (Upload) #:4E (I H C #4735 T4
XD, BIH LE RIS .

M Pro/ENGINEER F$#4T %

WEERE “XH” (File)> “{REFFH E#E” (Save and Upload), FF4fi M
Pro/ENGINEER ™' #5300 H (0l f2 . L FERISY R ko S ar— 15 ek i
FLRAF I REAR ] . FEREREES R, RV DH LR EAE PDM RS &% L1
AN, ARSI A 2 B2

MTAEX P3AT L8

3-16

RSP s S (HIDIEYSY

UM H 2 AR DR SO s e S . ANy B3 RS
s SCAFARTR ) TAE X S

HEFE L E B AR DI H AR e b R HOH IR B8 SO I ARAF I H i |
Blo PRI B FE AR S (O AR

1. fEiE3) CAEX, Rl B3I H , ARJEES “3XH” (File)> “ Lk
#.” (Upload), iy “_L#H” (Upload) HE .

“EZ” (Upload) GUIHCRF L, It 43 81 Hi AT R L € 0 H K3

¥ Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill 7 [¥] Pro/ENGINEER # 4 & HL 15 5



PDM FE A 4

2. £ “LE#,” (Upload) Ui I, ™Mifi “IF|FR” (Item List) T HA= AN

LAUR EIRR,  BUS HI LR Jrid i

—  “pLE” (Location) — (WA T “frE” (Location) 51H) IR
“WHENE” (Set Location) & I, fFREHEMW hik g MmiHks: “
T3X” (Context) Flfifii “HrE” (Location).

ER: WUH M ERSCERIR B3 € o BGRB8, DAUE
“B8” (Move) fir 4 B8 H ¥ _E R 3C.

—  “AEE4” (Include Drawings) — &% L4 5% @ I H S B 1)
HAZ K 4R

—  “AEEM/ CRY” (Include Part/Docs) — £ FE 3T 5% & 1K) IR
H ORER B F 8 CAD XY o

—  “AE/HR” (Include/Exclude) — 340 7 alHEBR L & I H .
BEAEBR UK 4 — 45 A 8 a)

ER: WARAGEMIIR A MERAEATUH & IS

- RO ARG R I H B AT O RIS N BB (1 T AL AN S RE

WAFIE, W “ BT A5E#-IE ” (Auto resolve
incomplete items) 2 UEHE. I ILEENES, AT OIREER L TS
BT

“EHRE R LEHINS, SRI5Z8” (Update with object on server,
then ignore) — REAEMS5 % P M A IH o an R 4k 21

—NRITH, B SO AR IE o TH A A
SEHEY, DAl At R

WRTCIEARBIH LA SE I H (I H, W RS2 ZWEA LN
WAFIH , FF AR IR e .

—  “URARZBE” (Always ignore) — R FUEF HLE N LA A I ERAT A
ANGEFEIIH .

R 2RV BEBCE AT REAS SO VF L RN IE T, 5 (RIAR A7 X B
ANBE R .

. B “HE” (0OK).

Pro/ENGINEER Wildfire £ )5 & 5¢ ik L3485 4E, J7E Pro/ENGINEER 7
S o shm e TAEFR g &8, EREAE S 1k,

FERCED B3R, 2o I H B bR b ER CAE S A AR5



KT H

FEMES K HT 0T H IR Windchill 2 FER, 5035 ©5¢ 10 S 35 H 1 L
VERIARIME SOFER BRI H _ERIBIE I, R0 H R 2

ERANTLHE, RS H AN —ANNEA . 7EH SR I H 14 0
T, RGBS —A/NRA . BRI H 5 B AT LA Windchill H 7 Al
L i HIH T i AR PR (BREAEE R e AT H S5 E T H LR ERS
HERES) ©
CIRYSUBUNIRE B Wit 5 % A UN

A58 FH 1 2k N B35 I A M Pro/ENGINEER 1 P L1 0 58 1%

7F Pro/ENGINEER | %o g% A s o] M CAEX s [ i “#EN” (Check
In) T . PAR LT UL T S AN A] (R N IE T

M Pro/ENGINEER H# A\ 35 H

WAT BB

MFE TAEX A5 i T 0000 H (AR 5, w LUK AR o S A o =
R NFRAE N TAE X o 55 e sE 2 1 H OB RS JE R ST 52 3
Windchill Ii45%% .

FAAT LA H 3
B SRVFHARIT ™ U 3 350 H PR 08T RRCAS LURCHS 35T AR H B0 AR X

WAL TAEX P alE 7B H , 507E Pro/ENGINEER H ] FF gt b
FI0H FE AR B TAEX AR 2 58— YO 00 H s I 21 A 2%
(e e, S I Al P Uy )

R ANIGH 197 AT PR

BN — v DAFE TAE X B e o v B B AE,  ACA T
Pro/ENGINEER i {1 30 H &\ 21 Windchill k4528, H e
Pro/ENGINEER (1] “3Cf” (File)> “#AN” (Check In)> “HZHKN”
(Auto Check In) S FAJ H AT A J7725.

SEFIREN — VA A B OO B, T R NI R R e T
HABIET . W] A Pro/ENGINEER [F] “3C4” (File) > “AIAN” (Check
In)> “EHIFEAN” (Custom Check In) &R TAEX H ;5 p A itk
SE 715

1. fE7531f Pro/ENGINEER 2 ifiH, i “3CE” (File) > “KN”
(Check In) > “HZIAN” (Auto Check In). LRI “{RIE
XF4” (Save Object) X[ IHHEN] “HERIZFK” (Model Name) FE .

o, AR, T IR ORI I AR, AR JE A

3-18 4 Pro/ENGINEER Wildfire 55 Windchill Bt &1 H] Windchill # ] Pro/ENGINEER %4} & HL i85 1



AT RE IR

PDM FEA 4

O£ L — AR, E# “BIN” (Check In)> “HZF”
(Auto)o F LUK BRI EARA AT H -

- BRSZERIH B A U o IUH A RR . S AT SO A0 2400 20
ME—

. R ARG LB % ENTER.

EE: EHRARAERAE, Rl “X” mid% ESC.

. RGUR I LR PDM RSG5 ds . BLAE, B HGE ISR Al PDM

M S ERE .

ER: ARG, WRRGREHE SO, W EUR e g, W
RICAF A g G A7, WIS R R e

. {EWEZIH Pro/ENGINEER 2315, Hili “3XfF” (File)> “4aN”

(Check In) > “E#HIFEN” (Custom Check In). AFIZFR B “£f
HFXT4” (Save Object) X 1FHEN] “PEHEIZFR” (Model Name) 7B,

B, AT DRI R BRI H A RR, e AT, e HEL— A
PREESEH, Hdi “BEN” (CheckIn)> “E##|” (Custom) (UIEEIEFE
W7V, WHEBREIP IR 4) .

. AE “RREFXZR” (Save Object) X IHHEH, #&52BRINIUH ik A2 i

I A RR e S AR S4B s 25T HE

. “BAE” (OK). “SEHIA” (Custom Check In) X iEHER 34T IF.
C WERR RIS ATIH , WA “BAA” (Check In As) 513 ik L

T/H‘ZE{J#ID‘\Y:

“PEMZER)”  (Product Structure) — BT BE PR AT 2 B ) I H
AR Bltn, AERE NIRRT, TR SO R BT AR A S
RTNER AN



3-20

“STEFEFA” (Object Package) — ¥ T Hdh LR A7 2 A zip T
o I, FERENZERCHS, el R LT A —AS zip SO
KA.

w |

5. 1F “XFHIER” (Object Types) Xk, HEFLL NI —ANET:
— “RERL” (Models) — K AR A

“TIE/F/IM” (Viewables) — F L AH1E N ProductView n] & 1
LA

“BERIFITTEFIT” (Models and Viewables) — 4101 H AF A A8 ST 1
AN

6. 1F “SEHIMAN” (Custom Check In) #HFHEF BT “FAE” (OK). “A
A” (Check In) T [ # Pro/ENGINEER 3| % 8% F 4T IT .

7. £ “BIN” (Check In) VU I, FEZ3LH 4 LU R EDE i FE:

“PLE” (Location) — /x “BENE” (Set Location) X TFHE, fit
&4 PDM 5528 FIEFE BN TR & . eAh, nI DU “#rEsc
f432”  (New Folder) 32 15K G 8 11 319

— “AEE%K” (Include Drawings) — 1 & B HERRAT AT 2 I T & IEAEA
AT H A 4R

—  “BEEM/ 37 (Include Part/Docs) — & B FBRAT ] 5 75 1E A
REN IR IR H I3 B SRS S A

—  “fRERHH” (Keep Checked-Out) — #43% & T H 11 9 2545 A\ £ PDM
M55 4%, JFr BRI H R H B TAEX H . BRI IOk B I H 16 BB ik
ARHT PDM IR % w5 LR, Mm air s gksas ol , JfikdL
fl, PDM H F'rl LLZ i PDM JIRSS 8% E BB BB B0l 2%

—  “Q% /HK%” (Include/Exclude) — £, B HER 5K NI H S
AR . TUER “BE 7 HEBR” (Include/Exclude) 1L
FERSN 3 I s BEL 495 20 H o

¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R



TR BRI H AE oy A O IER 2. 4 A ASRRCI
SAERATEERAS G, B HSMRAHHER AR SR AF I H

8. MUK “Me” (OK) il sl N (s “BE”
(Cancel) B HHEIAD

MITAERX A F A

PDM FE A 4

“MIN” (Check In) #:/F 7 “MIN” (Check In) WUJfI, 48 w] 81 Ui ik
FRIEIT, DR E R TP A I H A AR AE N B e “AN” (Check In) 1T
Tk SR VRS E A7l I H AT &

TR

LA TARCR, AR AT

2. W “SCHE” (File)> “BIN” (Check In) Bi8iidi “#A” (Check In)
N, “RA” (Cheek In) BUIHFHIL () “SEbIRN” bfE i
Sy LI R STAIR)) -

£ TN E
A HNERANHESIE. FRIFEAEE. TR EEABETERERTPRENRIMIE.

HEINE (1 7)
- i i
iﬁé&ﬁ ﬂ};EiB’: A4 3 fﬁé%_‘éﬁ @gxfg; 840 |0
it A
e ExE [ T | LwEH B

o = FLATE.FPRT plate.prt EIEE R Al JGOLF_CART 2005110417 14:23 plate. prt

3. 7£ “MAN” (Check In) Iiff I, ¥ty “I0F)FE” (Item List) T HA: N1
DU EIbr, DA FHBAR o

— “fIE” (Location)— (AT “fLE” (Location) ¥+ ) HIR
“WENE” (Set Location) X[ IHHE, fFIEAEMS hy ik e I HEH L
T SCRIAE A

R HAEAFIH B B BARTAERX — ARG R — A
ER3 HAT LA T H AR Z A ERSCH, BUAEA ER
AL 2 AT o XAE LU L N AR AL B, SR Le
TAFAE R I HLAE 7 b P BT B R R AR

ER: TH M LN SRR BN e o AEIUH oA Windchill 2o
PR By e, AUEH] “Rsh” B SO .

—- “AEE4Z” (Include Drawing) — LA N FTA L5 3% 2 Tl H A SCER
A Kl 4.
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—  “QEEM/ XR” (Include Parts/Docs) — i B A ATAAT L5 3% 12 Tl
H AH BRI 5 CAD 3CHY .

—  “LRERRHY” (Keep Checked Out) — ¥ & J& 75 K53% 52 T H (1) 9 2546
N BS54 FE L BRI H PR 30 TAERX

- “BF/HR” (Include/Exclude) — i A AL BiHEBRE & 11 H .
HEBR 30 H 545 20 O R 2k

R WARBCAHER I, WICTEHERR E A 0 H K75 H
FTH B s AE AR B (R SO X sl

4. BROATEOLT, ®FE “GIEFELZR” (Create Baseline) K a —4c3E2k, &
WA BRI G0 5 DA SR IR B s 40k H AT TR . B N 2 A 371
LR —N I H SR et

HE: B ERINIEE LIRSS, S W E P NI — 1
5. iEHE “WITSERL” (Design Complete), XXKf fuV/F AT H AR A ik
SE IIIH ARG SURAE N G o IXSSAE TAESE U BRI H 4L A8 -

6. NSRRI NI B H BUEE T A O FR N N 20 #1126 (1) 0 H AL 5 AN e
WiH, el “Bahf@ A58 H” (Auto resolve incomplete
items) S EME. EPICEIENESS, AR DhRERE R “RINIETR”
(Check In Options) UL _F s e, PN L — A BEAEEE R I -
— BOATTVEA, RS ey FI R HAME SRR . iR

R —ANURTUH, W H R SO R A S I « 10 H AN
RATEEERT, PR .

AR TCVE IR B DL AN e8I H (0 H - R Geos B AN e B
WH, I AZIR HIERE

— LUK RG W E AR A ZREA SR I .
EE: £ “BANEIT” (Check In Options) T -, 1K H 3@
DNRET R 22l S AN SE L I H F1E TG B B S 3T I 20 1
B BN B RS ANSE I I E .

Sl 5 BT RS S0V A B T AT M R AR AN
/%AJ‘H]%O

7. Hili “BiE” (0K). RGEPITIAH:AE.
R : Pro/ENGINEER &G G K B b, BRI GG B 5E A 1F .
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RN
IR — 5k, Pro/ENGINEER Wildfire foVFEAER AR FE 2T H _F3h
T AL . XSO E R G IR . G CAD SCRY KR X S8 SRS e
AR T A SEEEINE , BOE R TAEX .
“KIN” (Check In) UL 5 T A LA AR ST IEHE . Sl AE “BEN”
(Check In) TU[H i+ “IEIN” (Options) F4l, Ak “KANIEIN”
(Check In Options) Ui, 5 A] DA TR b 45 € A B A $h 473X B4
76 “MEN” (Check In) TUTHI FIERE TIUH 5, W LM% LT prid e e Soah
VE R ILTEANE R -
1. ¥y “3EIN” (Options). HIL “HAIEIN” (Check In Options) VI,
2. JEPECUNARMIED, AR S GLIE S ST B SUA T B
“BIERELL” (Create Baseline) — & X HELE LARFIG 5. S
ERVE G A RR, R
o “&” (Name) — FIANILZLIM A FR,

«  “Yg5” (Number) — FIAIEL 1T

R LA 5 EOMER “HI 4 + DLl A7 m
1R (GMT e 7,

s “fIE” (Location) — i N SCAFIA B AR . Hki ORI b
BT “WBME” (Set Location) X[ iHAE, LUMEAEARS %5 ik
PEAEAEALE . ML DU, b m] DLAEE B ) SO

HR: ALE IR ZIIE B SCSCHAR 1 S0k
o “HefRABA” (Lifecycle) — i A\ 5 A FK
— AU EE Y5 SCRSAESCER”  (Create or Associate Parts to
Docs) — 4 5 R 1 Pro/ENGINEER #1112 e A 220 6 7 A\l 8
o Pro/ENGINEER ZEHC 1AMV 5460 & A P sk e, Bkt — 7
EHC, 7% Pro/ENGINEER 2RI\ BOM A7 & P4 5 )

TIU AN FERAE (i, R R L CORIBCE” R “HRERT
%7 o ax AR AL H R AR D ik 0 bR i AR S

FER: RALZ0K Pro/ENGINEER FI4LCH, F 3 Pro/ENGINEER
IR R A
“Wit5em” (Design Complete) — & X LU R 7B

«  “HHKH” (Undo Checkout For) — 7t M7y, &L
Hrp—A k. “2WMETEXAN” (Allin WS), “2E”
(Al). “AFEH” (Required) (ERIAMED 5t “FE” (None).

PDM FEA B 1 3-23



“BERBBREIXNS” (Objects to Remove) — 7& Mg, e
LR H A — g “4” Al) (BOAME) « “DERN”
(Required) 5 “JE” (None),

—  “BIENAEEINE” (Auto resolve incomplete items) — U152
N S ()30 H BT D% RS IR 2R R T H A 5 AN S8 B IR A
FEDUH , WA IR . [ S ig T D Rede i Py A~ e 1ot «

“HEFREGSLRXNR, A5 (Update with object on
server, then ignore) — RATE/NR S5 FIL R AR SO BT H o
WAARE N UESRIUH , 0 RS0 SO S5 AN S8 R B A AE 0T
Zo HTIHATRATEEEN, B A

AR IEIE AR B LU OB AN e B RAE R SR, R G 2
AN SEBEIIRAERT 5, TF MR A TR IR E

“URRZBL” (Always ignore) — ZR 45 ML A FI) K I ERATAT A
SEREIIH o

FER: b U TR AT BRSOV T I 2 R T . T AR A
G AN e 20

3. il “BiE” (OK). BRrR[FIE] “RA” (Check In) HUH .

i H 350 H

FUEHONH , AR H _ERATR R AT . A6 I R S B 1R
%32 PDM AR 5545 o AL HH 4R DR I H 1R U5 1) 5 22 T A BEATE Y o
AR, SAEDUH ERCERUE, R, HAl R ) w] ARG 0 H
DAFIH A BRIA, HARBECE. Ak, KR RV e Brifs 1l
HECE, PURAEEA TAEX A i H

7 e R B USRI AR D AR R R R R A e
I, B AR EE o 2ok CBIUE 1A JE 2R TR H T8 s A
(ARAILEEIH AL ) WAR TAEX A, R A I IEFE L 5%
ESN1: PRI AU NS N EIEr =2 W W N vivk =20 NS <RS2 Sl 11177 NI QA7
BUEARAL B TAEX D) A ABRAERII G U H .

TERIH IR, 20 e I H A LG 2 I i ST B A - TAE X
AJ LLFR E A2 75 Y PDM Al 454 ol SEBR SO ST B TAEX, B3 & 5 Nl
BRSS9 k. R 1E Pro/ENGINEER 8 3R I 423 )\ PDM 4% 2%
RIS WM B SCE, R adedr i CER e R 2
Pro/ENGINEER 2 i IS L 151 H (AR A o AF I BE R AT HE AT o5
FETHE H 45 AL B S TR, SR R AN S SEBR IR SCE R 8081 T A
W SEER SR A e 1 T R AL R 2 AR S

FER: WREAZA TR, R GEASORA I H (14 AR D A 2 ok
M H o ERIAIH Z 1T, FoiB MR Al AR A 7 1 eI H .
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M Pro/ENGINEER H# H 35 H

2 {E Pro/ENGINEER H§ H C0 R 20090 H i, 1 H 5842 R, EE
WH, WSEHATH . 75 Pro/ENGINEER ks 3 H (1 575 = M
Pro/ENGINEER LA H, MRS A Y, DR “BRIFE” K.

MR FL RS HY
WA “3C4” (File) > “AXH” (Check Out) iy 4.
1. {F Pro/ENGINEER 1, i “3CfF” (File)> “KyH” (Check Out). %
SRR BN B8 i N REURSE HE I H A4 R
2. Huhgk e IR AR LT A BB . R W0 H R H B ) T
EIX .
A TR AR A
1 fERRM A I H , REERE “Kith”  (Check out)
2. HEUMEHAEMONEE, MSmmE, mim it e (@l
TeVEAE S — TAEX R H )
5 A

SRRy CRIERI T o RSB EIEA R H I, RIRAS K
FoRERE . EERBESEAN LRI H N,  Pro/ENGINEER 2 Bk —/
“WRZE” (Conflict) AHFHE, F5H1 “AFZUE SN, POV AL (The
object is read only as it is not checked out). FEWFHEEAERE “ILAERH”

(Check out now).
=

13 RERE |

MR iER [ HR{E [
[Jeup QHELRiEM , EAFEEHEH. HlE
HETERTPIEIR A
MEARER, FEFgEsH.
W |

HHE “HhE” (OK), WH g CalR A R IERE, TmH AR

FH AR NS Y B S g — AR AR D
TR BRA HHE T T AEE55 & R B I H

PDM FEA B 1 3-25



M TAEX PR HITE

A “frH” (Check Out) #:/EH 10 H A Windehill A8 EE 1) TAEX
t, DUEME S, SCEF TAERIA Y AL B A AL, FF HA7EmH Fik
HRE, VB — TAEX PRI T 1B 5.

WA R R R k£ “HERE” (Link) 18500, i ROCHT CAEAS H ik 2%
FEHRAEAE, MG SAEARS i R b N 30200 H 1305

H&: 47F Pro/ENGINEER Wildfire ' T/ER}, Pro/ENGINEER & £7 o< Z M
LRI H RS S H O TAEX P AEAE) i 1 B nf %
PempLeri H B TR . sbAh, mrRevT DR — L, HLRE N A — L
WiH, s RER P Ah—2eTi H 1o Hdh .

F I H -
L AE AR s Ao it H .

HER: WK TAEX ks, WSS “KH” (Check Out)
B, “EBERIHEXTE” (Select objects to check out) UL HH I, Kk,
e n] AR B IE B AE Windchill JLZAF A7 B R I H o

2. “KHHBHEINB|T/EX” (Check Out and Add to Workspace) |- FUEf
W, R “1. WEIR” (1: Collect Items). “Ti%FE” (Item
List) 410 T o H 3k e i 00 H Fk A H AR & . il iy
2 b B AL B S BRI FAR L, ol “TRFIR”  (Item
List) R I BATHHATHET o RbrC P bRl & 15 SAn s B 703 i
7 T RS R SR eI 4R .

fu tHFFE M3 TER
H(]
£ 1 BER 2 WEIET
EWMELFR [Wi_Pool 7| EEA: UGN BE. SH0 kAR UHRE
BAE (67, 3 EW) i\, [FE -] B
# # i “ X 3 “
it BREE  ® B4k cAD IO HHREE s EE
Sl E B |k | | wman LiE |
r g8 Windchill PDM A1 D TEIEER 2005/10/0 15:15 IEFELAE
r 3 cup.prt cup.prt A @ HEHIERR 2005/10/11 11:47 EFETAE
r [ tray.prt tray.prt A @ BHBEHETTIR 2005/10/11 11:47 EFETAE
C @ O lidprt lidl prt A1 @) SBREHETEIR 2005M0A1 14:23 IEFELIE
& [ platepr plate. prt A @ BERHETIR 2005/10/11 14:23 EFETAE
r [Dglunch_tray asm lunch_tray asm A1 D TEIEER 200510411 11-47 IEFEL{E
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PDM FE A 4

. ATLON “RRRE” (View) S RIEFER I MR CWERAFE AR, B

vty B DL “RMALEIEESE” (Table View Manager) (il 7E3i
SEM “TFR” (Item List) KFHLIED .

. fE “UINB|THEX” (Add to Workspace) [ Hu&F, FH TiGsh TIE

X 44K o

FER: WARAEARE S AR P AR, Wa] DU AR W] ] AR 511
HIEFE A H bR LA

ARSI H BN A E R, BRI R R 7. W,

S N A E 2L R G e SIS S

WCARIEA T H B HARAN ORI, Tt Sz H 14T, RJG1E
TR GRED b e DR s, DLW
MIAHSGIH o PR bt B b ] IR S I AI G I H « a3+
JEE I3 H BT R RIAI T, TR AT B b Ak F-ARIE SRS . ]
DOMFIR IR L AT« ARTEAER, WS W A eih R
KIH” —77,

iy “ERE” (Configuration) 2, JyJE T-HI4A 1% & BN H A H
MR H AR A RIS . ES W, “WERE” —75.

R R H AT IR RS “HERR / B E” (Exclude/Include) ¥ K
HeBRIUH o ZIH AT h & I — 4L mBR 2, Frm s MATA
R HERR Z I .

B “HEBR / BE” (Exclude/Include) (FE3%E & #HERR I H
FIATID iz 5 E 20 H 53R, FRR MR bR,
REHBREATH G, SEBEEN NP8, RERM2] Bk
1”7 (Collect Items) A BR, WK s g HEBR I H - (FEA S HERR
P H, WAL AR .

CRI3E) EEMHBRAT ORI H WOSR IR IR S e R B FE Uik, s

' i “EE” (Reset) €.
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7. Bk “F—#” (Next) ARZHAT “Mrti IR MBITIEX” (Check
Out and Add to Workspace) T 21305 2,

I SENETEX
Enm
I, 1 UTET 2 RHIER
mAE (G, # 6 wE: [FAE )
8 | P Hy 0 <
i F# 3 BRI EE
EINNE siem  |me | [WERNO semw (ks |
r v [ cupoprt cup.prt A1 (D EIERE R 2005/10A11 11:47 IEFETAE
T v [Oglunch_tray asm lunch_tray asm A1 (D THEIEERN 200540411 11:47 ETELAE
r Ny @ Windchill PDW A (D AEIEE R 2005410010 15:16 IEFELAE

LR “2: BBEIN” (2: Set Options) 1, 15 & 7y B A0 ] Ab FAEAS ) oS
IR TAEX It H N 28 AP BV IE T I3, “HRBIEIN” (Set
Options) 2V 3§ L) “TRFIR” (Item List) K5 T DHSMPIRES], W
TR

— “THERAZFIRE” (Workspace Content status) — ( HZFIG5) TAF
X AR $8H AR BRI H N 3R AR, @ 5N
(RREEE ABERS o N s TAEX R i N . FRnds Ebs
N HTIA:

o CMEO ¥ — AEPATHRAFI RS A TS TAEX

o GO W — JUR U PRSI TAEX A, IR S AR
BN R AR h 2

o GEAD & — T TR P RIANA CREH] RS 4 Lol

o
—  “BERAE” (Action status) — e AR I H 1 AR E . 8o
PREBR IR BT -

o R ¥ — R H e 2 AR X

8. MILIEFE AR AIH, RGN H THATE S 38E, R A S
PATRE H Il AL BRI H AT 28, ] “KEH”  (CheckOut) £y 4
Dieds, MR Rt A H I Hid R AR I H s
(Action status)) . fE¥H&) LAEXH, AILUMEH “T#E” (Download)
P “HEE” (Link) By Rl “FEH” (Reuse) £ SKifle &5 R #30) TAE
XAWAE “THEXANEIRES” (Workspace Content status)) o

9. (AliE) ZEMIERA S H AL PE 4R E TR/ AR IR B A IRES, 15 H#
i “EE” (Reset) ¥+,
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L AT PR AN AR
BT RES AR RIS CAD SCRIM I Bt . REUSCRF A CAD SO
IR R /NEAS, (ELEESZ LR 26 124 34

PDM FEA 4

10. TRFFE, % “4E Pro/ENGINEER 3T FF— Ak ERIR” (Open

initially selected items in Pro/ENGINEER) 5 iEAHE, DUEZEHATRE H i
[ Zh 45 Bl ) Pro/ENGINEER % I FR T JFREAN WA 2 T H

11. B “5ER” (Finish). 26 5E 100 H B2 RIS IR e 9k B S |, 1

SR IR M A rh TFAR A6 H R A (1 L S

ORI TS, Fi5 Y 1E S uUR RN AN I J0T/INCAS o

e “HFEHEAR” (Event Manager) T —WrhSEH L, 5 HAGE
Ao H I B INRA MK ANEAS o 30— ANl RIK PSR Rl i A
“TIEFRES” (Conflict Manager) 52 IR ) o

IR AN BB/ NS BT AR 0 5 T BOAT ORI F I, X 146 8 2 It
H, BUARCER “JRifr” IE Oh2E “S8of”) .

FERLHN,  CAD UM RATE /MR N (RS T s

e, AR RN CEE . B, AR MRA T RS
PRI TP IRIBG, U2 ORMR B ORfr o DRIUE,  SBANS Ol CUAG H A 1)
NRASNEE TS AN ERPSCER. BBAh, — HARH, HEE AR I H
el A7 o A CAGZRBLL I NBRAS) (/NIRRT o G2, far
H S B A /N FBOA SE2 o 30 A R 5 (K /N AR I 37 RIS e 1 1R /il
A N ERBEATIN o

U SRASE Y ) N RRCAS 5 BE e iR vl S IR 5, A i 2 A B
TAEDK, PR A A B R NEAS o

A FeVFH CAD SCRS AL (R /INA A, HH B ITH

FEVFIISUH P85 BRI RRAS R B AR, HE

— WRAEABH, BCE R A H B ) — R PERRA .

— TUH YHTARBE AT AR H

— KM Windchill PDM B¢ Windchill PDMLink #5443t 72 3] 15
FETEFARE NI I, B A 5B N RAS

HEE: {E Windchill ProjectLink WA SZHEEKY H A LA /N A
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HAL

3-30

YUE FE A IR 24 AT Re AR 06 00 H B /e s B i ek, K
S A7 AE Windehill H I H BRAS, B8R AR BR RS B EE L H kg
B

TR N, S 237 ORI H A P ARG £ R S, i FLA f
Windchill 7 A 2K R8BI TAEK H . T AEREA R4 Windehill 7. 2
NI AR, A DUR R R

Lo NIESD AR, Bl AR FOAS HE R 20 H 55 ) SR B ATE

2. FELAEXCEHRALH, HEF “3CH” (File)> “HiEKH” (Undo Check
Out), oifE TAEX THA FRd “HiEHH” (Undo Check Out). i
“BERH” (Undo Check Out) T .

3. WERIUH BA KRB B, BIAR, BRAFEsL], 1EBkaI bR 4. &
W, AE “HN” (Rules) XA,y LU ZEIAE H ik

—  “AEKFEXNE” (Include Dependents) — 41 Hi 110 H FIAKAF AL 2F
WINE “HIEHH” (Undo CheckOut) 115 H 41| £ .

“AFR” (A — I H T AR B
“DFER” (Required) — I H P A i IAKAERT 5
“J” (None) — AUSIKAEXS B

—  “A&E4K” (Include Drawings) — 4451 HH KI5 H 1K) I I 4045 £
“WONHH” (Undo CheckOut) (I35 H %1%

“EER” (AN — A E A ORI AR
“HEEM)” (Selected) — ¥ N LLHTIE 52 F) R BEE 48
“F” (None) — AN INSCHEA 4K,

—  “AEHMH4” (Include Parts) — K41 H 1T H 1 G )
“HISHH” (Undo CheckOut) (1351 H 51|46

“EER” (AW — RN H FETA AR AT
“IESEMI” (Selected) — N HITLATINIL RE AR AT o
“FE” (None) — NGNS EHLF o

4. WERAD IR 3 PSRRI, W “RIFTIEIZR” (Refresh Item
List) JFHAETR. w0, SR80 5.

5. (i) EHFE—AIHEIFRL “HBR / BE” (Exclude/Include) 3, 7E

MBI R H AL H o] 205 & b 2 Y. HEERIH 5, T H
DK SR SARGEN ] 32
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6. EFE—ANWRZATHIFRT “UIB| T/EX” (Add to Workspace)
B, TEREITH IR S P 2N 0 3 A DX RN I st Y 2 2 TRl e T
Uit i RBEEEI T HNE, “EFE” (Choices) 51 2s LR H ot K
AT

7. £ “HIHKE” (Undo Check Out) GUI (M “HAE” (0K). &
ORI A% e I H

EE:

FERHR G, ARG i a8 0e 75 F AR X P R A& i I H 2 3
Pro/ENGINEER x4 A1 i3 H &

LA B)H) Pro/ENGINEER 2% IGH I H (R, HIs$e “30f”
(File) > “3#HAH” (Undo Check Out).

TR O I E (R, EAEIE , AR E R A b
“WHH” (Undo Check Out).

BRSO A T R iR R 5, I TR R T R R R Y, R R
EAIFLZAH A ) Pro/ENGINEER A4

ASHE S A SR LAt A HL8 A R T
AR BT AR TR AT i R AESLAL P I 0
THEIBHE CHBBERNMETEXS)

Pro/ENGINEER H {1 F 23 /E R Windchill FP 1 “Wsina TEX” #4E o
BT H i R ARG IAR TAEX . XA ik EHEaEm H F ik ESUE
ety WRZABS O FERKIH, ARG RER HE.

M Pro/ENGINEER F FFi5 T

7t Pro/ENGINEER 1, ®JEUMEH] “CHATH”  (File Open) % il HE A i T
YEIX, Ff I\ PDM g 55 % ok 1 H T 252 Pro/ENGINEER [F)23 1 1

1. 7£ Pro/ENGINEER A, Hiii “3¢f4” (File)> “3TFF” (Open). “3Xft
FTFE” (File Open) K FHEH 211 .

2. fH “EIIEE” (Look In) FIFRAKLEFAI VI TAEX . — HiEE T
PP, AR At AR SO X R B

3. EBEMREMIIH, RJEHRE “4TH” (Open). L@ M50 H K 403
Pro/ENGINEER 4] JT.

R FERIH BN 2B ERNITH, DU .

PDM FEA B 1 3-31



MITAERX IR “On2B|I TIEX” #4E

3-32

R “@i” (Add) C“DINEITAEX” (Add to Workspace)) B8 TAEX
TH, B\ Windchill HeEEIT H I E) TAEX e 5300 H OCH SO 14 i
BIAHRESL, PERIATELIVT ] o

FER: Pro/ENGINEER A7 SR MM LI AT H PR (WRIH B8 TAF
DHRAFEAED M T AP sl A n R FEIRLE I H T M. BEAh, mrfgnl Lo
LRI, R 2RI, BUR AR D A 8T H R e
NI |
L AE AR A Atter A3 H .

ER: WACRAE TAR IERIH , WIAEH S “Ein” (Add) I, “3&

FHETHEXER” (Select objects to download) VL[4 HH I, &R LLikEE
JF R AE Windchill JLZAAAEA B I IH

2. M “ICHE” (File)> “¥WRIN” (Add) B “WMBIT/EX” (Add to

Workspace) -

“USINB) THEX” (Add to Workspace) | FUEHITL, BRI “1.
WEET” (1: Collect Items). “IRFIR” (Item List) 51 H T ANz
AR Hp I s R H A5 H R ERA S . i Y s A
HERSEH BoRPAERI AR, AI6E “TRFIR” (Item List) £ 11 H
ﬁ}ﬁ?}iﬁ? RERC bR 210 AR5 B 7L B e T R 7Rh R
AT PR

FENATHER
HC
SR 1 REW 2 BEET
EMETLHER [wi_pooi ] EEA: ENEN KE. BTN kANs. U8
WX (57, # 5W) wE: [RE -
i3 A A A X % “
i EREE B B CADTTHS HHRREA L BEE
= B mE || e | bxE | |
[T @  [Oglunch_tray.asm lunch_tray. asm A @ HHEIEER 2005/10/11 15:46 IETELAF
= 7 cup.prt cup.prt A1 D PR 2005/10/11 11:47 EELIE
r O tray.pr tray. prt A1 @ LEMFETEE 20051011 1147 EELIE
< O ldp lid.prt A1 @ LEMFETEE 20051011 14:23 EELIE
@ ([ plateprt plate.prt A1 @ LEMFETEE 20051011 14:23 EELIE
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PDM FE A 4

. ATLON “RRRE” (View) S RIEFER I MR CWERAFE AR, B

ki BB Ui “RASVLEEEER” (Table View Manager) (n]7EtLr]
S “TF)FR”  (Item List) K FIALED .

. fF “WIBITVEX” (Add to Workspace) FH 44, #1158 TAE

EYIEY

R WARAEARE S TAEX A AR, AT EOAIHAR ] TAEX 511
HIEFE AN HAR AR

QR I BOAR S KN, BRI R R 7, AN, i

D A A EZL D RS PR R e SIRTIEE e

— R TH Y HABAI ORI H it IEFEZIUH 4T, ARJEAE
TR GEAE QRO Hohd AR, DS
HUAHSRIUH o PRy bt B b IR S IR G H A 3xt+
G E I H BeAT P RIA R IR WA B b Ak T ARE SRES . W)
DAMBIR IR ZAIH o ATRVEAEE, WS WA 3
INEMERA I ” 7,

— i “BE” (Configuration) %5, AL T-HI4h1% & A I H
MSCEEMT B A R ERE. ES W= “RERE” 1.

— W EEIH AT IR R “HERR /&7 (Exclude/Include) X KA
BRIUH o 1ZI0H AT 2 IS B IR, 457K AT AT 3k
— I ERAE PR I .

Hkwdy “HBR /848”7 (Exclude/Include) (/7% @ M HER: 150 H
AT Rl i B E R 2000 H 52, FRR MR A mibrg.
RAFBREATE G, BEBERENT 258, REREZ] U
Ii” (Collect Items) B, WK Bos g HERR I H - (FE A O HERR
FIIH, A ZLEMERZD .

CR3E) ZEMMERAT ORI H WOAR IR IR A1 R B bR, i

| i “EE” (Reset) 7,



7. Wi “TF—3” (Next) DA4REEHAT “UinB TIEX” (Add to
Workspace) I HI{2 5% 2,

AR TR
[y |
ET 1 uET 2 GEER
WAR (5, 5 wE: [F0E (2]
& | P Hy &5 “
A T HETE EH{EA EE
SN K AT wE || wman Ew | s |
& a  [Oglunch_tray.asm Junch_tray.asm A1 @ THRIETER 200510411 15:45 IETELAF
4 3 O cuppr cup.prt A (@ TEHIEE R 2005410711 11:47 IETELAE
r2 & [ lidp lid.prt A1 0 BEOEIIHE 200840/11 14:23 EELE
@ & ([ plateprt plate. prt Al O EREMEATTE 2005410011 14:23 [EFELE
- T trayprt tray prt A1 @ L/ROHAFHE 200511011 1147 EFELAE

EARR “2: WEER” (2: Set Options) H', $i5 i Ay B Wi &b B AR t sl iR
B TAEX AT H N 2. Dy B BT %2, “TRFIR” (Item List)
BT TADBOMPIRES], ik prid

“THEXABIRE” (Workspace Content status) — (L AERES) TAF
XAl HD FEH TR BRI E WA TSR TAEX T, @ H AN
PIRERE LSRN 2, s TAEX TR I Y N2 . Faonas B bsan
T HTIR:

o CMEO ¥ — EPATHRAFI RS A TS TAEX

o G W — JUR W PRSI TAEX R, IR S AN
IR LRI A &

o (GEMD & — T TAEX AP AR M IR 55 25 ol 247
Jil )

“BIEIRAE” (Action status) — F57~ 2 H I H M RARKE . 8-
PREBR TR ik

o O ¥ — RO H A 2 TAEX

8. MWIEFE—AWMEZATHE, RGN THEP RS S #8E, fBes B2
PATE IS T AL BRI H AT 25 T “ReH” (CheckOut) £y 1E4
DIeds, MR Rt A H I H e R AR I H e
(Action status)) . fEVH&) LAEXH, AILUMEH “T#E” (Download)
P “EEER” (Link) Hy F1 “ER” (Reuse) /3 KAE 45 RT3 T A
XA C“TAEXNEIRE” (Workspace Content status)) o
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9. (nIXE) ZEMIBRA I H 4B H 8 FHR ) R B AR, 1
i “EEB” (Reset) €.

10. WRTE, ¥h “4E Pro/ENGINEER 3T H—FF 41 E KR~ (Open
initially selected items in Pro/ENGINEER) & iEHE, LCUELERATHRL I
H S 7E 5 Pro/ENGINEER % F 4T FFREAN VI 4632 2 1 H .

11. $ih “5ER” (Finish). &€ 190 H K3 IS 038 e R B S I, T
TR A [ 2 N T GE A H B (R P ST

USRAB S TAERAS I B AR A S I, iy EL s e 0 o a2 6 20 P 11
N EERRR N OO, e e TR K B

M AR A AR H

PDM FE A 4

A TARDC R RE T, R el TP P 8F 2T H o Bald. 1177
B SRR I SN2 TAEX . AR, ErTRea kI, TAF
DX s AEUIHT Bk 11 TH 300 ) AN ASE P A 000 o B AT A X AP IR B AN 7 22 )
TH , R R MR A

Lo AEW I TR, e # A e A ER 1 50 H

2. fETAEREHAT, i “3Cf” (File)> “MER” (Remove). “MT
YEXMIBE” (Remove from Workspace) U [fii £ Pro/ENGINEER || % 2%
17T

3. WURIH BA REHMKAA N S, gt s, igska b 4. &
W, AE “HM” (Rules) XIS,y LU BT H -

—  “BEKFEXNSE” (Include Dependents) — fiffi i & 75 Mt B 10 H (K A7
YA

“HE” (AN — BB H BRI R .
“BEHI” (Required) — I H K HOITA A6 76 HORAT A 4«
“E7 (Nome) — Mk it (95 FLIEAR I JCATAT A A7 0 .

~ “fFRE4K” (Include Drawings) — i A& 75 BRI H 1 156 B4
“HE” (AN — BRI H B ILTAT (I 4.
“YESEH” (Selected) — IMWRIR F 1 AT LA 1 O FE4E
“I5” (None) — M Tt I AELAS IR SEAT o] Sk i PR 46



— “AEEM” (nclude Parts) — ffi i & 5 MR 5 300 H SCHER) HA
“CARER” (AN — MHERIE KT SRR .
“IESEM” (Selected) — MHERIN H A FLATAT ARTLE 2 54T
“F” (None) — MIERIT H AHAS R FLATAT G (13 1«

—  “fELH” (Include Instances) — i & J& 75 MM B ATAT S 6 ) ik 22
SEA «

“EER” (AN — MIBRILH K ILET A S .
“HEEE” (Selected) — MIBRII H Kz FLAT-Ar] LARY I 52 (19 5£ 51«
“F” (None) — MR I H (HAMH B ILAT ] 5451

4. il “RIFSCHERIFIR” (Refresh File List), LN FH AT 2656 1050 00) - 7
£ O“TRFIR” (Item List) K. ERIFSCLEFIRRS, BAeRrxt «“mizR"”
(Item List) & BT 1 3 ook 45 5 0%

5. 1F “DANITAHEXMBER” (Remove from Workspace) L [fl FH¥idi “HiE”
(OK).

ER: WMANTAEX PR ORI AT, 2B A, i EL 6 H
TR o2 2K

fif TAEX T H RIEFBAHTIRES

WRAEZ P IREE N TAE, W R il 2Pl : 1 4E TAEX H HA I
H, i HAR A = s 24T T . O T s A O,
Pro/ENGINEER Wildfire 255 50 H AR AR LI 501, I RV T HnE 2 m
BT O ) TAEX I, DA PRI S8 — I TR SR A 50T 1 R 55 a5 S o
REGE BEILRES VP IR A, 2 3 “THIRES” — ik,

AR T PIE a] H A8 AR X AR R s BRSO #4508 A
“IRE AR o AR 7 o6 0 H BEAT B 5 R AE 5 — A AR X rpoxt
T H EATAEN TR R B A AT AR DI H 5 BRI CAD SCRS AT #F
FCERYE  (FE “ TARDCEEI” g 30O ARSI, WfEH] « s
Ao BRI AR X AC B2 Sopr B 1T I B ol iAo W] LI —
A e AN EHOF I H (B, 250 H RS SRS R I E AT e Y]

) o BbAh, WTRAFEATUCIERIUH 500 FIkFe “ B0 4 (BT -
MHD o AERXMIEL T, “FEH” (Update) TUHI< A SN 78 TAE X P ARAT
I E o AR A BT A RS (B, SRR, NEk, IEEBE
BRI #5 28 R 480 , PAT SR 2 5 L 30100 ) o/ RCAS o i 81 A
DX e 12 I EUR TAEX I 1

“PRIZE AR BRI AR D CAAE I H R 0BT B SR A iy i 52
77 (B, ABRSEAR SEEs T BEAT B 50 o DB ok G A — 5 P i W] 1
PEHRAT
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B LAEXIH

FEHUH TAEX AT, 35T AR R

1 B TAEX P IEREE B I H O THAE - XPR 8, A IEFRAT AT 1
H), Rty “FEH” (Update).

| I
] 1R 7 B EIET
MEQ: #HAHY BE: EFN &Ede. UFR
‘Jﬁﬂi (1 e 313 W [FE =
# ol i) 24 X % £
ik EREE % EE cap THE MRS E =B
I'JJJE £ | T EE | IHE -EE | | wEAN | DR B
O # [ ftest test_assembly.asmAS A2 @ FIEIETER 2005410413 17:21 IETETAE

2. “FEH” (Update) TUIKG I, JEERPE “1: WHEI” (1: Collect
Items). “IAF)FR” (Item List) 741 H T 40 48k 58 5 ik o2 AT
[ I00H A AF I H BN Ao TR e 4 Rl b s B B L B s i R
HAT BbR S, mI%) “IRFFR” (Item List) £ 4 I HATIATHE . R
FrRic B bR 2 AE BRbr s B A0 H IR T B R v BoR B AT T 2R

AL “RRE” (View) SEHRHIERER 5 —ME (A fe) , 5

el g DV “RIEPLEEESS” (Table View Manager), Jfi& il

FEALIE

3. WIARXTIH MEOAE A B, BRI AR DR 7. B0, Wik

PLUR —FhEl 2 Bl 248 Il 4R 1 il H 4545

— WEEFEATH IS, Jrvisg: EERIH AT, ARG
THEASSEAE GRED B0 —AMERERES, LT i
PIFHCINH o PR e P b T B s AR SCIH o i X1
BRI H BAA AT H , Wb T AR 3RS rTEL
fﬁ%ﬂfﬂiﬁ%%/ﬁﬁ He. ARVEAER, 5SS WO som e AH < m H
/E 3-3 jL—"

— i “BCE” (Configuration) §2, AL THIUGE € EE B H
MIBEER I HAES R ERE . H2 W18l B4 4-36 Tl

PDM FEA B 1 3-37



3-38

—  IEEEIH AT IR “HEBR /A&7 (Exclude/Include) ¢ KAl
BRIOH o 1ZI0H AT S I AR B IR, FRKs AT A 1
— WP IE . R “HERR  BE
(Exclude/Include) (3% & #HERR I H FIATID R %00 H ]
FIIHBIER S, I MHBR L EMIER 2k .

4. (Alik) FEMIBRAA ST H WAL R & 3K 5 R R B LR R A, T
i “EE” (Reset) €.

5. Huli “TF—H7 (Next) IZRELHAT “BEH” (Update) TH[2PHR 2,

E
mm
HR 1 e 2 R

|J§§li EHERE

il ¥ Hy g

= TR 6E EE
m L] e e |3 | THE -wa | |wean | reEs (ws |
O 3% [0 test test_assembly asm A5 A2 @ PHRIEER 200510013 17:21 EFELAE

6. fE0IR “2. WEIEIN” (2: Set Options) ', 5 & 7y B Wfr] Ab BEAEKS HY
BN IR TAEX AR I H N . AT LGS, “TRFIR”
(Item List) RALE T PIANEINFIRES], Wi N Pridk:

“TAEXNAIRA” (Workspace Content status) — (HAEIHEE) TAEX
T HD Fe YA BRI H A N AR TAEX R, B S N2
HIRERE AR 5 R 3. FRonds AR R frogs

o CMEO Y — AT ERAF R A T 38 TAEX

o GO W — JUR U PGB TAEX A, IRl S AN
TR AR b 2

“EAEIRZS”  (Action status) — 875K S HTHRLL T H -
o (HFD & — M TAEX I H 5 RS54 EE BORERFRD

7. WIEE AW ATHE, ARJEN A THA R E S, R A A
AT ST IR e AL BRI H AN 2. WD 6 IR, ARG s TAEX
o, ATLMEH] “TF#” (Download) ‘P A1 “4E¥E” (Link) My Skiffi e 45
RFTA0 TAEX 2

8. (ML) ZERMBRAT ST H AL 148 2 R 71 R B LR A RS,
i “EEB” (Reset) €+,

9. Hli “SEA” (Finmish). 35 (K300 F RG2S 45 02 s in 21 TAR X
S Z I, TR AR [P IR T S B SR AR (R S

¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R



Rl T R T A

PDM FE A 4

#517: 1)1 Pro/ENGINEER it & 3L 3
OVERWRITE _CONTENTS_ON_UPDATE %1 “H” #AF b AT h o

— WEREEN “no”, WIARGEA S i IR N AEA G ) A
7w, BRI o

— WCERBLEN “yes”, WIARZER T HUFEA NS S s I L o
Huoh, o RS s 1 R0 G d X U0 5

AILIMER] “[R22 TAEIX” (Synchronize Workspace) 5 4/E BH A hill 7 iy 35 25 47
R I T TAEXIE , AR R S — P B (RS
TAEX ) RS o ERM TR B . 28005, WS 7 s
WEEE  CCRESAFBANThEE) £ T/EXIH M@, WEEE 5 RS
PREAT WX R A BE A S B oA a6 B AN Hh = T 2R A

PG AF 105 S IR S5 A [RD AT ISR R ) 2D R s R R

% LIRSS AR R R AR IR ERRECRRE,
FLC R R DEr LR L7 S R -

— FERTAEKHXPRE “Clfh” f5E %
— AR AR AR 5
— ML TAER AR5

(EREIESE “3CHF” (File)> “EEH” (Update) MH5 kL W [FP . X

EEZiE RS WPIW NI ENSY

- BRAXRDIFEPHIANE Gl Eprig)

— A IS A (1 SO AR T

—  FEHEE AR I H A S RRCAS R e A S B

— PRl N M RS A TR AR
5 24

Z1: TR “REMEZFESS” (Table View Manager) ¥ “ LLESR
A7 (Compare Status) 57N E TAEX A& oo a5 /LA
FEo et AN A I TIH 2 A7 3 IR A A e ST A A L

B TAEX 5 RS #s WAL, WHAT LR i i

1. &R “XH” (File)> “[FIP TAEX” (Synchronize Workspace).

RGURA T — s (B — TAEX ) fEIRSS s Lt AT i) o
S ST R AR DM AR DR A 35 H BT A5 U



fEFHSEFEE A

Pro/ENGINEER Wildfire Al Windchill fIli45 %8 2 18] V5 22 F45 A FRAS 2 [R5
KAR, XSRS T EPAT HEAEEAE Cn “RN” 30 “ B3, [H
IS 7E A B % B A IS 4R 22 4F Pro/ENGINEER H T 4%,

A B AR T — Rk, M TR A 7E Pro/ENGINEER 5, Windchill
g A O H AR B IR LER U RS it . T A Pro/ENGINEER HH i it
BRSSP R SRS B bR R VT W e . 4R, 85 E Pro/ENGINEER
Ul Hik$e “TH” (Tools) > “#H|E” (Console), 1] UL in) f&&EH: 3 (14T
RS s Edl G . M IAER Y, Wik “PE” (View) > “FEFEH
#%” (Event Manager) >k [ 5 B4 . 78 Windchill PDMLink 1
Windchill ProjectLink H', tHr/ LB IER “FERT” (Home) > “SLHEF”
(Utilities) > “ZE/FEHSR” (Event Manager) K1Jj 1t .

WA TAEX EL PDM R 48 AR 45 b BRI, W< B3 E3)
“EHMAEHEEE” (Event Manager). W14 M Pro/ENGINEER H /' 541 4 4
HI=E 5 A BRI, T Pro/ENGINEER R HoKE H 0 AR B3 RS AR

FEHAT j(glﬁEE’J%%L@&T%E&%%&H%EPIT’EHT (U e
fE%ﬁf%%lJﬁﬁﬁy Jor DR A R A UT TR S 1 IR 554 (R e

FAE AR A HANBER i, ST RS A E YR T PDM S5 55 Ab 2

EI‘JYEP% RAGA R LR IE S, LR X S 58 o 31X = AN T 73 )
: “HHMEHEE” (Event Manager) VL. “EHHER” (Event

Informatlon) GUITAT “PREFIR” (Conflict Manager) UL [fT

“HFETESS” (Event Manager) WU

7 “HEAEFELS: <RS- >" (Event Manager: <server>) UL, 1]

IR R “Z” (Events) AT L IN 8] 56 f5 W7 41 H R TEEE(%%EE’J
PDM . nfLUE S fEHAER “#4E” (Actions) Pty @, fE “FfF
{87 (Event Information) U [fi " i [n] A3 O & FAF IS B J%Ei_i_
By “¥RE” (Actions) FIH BRI E R “PpPREESE” (Conflict

Manager) UUfl, DA BUAR PR 58

HE M2 http://i2688.ptenet.pte.com:8002/PDMLink300/

H 4 m)

x

HEs Rl
r_ | REEE wxm
| Créer un docurnent CAD BATh. EETEE @ %2005!10!11 12:44 200510411 12:44
r SRBZRS BRI @ 200511041 15:25 2005101 15:25
r 217 BRI @ 200510411 15:26 2005101 15:26
re L& s @ &y 2005110411 15:27 2005101 159:27
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“EH{E” (Events) Fib A A THES, Hpad 7T LU FERER L
“HBE” (Delete) ¥ — M3 P IFR % 2 14T
“RIZ” (Refresh) [#] — Fill i e 1 giqh 512

FAFRA
“HMHETEEL” (Event Manager) 0TI KM AL & T HI THR 1R800y
SO bR . SR bR R T
Q — TR R
S — RAr RIS (RO
LS o2
B — A7
— Ak
@ —oER
I — %45
FiF Rk

“HETA” (Event Manager) 1] “#:1E” (Actions) &6 7 m] LA H
“HMHEFR” (Event Information) V[ “MREFESE” (Conflict
Manager) {JEIbR, W Fros:
D —f “HfER” (Event Information) T[T 75 7 A B
D “rhieEER” (Conflict Manager) "' 71 5 2 % ol 4 5%

— 7E “PPSETEIL” (Conflict Manager) Hfif e ph 58

PDM FEA B 1 3-41



“BH{{ZR” (Event Information) W [

WitfE “ZEH” (Events) R i s 1) “HAE” (Actions) ZIHH 5,
BUR SRR AR R, N “EEESE” (Event Manager) i
W “EHER” (Event Information) UL,

3-42

< EOEHEES
HEHIIEHRS X
FfEE: SHOSHRS HEEHM- 20051001 1525
TEK: W1 PO LWHM 20051011 15:25
P Cmoh EfTHEE: 7000 ms
‘ BEWME O 7
| [®= =& | wHER

U TS 2 — AN s, Wil Enike 2 “HA4EHES” (Event
Manager) 1] “ZEFF|R” (Event List). SERAEHEZ L T 0 X 155
W T HAE M, W N R:

o “HMHLI” (Event Name) — FIFM AT FALIRFLM L “IMER”
BRAEIEIRR (¢), MU AR BB S Bl e, W A2 RR 553 IR 2 AN
o —TE (SRR B bR

“HFEEE” (View Warning) Sy — W H/FR7 15

“EFMI” (View Conflicts) &y — U R F{FAA LA AT 50 b 58

“MELRIHZ”  (Resolve Conlicts) (7 — WG SEA L al F IRty
«  “TAEX” (Workspace) — ST TAEX

o ORF” (Status) — WERFMFCSERG W EIRHFAFIPRES, A0SR
N, TSR 2 A 58k

« “JFUGHM” (Start Date) — FAEIFAA 1 H IR )
o “HRHH” (End Date) — F£F5¢ 5 H HIRT ]
« “IBITIIIE)” (Elapsed Time) — 5¢ s EH i (LRI H] CAR EL5E 0

# Pro/ENGINEER Wildfire &5 Windchill At ] Windchill H1/] Pro/ENGINEER (4 & BLFi5 7



PDM FE A 4

“PPREFIS” (Conflict Manager) 5 BI & F A Ui H PDM ZFAF 1 o
5%, A “HAEHEER” (Event Manager) Uiy, sEMRE “EH

MHZ” (View Conflicts) &y 5 “fRyih5E” (Resolve Conflicts) &), M “ZF
{5 E” (Event Information) Ul [f1)j )& o

T e B
S (1 E 1 E wE: [FUEL] B

Ewiah: [ |

TR
wh util WTException: ZoiEH—1 B35 CAD JHSFME PDOMLnk P& Windchill POM, BEIAEAIRIBHFFFE POMLnk F=f Windchill POM AR ‘
mE—. BHEM CAD &£FFE rod.pHe

“PZE” (Conflicts) K1) THFHA—AN TSR, EHIH T ke
5 (CInEA) LR “ERIEM” (Retry Options). “#5” (Conflicts) %
W) “PiBR” (Description) F1 Ui TS, W B B AT WUTU\T?‘%
FTHIT “PRULEE”  (Conflict Description) X 354 /R 52 £ SCA (Gl

76 “$iB3” (Description) 51" LA B S (1..) o

FR R SRS, TEHRAT L R
L AN E e IR R AT

2. METEFPR “ERET” (Retry Options) 741 E Pk —A ik
It

3. Hili “R’E” (Set).
“PPSE” (Conflicts) FEKelHT, LAMEAELEE AT “EREIR” (Retry
Option) %1 1 % 7 BT IR

4. i “WiR” (OK). RGUKEIREAE, A “HMH” (Events) 5K
BIAHIIIA H . JRIGFHRPREESCh “BER” (Retried). 76 “7
REHIE” (Conflict Manager) 5% [ 4 S AR 3 — D05 in) & HLE 1.
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4

¢ Windchill F4-FE T H

AP AT AT B ) PDM 155, 15 Windchill Qe Ab 3 — 4
Pro/ENGINEER Tii H (g Mfafh £ ) .

e TG
B H B (Attribute B Property) . ..vvv e e 4-2
T AT 4-6
T “RBAER” R 4-9
£F Pro/ENGINEER FHTIFIH ..o 4-15
B R R . 4-17
T T e 4-28
CAD SCRYBEARFN Pro/ENGINEER URZEAF. ..o 4-29
A EE AT . 4-31
PR R R AETT H 4-32
LW AP 4-34
R = S G5 R AT CAD SCARSZE AT FE BOM .o 4-41
X} CAD SCAYFI WTPart HEATaR A AR S .. o 4-46
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B g (Attribute BY, Property)

BT TAEH I T RE s BORAEN BRIl g e (Attribute, HFRA
Property) , BREREMEM (Attribute) (. “4u#B)E1E” (Edit Properties)
T Rt 7 AT DU R 1 5 7

() i g 0 £h 2 AN 000 H AL =18 (Property BY Attribute)
ERANTH gl 2 AR 1

W GndE TAEXIE g, BT/ (A& SO A 20350 H I AR XA .

o, WAl DT H (A e A A _EIF G B s vl ONIH 1945 B
G AL R E T E3) “YasEJEtE” (Edit Properties)) o 7EIXFiE L
T KRR BT VE S SO N 2055 H T A .

M TAEX P4 R

A R AR X b g 2 AN I H IR JE P (Property), 1XL6JE M
(Property) 041 1) CAD SCRYFEBAEI HARALE, DL EL4: CAD SRS/
FAS ) g PE (Attribute) %5

Lo W E A TAEX
2. AN EELUN CAD ORI
3. &k “RE7 (Edit)> “4eEEtE” (Edit Properties).
WUER T I H 548 50 H sk 2w AR, AR XTI

“rEE” (Edit Properties) Ul I, WREFE M ARIH,
Mz — sy R, R T RE Gk g 2L H .

SEEM a
|HRAE (@ R W wE. [FUE
2 B 0% m M oM W M x e e I8
HEE i =4 Eivhi] it IBAER i3 R cAp I HibRAE Baf
~ 1] e e s =
@ ([ PLATE.PRT plate.prt G SE ] =

4. WERSEANTUH AR H , J5idot: EEEZIUH 94T, R £ T HAAMW
XGEAE G M — MR DR, SR AR SRITH .
EE 5 AH R T H AR OG5 0 o AR w] BN B A IR AH SR ITH -
S5 (I H B AT ARSCITH - B b Ak T ARG 2R . L
MIRFEFEZATH . GisZ W4 PDM #0015 3-2 50D

5. (A[ik) i “BEE” (Configuration) T2, MY LA & B g4 g 1tk
(I H 45 2 TR AR B (G2 AR 2 lid B AL 4-36 UL, )

4-2 ¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R



o

10.

11.

12.

7E Windchill #4335 H

(Ali) WHEEATH AT, il “HR /88 ” (Exclude/Include)
Ko DUHEBRZ IR H o %50 H AT P B — 44D (MR 2, FK A
AEAT B — 20 A rh HEBR i 0 H o

PR “HEBR /BE” (Exclude/Include) (FEIEE BHEER 00 H 14T
) KA H =R 2050 H R T, FER R L e bR 2k

(W) BRI R, Jrikad: N “HLE” (View) P IEFELRN S —
FIRLE ClRAFEAE) , sRE AR T o BB LAVl “ RSB
FH2%” (Table View Manager).

FER: HRwBrdtEEmrE g .

CAe) ZEMIRA SCT H WA IR 48 2 JH R A R I R B L TR AR, 15
i “EE” (Reset) ¥+,

FE AT B RO, R, WERAT SR, A
B

B}

AR EATHAT, RIGHd “BBME” (Set Value) =7 L)
“Uiig)BMEME” (Edit Attribute Value) X[iEHE, %] DLZE PR E 24
TH EREZAN BRI (BURSE T “idgmtEm” hidm T “4%
BEMM” (Edit Attribute Value) X iHHE. )

BN, i “RrE” (Location) I LIMEE I H (M s, (F
KRS B, WS 3 S CWETAME” )
R FAN T ARG 55 5 A4 7T DL - R .

WA IR R R BonBRpUEAE RO S 1 F
NI
Hili “He” (0K).

“YRiEJETE” (Edit Properties) % I D2 hlBr. WG RT “frE”
(Location) 41, 25 Bt Bt DL 27 <context name>.

FE: WRNEITAAEIL A CAD U B R 3ChAN T — B, W
2izM3 “4rBJEtE” (Edit Properties) & 1. A~ (A E 2 8 B,
MHESER “RE” (Status) F1H I — A2 B bR I0ah, HEX
W Won— R, AR AR5 1 B 3.

4-3



M B IUHE 4% CAD LR M

wERMEE

4-4

WRAEMN CAD TR FE BT h s fm e, WAERAE T R it $f
“UiJEE”  (Bdit Properties). 7& “ZwiHJEIE” (Bdit Properties) % I H U
i, A ETE R DR 4 BI2PER 12 kB2 CAD SCRI R -

M CAD SCRAR RN LT 18 2 2 ) R 1] Gt 4 1) i 115 I 1) CAD SCRS (1
P hiAS o R e AE R A5 5 T 1 22 325 IR I K i B CAD STRS I i A R A
M.

J¥E&: 7F Windchill PDMLink "', I H J& 1 — £ 48 Ut 25 3 B /s 7245 BT
i b CZERPFL ) o« #F Windchill ProjectLink HY, @A405% &A1&
SO B I E s AR A A BoR e B U b

“UntEEMEME” (Edit Attribute Value) AH5HE (BT “4wiBEH” (Edit
Properties) 71 _[f] “¥EE” (Set Value) #:1F )5 %)) RVFEE S TED H
BURAE AT BRI v g iR B (A ERRAN) o U REGa AR O H 5 H 1
JEMEE. WRFENIERE T CRHAMOKRANINE, K554 “&EE”
(Set Value), NXHT2 R3] “4pBEHE{E” (Edit Attribute Value) X} i HE,
FLLE SH 6T AT B AR 1 B e N 281 A Hh e sE T H

[FIRE, AR S, MRS A — AN B AN S 1T AR X ARk
W R, XA R ) “4piEEBYE{E” (Edit Attribute Value) X%
HE,  EE IHEOOH T AR H B A ) B S N HH 21 2 i B AR

7 “Yrig)EHAE” (Edit Attribute Value) X[ iFHES, “#E” (Set) N7l
TS T A4 “REBEM” (Edit Properties) 711151 HF B R (0I5 H & M1
I, WRTAE “WE” (Set) FREHHFTIERIENE, “A” (To) FBI
BoR FHRAIER O TAEFIR RS FED BT O T 6 F A R
B o MEEE “BWE” (Set) PEHIERERT, Ko Won @ M AT BRIAE.

LU E RV, TEIAT LU R A

1. 7 “Zi#EEME” (Edit Properties) U1 I, JEFAR G5 H g8 M 10 A H
WiH, gt “REME” (Set Value).

¥ Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill 7 [¥] Pro/ENGINEER # 4 & HL 15 5



2.

3.

7E Windchill #4335 H

“YntRBYEME” (Edit Attribute Value) X FEHER 25T I .

SsE R al

'ﬁEIDESC 'I
% | (BEAE)

N “BE” (Set) N A& PEAR IR 1 B .

2 “R” (To) FBUH, BEHRZEONE, 808 N sk F 4.,
PR A A TR H g A

ER: AR N2 Bon i B SOA, DU W] 2 1 1 2R 2L A

sy “NHE” (Apply) DLiRE(E (ERE “4uEEMN” (Edit
Properties) 71 /5 2IRIHD , Ik “4uiEEHE{E” (Edit Attribute
Value) X UFHECRFFHT IR

o
il “BiE” (Ok) LURH “4miBEMEE” (Edit Attribute Value) X%

HEFFIR N3] “4RiE)ETE” (Edit Properties) U1, 7Ei% 0 ¥4 Wik
EIE.
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IR EATE ST AR, WA A0 H , e “4i's” . “HRR7 M
“CROMARR” JRIERME. HERR UIEG AT N TAEX P IH ;. &
GEo S FAl ] A R SL AR X S R S5 A ISR E SR RE R

HBEATAE DX Ay 44 MR CHrif) T H

— BRI H A AR AL ], BN EMIT/EEEPEﬁ“B%iZ%IﬁE, [[IPA
MM AL e “FEa4” (Rename) i 4o

EHE LI, AN R

1. U\IT/F[:EF'JZHETX MREZANEFE L IIE, REEEE “SCH” (File)
> “HM4” (Rename)

B}

S FeAS A op I H I AT A AL, WIH ) IS AFEEE” (See
Actions) S HLEEE “EM4A” (Rename)

B}

I H (45 BT TAEX R GFFRmE ) s O
THARE D EAAAERIH ) h, %8 “EM4” (Rename), )55l
“%En ((;0)o

“Ew4A” (Rename) GRS IL, JFAE “TFIER” (Item List) &5
Hh e 5 A 2T H R A 0 75 A AR A XS 52

ATAEEEwH a8

L]

[ ] ﬁiﬂiﬁﬂﬁ%%m' #HA- -
Eiﬂﬁﬁm |

wE:  #AHR: [E | B [£ 0 5]
capx#i: [£ 00 <] EAme: [ 00 <
a:[E kX

® &

HEAE (1 5

&) £
&Eﬁﬁ BE

r JJJ_ |xzf¢zxm |#ﬂn¢mm |ﬁ% |§m% |n&ﬁmu
% 4 Partl I I 0000000085 HIEIETE
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7E Windchill #4335 H

ER: WRMNTAEX P I aE A 4454, WIPT A 200 FH - S 44 PR
“MTHEXEA4Z” (Rename from Workspace). LIREFIFEM; S AL
) “Efg%” (Rename) WHIAHIE], (HEay & AF P SHEERATTC
LI H o

SR IRC B TILE 307 (Rules) i1 Jise— ML 152
YHRH” 1

EIEAE “HN” (Rules) {57, Tl IE PN I 2 LRI H S8 )R
(RIS “TRFIR” (Item List) FPfK) “4f0” . “HIUALLER)” (X014
WEER)” D TUHBAERIH (67D ), JRE FAbAH I H g iedi

—  “EMF” (Parts) — WARE CAD SCRYSRERIELAT

—  “CAD 3#4” (CAD Documents) — W4 5 #{F5CIK K CAD 3CAY
—  “KE4R” (Drawings) — 4E5 CAD SCRIAH IR I EI4R.

—  “TERIEME” (Generics) — WCHRIRARITH K13 H B 1F o

—  “HR” (Family) — WCSEIRR I H 14K

By “RI#T” (Refresh) LLERACTI H Ml & M S RIFR €, TERIHT
“T%|FR” (Item List).

P AE “TF|FR” (Item List) & M5B H, hE “Hu”
(Rules) 73y “EE” (Reset).

£ “HEBF” (New Name). “FHXHHBFK” (New Filename) 1 “Fr
5” (New Number) 7B B E B, W LAE BRI A 2R 100 H AT
PR SO Bedr, wE, TLUEEEIHAT, RERT “REFA
%7 (Set New Name) “= LLijii] “#EHFLZFK” (Set New Name) 7 1
(EF—"1rpud 8D, nT DAFE X s 1 e e B 44 00 H i
(W) 78 “TiFIFE” (Item List) T Pid; “TE” (Reset) ¥,
Wy 4 Bk E BB ES .

i “BAE” (OK). T H RIHZ B E 4R o 44

4.7



BEHAR

HWidAE “EE” (Reset) il I (GE “SHFFEHN” (Save As) U1 1) i “i%
BEHEZM” (Set New Name) K] “HEHFLZH” (Set New Name) % 1.
EAVFERENIE (B H FrRlAD i T ar 4 Mg 5 2418 .

| B 1o x|

2L

BN £
"5

¥ BERS

1% El Z|
XA

V SRR

i E| Z|

=

“WEBBI” (Set New Name) % 175 “WE” (Set) FB Wi Jidsmi H
JEYEAL, HAE “R”7 (To) F-Brr B B H (BRI B YE . B T3y 15
B, BOTRET LB SCERIAME (TR TR -

o fE “&F” (Name) XIH:
- RGN F=E “R7 (To) FBUT ARSI FRIZ ().
o {F “485” (Number) X

- WEREE T AT, WEOAME NSk “B31%S” (Auto
Number) SEHE, 1 H4w 50 “HWE” (Set)y 1 “k” (To) 7B,
DL “HBEEHR” (Save As) 1L I “H4R5” (New Number) 7B
P4 T AR SR A .

— WHER “B31%5” (Auto Number) 5EHE, W SBEIX A
Eay Lo
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— WERARVCE AZhG T, WIRHREREAEHE, W HS 51 “IRE” (Set)
A “R” (To) 7B, LLK “SFA7 (Save As) WU L “Higw5”
(New Number) 7 BUIERAL THEEIRE . REBONTEOL R & 1)
“R7 (To) TBUH IS Sa N FRIZk ().

1 “XH4LFR” (File Name) X354

— BN Tt “5%54HE” (Same as Number) SIEHE, 177 H.
FXMAFRE) “B®E” (Set) Fl “H” (To) 7B, UK “HFERN
(Save As) 71 _LfF] “F3CFE4EFR” (New File Name) 7B 2KE AL T-9F

PR B SRR S g 5 AR A

- WRER “54%5HE” (Same as Number) SiEHE, & 3H0HIX
M. REEBNEDL N2 “R” (To) F-Be I SCAF ARSI T

4 O

THRE B ORI H a4 MG 5 40E, EEH LR
L RN “RE” (Set) TEAPFHIAILH A FRegi 5 (] LUE AT B AT

VEHC) o

2. IR BARSOR G “A” (To) 7Bt (ARl WHEW TR .

3. il “HE” (OK) LLKH] “REBEFHLFK” (Set New Name) & [, FAif

B AL ENHAE “EM4” (Rename) (I “HEEAH” (Save
As)) U1 EHIHIE .

Har KB | RaGME SRy BARE W)

N RIS Item.prt | Prefix Item.prt * Prefix_*
I el Item.prt | Item.prt Suffix | * *Suffix
N RNz Item.prt | Item_ Suffix.prt | *.* * Suffix.*
e Item.prt | New.prt *Item™ *New*

R “HERN” IREF

QUHBTK) CAD #AFE™ Sh &5 R, TR B 10 & S R VR IR 28 s

THIE SRR “ I3 07 BAEbe it T — Bk, AR SRS

2T H B iR PR e a4 0B KIiH

7E Windchill #4335 H
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KT “HfFENR”

MRy A T

CHAENT BAEN T RSN . CAD SRR . B4R
Pro/ENGINEER J&ERINH . “ A7k S ¥ CAD SR S5 FIR R

ALE S5 TR PR ) CAD SCRYAIFRARI, BRI e iy
A BARIIRIAD o BOEREM AN BRI AN —LER b3, 10 SRS S an L
AIWHK G g H IR ) .

FEREH] “ iAo AR, S CAE LR AR

n R S A AR AR AN SR P 5 P PR P ke i, U P AR 5 T S 2 4
(SRR

AR “ Ak SR SEHIHEA B R BT AN Rl . SR
Tl SN 2wl 0 FH S5, U3 (140 S 48] ) A 25 8 kg TR (P T 3 072
“%ﬁj\j 424
PURAERME T “51F 87 (Save As) i :
CAT A (AL CAD SCRYaREBAEIT H 5 B i E e

“FEE4it” (Product Structure) 3% (75 TS IR AR Bt 145 B 0T
[NV =

“RERIGERIIRE 7 (Model Structure Report) £ (7£ LKA K] CAD S0
fs BT B> B C A

BEAk, AT AL ZRGE R wh R AR “3CfER” (Folders) UL 44T
“Tifrh” B (ERXRMELLR, TR S SR IH 0 H #4558
PR ERAE T IR

HERE: W BLE O L FAE WL I “SOAER” (Folders) T LS
SR TR BAE:

SIER

S

B3R
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“CHAFNT KRR
BIFUR AT BRAE, TECERRAREATH, KRRt “BER”
(Save As). HHXEFE—NNZEIH. )5, “HEAN” (Save As) TS
WA S TSR AR WP SR W U= i S E I
K AR ERAE TR R I H S R A I I H AR H )
=,

e B H 23 BonERIAR “4%S” (Number). 1 CAD il H it 4y H A2k
N “4FR” (Name).

— BRI H A AR ER BT Bk A BRI A B S i, BRI
LT “485” (Number) 1 “3CE4FR” (File Name) (15L&
D FEESERICK “Am” b TAREIRES . XK I
HIER A, 1w H A 3hd's 1d A T H 288,

— WRESE AT IR “EFMEH” (Reuse), WIFR IR
B 4l A6 B R A R 3 E AN 2 B S R AS . W R AR DR A B R
AFEHIAIH Z ATV, WS “Y485” (Number). “4
%” (Name) Hl “3CH4FR” (File Name) (i) B ik
AR SCAS,  TIANE EATTIE R G I8 A& i8S N 1)

— W AT A R I H R AR A AL AR BRI
H “4%5” (Number) fl “3CfE4FR” (File Name) (Lnfi&EfA])
IR RIZ O

—  YIEAHOBCT CAD SCHHY “YR5 7 (Number) B, Windchill 43
PERGERINIR) “3CfF 2 FR” (File Name). SCIFEAJE < 45 > i bid
ff) CAD XYY 4. filan, Wil A3hg 54 CAD SCRMSn 5 15 E
o “1234567”7, 1 HAEIER Hl—> Pro/ENGINEER #4454
(f) “3CHE4FR” (File Name) & “1234567.prt”

— WERARME A0S T, MR BOAR “3XfE4FR” (File Name) (]
FLRb AR AN R RIZe (). a2 v, WIRICAEAJE boltprt, T4
AMERT B BhG S, B “3CHBFR” (File Name) BRI L Ff
& bolt_.prt.

AILGEEAE “HI” (Rules) #1873 H EATZEREK ) T H B1IRS AH O )
TH .

I SRARE X SN I H IBRIANAA AR G 5 BOCPEA4 AR, A 2T
N . - (B

—  TERMEUN BRI “485” (Number). “H&FK” (Name)
o “3CF4FR” (File Name).

o

7E Windchill H 42T H 4-11



R H I TR RE “REFBFR” (Set New Name). KAl

PAE “WEBLFR” (Set New Name) 7 1115 H (136 Tk B 2 1 H
I FR o

FER: T bR ACESAL D ASASGH I o U FOR I H

“ZF” (Name). “4%5” (Number) 2%, “3CF4FR” (File Name), W&7E
B H O TEAE IR 2208 1 L8 B K

WA LIE ] “&BE” (Set View) A A Eh -0 H 5 & 5 — K.
“HAFN” BIBRINAT A2 R K] BEOR B CAD SCEAT Windchill #5F45 14 .

UWIARARAT CAD U Bl Windchill fF45H, WRATERIN R LR A4
PN A 2B i SE SEI AT (454

T Z 250 H AR g i H ORA7 o
NZIH P S AR A I H LRAT
WERATF S L L6, WSS MM I H , (BRSSO B .
K T B RAF 9 T
SR IH CRIORIRIUH ) LA 9 Bt H -

1. MASEZS[A] CAD SCRY s ST FRzpl R, &8 “BEEAN” (Save
As), AT “HE” (Go).

B}

7F Windchill W I LA S A B, M — AN B IR FE— AN e 2 AN
H, RIEHT “HAFEHR” (Save As)

“HIFA” (Save As) T LUK 2T, B T TREEIABIH K
“H” (Rules) 75y, FEEHIH TIHK “HEFA” (Save As) K.

A
BE: REREA: [2iiy ] wH: [ -]
RE: [£370 =
BE: KEHAR: (4B - B[ ]
cap 3#s: [£ 0 < s (£ ¢
@ (£ - A E |
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2. fE “HM” (Rules) #B73H, A28AB LA N FBURBOAE, LI
RIFH -

— f£ “BCE” (Configuration) XL, 7ELLF 7Bt E 4k 46T

7E Windchill #4335 H

“WEBCEH” (Set Configuration from) nJ il F5 i & AR IR AE
(BT B TR I H 7™ dh S5 IE 2 CAD SCRA A I 457
DR B R R FE T RS BIH e 7B o B B N iR
DEEY AR

“BLE” (Configuration) n 1M F7 E i EIE. ERIAN ST
Ho nILME R ILAL LR “J5UESE” (As Stored) BAT AT IE
MIFEEL . AR B T e (L B R IE 78 R I 2 - B

Y (View) CHUTAMHTRING™ fhdisHgrh B AL 4 0]
D WEEIRERSE R (R S i) .

“BE” (Include) FBIHFR BRI ILALINH , 41 FFis:

“URIEXTSR” (Dependents) M i EILBEAEMAT “ A ENh” WM
AN S o nTLLESE “DFH” (Required). “4i” (All)
g “J&” (None)o “Wi5M” (Required) (&Kl
Pro/ENGINEER Tl H It (I ERIAE I 4435 FF/E Pro/ENGINEER
R A T AT H o A7 (Al 2B AL B ek
PERARRIPTABHE . WALl E “J” (None) 5 “fNHCHE
HAKAEX %" (Dependents in Configuration Only)s.

“CAD 3CB4” (CAD Documents) ] il-f4 45 & f& A& HAl CAD
RS CBRIN) » I PR T 5 ) 4 i (R S BKK) CAD
SR, B RS SATAT IR I I E KRBT CAD SCRY .

“EAET (Parts) AIEGEIRE A IAMLEE CBRIAD , iR
HAAE L 5HIA60E € (1) CAD SCRIOCIRI A, 2l & 514
AL PRI H IR IR T AT #BAF o

“E4R” (Drawings) nibESRE AL TEA BUA) , EREY
BH AR WUH SRR P AT B4R, B AL S W an ik e 1)
K4t

“HERHMH” (Generics) N i EIERF AW E BT (BR
W), RS AR TE g R P s R, B
S IR 1 e (P00 H IR e 1 38 FH 3B

“Be” (Family) o] itk FoE A FIRER LY GRIL , 20

AR H B BT S, s RS WA IE E 1Y
0 H B 51 o



FR: AEd “RIET” (Refresh) H8 5 AETH IR IN, Ko BRI
£ “HM” (Rules) #70H prf g #E. T LUEN iy “EE” (Reset)
Reprfr “HN” (Rules) 7B 24 BB BLE

3. iy “RIFT” (Refresh), L% AT i B0 0k 56 87 00 H 21 3% .

4. “HIFA” (Save As) T HAA S LR AE T H AR Pk GELEH
T e A A IIHE ) BOIH _ESRAT A . n] DU ol B e 1L 1) 31
TR “4f” (A ZIEHEREREI H SR P AT H . Al H
YR PoR:

—  “RENE” (Set Location) — VA “WEBALE” (Set Location)
T H N2 R BB Ik H S B R BT B TR
BE, WS W& H A EAE 3-5 5t

— “WEBLK” (Set New Name) — n “WEHELF” (Set New
Name) % I, 1HESREHIH M6 . AR EH AR
FR, WES WK EH AL 4-8 UL,

—  “EHMFH” (Reuse) — F5E (LW 45 ko AL HIILAT 10T H 1A 2 81
RIA . FERIH PITEOLS, Aol 3 A I I H 52820585 gk

Can SR TRED he.

— “WEWE” (Set View) — RFEAE “RBEVE” (Set View) & 1

W R R AL I F I H RO GEZS W R

BIEH 25 £ 28 £
= =) £
BEE &Eﬁfﬁg ERER RS
I
r ] == | #me \_ e | oz | izt |#ir | = |mE |
[C @& [ PISTON_PIN.FRT | piston_pin.art [ piston_pin.prt | A [Awindehill FOM o=l A

[C % [0 TEST ASSEMEBLY ASM[<BabRS> test [TEST_aSSEMBLY_ test_assembly asm [<SaStHR? A Aivindohill PDM = h

5. 15 “AFFEA” (Save As) K, KA AR H FITH Pl () “Hidm
5” (New Number). “FXH2ZF” (New File Name) fll “FEH#”
(New Name) {H CEATC LI, f Bk i ST T oI « ik
WE AT, Wl DX seq; A2, CAD SCH %5 Fs oS
TEHAE e —, I HEAA K,

HE: “XM4FR” (File Name) il “HX442FR” (New File Name) £
i& T Windchill #544: .

6. KA AT H PR E . ATLGEE ] “ALE” (Location) 51|

SO IA N R B el . B, AT LA ZANIH, AR5 Hidh THA
i “frE” (Location).
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wEME

BB A

FER: WRAE PDMLink b RS0 TTAE, WA AR B RS B R ST A
RS

. fE “HBIEHR” (Save As) L LHT “BE” (Ok)o RASK A H Y

T HIME—PERL AR BT BRI B A AL 2R CAD X
(EETRETI AR TREN %% R A R AN S AT B A, Ml —
ANHIH o

ARSR I H S 5 ANME—EC R (B, g T R S e o — Ui 4
TR, R 5 —AME.

UER I H 448K BB FR B I B IR, el — MR, &RJa
AR BN —ANIEE I IH

“WEME” (Set View) & L THE “ 47087 BAFRIRE o532 SR 5
IE

|Deaign

Manfau:turing

TONFRPEIH BB, N “R BB (Set View) MuSIRPIEFE—
Meama A,

7E Pro/ENGINEER F3T 715 H

7E Windchill #4335 H

AT DL AR DX A a2 L 23 (R R8N B H T T CAD ST, RIS
Pro/ENGINEER Wildfire 2 i& FHR A X WA H TAE. BeAh, R Aevh 5L
223 T 3E M) Pro/ENGINEER 2228%, U m] DL ST (1301 Ya 2% 1 4T 7 CAD
RS



MHR AR B2 4T - TAEX T E

FAE Pro/ENGINEER T FFAIH I TAEIX CAD SCRY, i+ “30f”
(File) > “4TF” (Open) > “7E Pro/Engineer” (in Pro/Engineer), =it
HIY “#45” (Actions) 4 iy “7E Pro/ENGINEER W#TFF” (Open in

Pro/ENGINEER) 'O, 55 {7 M AT Pro/ENGINEER 2iF 14T IF. 7]
PAA Windchill " 2 7x CAD SCRYIR K Z5hr &b ii i) “/E Pro/ENGINEER
WHTIF” (Open in Pro/ENGINEER) #:1F, F—xt bt fT 7424,

HRE: LiE4TIF UDF. A5 H s 522 1) CAD SCRY.

MISE 3 A8 AT I E

AEMT P A A, T AL e T IE 1 Pro/ENGINEER hit
AHS, ATLALE Pro/ENGINEER H$] JF CAD (4. 41 Pro/ENGINEER 4%
T EAEIEAT, W H A SR 4T IF . WIREH S1EEE T, W
JFI0H 42 B 313 3) Pro/ENGINEER .

10 7] LLZE Windchill #5275 CAD SCRY AL E H A8 T IF CAD SCRS I
fEo BRT TAEXAL, XKLL EIRRE “SCFJ2” (Folder) Wi (4R
CAD SCRYIE) | $8REE R BRI . FEdiRdt CHERxK
e CAD SCRSIND , BLA CAD SCRYIIME B L. vl A H ) “ 4
YE” (Actions) #|F .1t “4E Pro/ENGINEER W3TH” (Open in
Pro/ENGINEER) "Bl S P U A, 2 MARAE S s ml F h 9 6 h ik %
“fE Pro/ENGINEER WTF” (Open in Pro/ENGINEER) >k JT 46 345

FERRNT 554 PR 558 A F) 2R G B
P4 “7E Pro/ENGINEER W#TFF” (Open in Pro/ENGINEER) #:151H, 5
GERENS ELEAEILA IOl (i, R CVEN T — N A TS TAEIX

TMRGEA) HITFIH , B W B EE NI RGE Irifs i g5 4% 1 TAEIX.
PAN R e R 22— R i«

o JTIERIREE INRCAREAE Pro/ENGINEER 14T T

o WSWERSTIFITIE ST Pl (R H AR H o SR A I AR o 1
B, R

—  CRRPEMRCE MR TR, B TARX B CRBCERR R Ty
SERIRCE (B, R .

—  IEAEFEINE, JHEE “HH” (Check Out) o “Wsing| LIEX”
(Add to Workspace) Ui (454 JH 3l Pro/ENGINEER .

o AR IRERAE K CIE MRS 88 AN e TS5 & W) if ) S 2 75 ALK
FAR N E S5 s o
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fEHRR

RRMIR

U R MARTEZPRES ( TAED R IT a8 A, 2 2R AT M TARIX
O 5 S SCAR DO 2 AR 2 1 AT I H D o

IR AR NIR S %, KR B AN RS AN T AE .

IR RS A O TR, WS BRI SE— A TIEX .

WA R SS # EBAT TAED, W s a0 — MO TAEX .

IR BAG 2 A0 T 5 5) Pro/ENGINEER [FJESECE  Cpsf 30E) , N

SEORIBIEFE A

Up SRR T B T AR DG, ) ot R 2 4B 23 1 IR i
HH .

DL LA B 1 %2 LA Gnfl #F Windchill PDM & 484 i 3 .

JRAG ST — BT 5 SCRy € H A (BCRIE s 7 5 SCIRIHFIE) AR (17
2, Xy E I H A R A A R, (AR BT (R e
TR _ERSGUANE]  RIOAEAREY (B, BEPH AR AR ET IR KR 52
KN FER A T4l —AT, AR IR 8 0 ) AN R] 1 e P s D 2R 1 31
il o 7 B TUAR AL 5 IR A A3 AN 8 B3 (1 3 H AL

JBARE R FR AT Ry R SR B (F B A F o
AR, T L
i PN % P 1 B A R A A R (1 30
T B YRS IR PR A F Y A N TR ARG
M AN SO R AR A BRI (A A, 1T 5 FOBT BN AR R AR AR
F 3 A B vt A2 A AT G &
QU — AN ATORAE 3T BN SO I S AE AR H ok b (1 R

WRRARIE T WAL A o BT RS LE Pro/ENGINEER H R /R S5
HIEBEgm H o ek, BRG] LR AA A S B e A 1R 31 2 e, R A
F2 [R) — 5 AR ) S B AR 2 1) 1 3l ml A8 4

#17: f T AR B s b e gkak, Pk, BRI GE L ety
TR IR O AL

1 Windchill 71 4b ¥ 15 4-17
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JRAG S5t b A ANAT AL 73R o IR AR St v LU A 2
I, DAL, XAtaUd T IRRM (AR IR E IR .

ARG LU = AN 0 -

L REIPA A CSEpD e SO T ROFEIH - GE 0 H 5 /7
BT o

2. AEAT AT REAE SR AT 2 WAL I @ P — RO RIS EUE. R IKE)
FPRFAEAREBC I AL T o SCIRF AR RS R A4 FR LA 28 22 B R EG

(ST

3. HIEREIZEMPHATIRE CEBD ARk, DL RIS I H A%}
JAH o

FEAT IS S AR S (R R Ak (R AR SRR e b

FIbR A S RGN R S8 Rk AR A FR . R H%
MR (Blhnaod FIH, M HAER F 47 LA AT AAAE (1 ORI 5 44 B
(fltn depth) « SEFLAFEIN . FHLZBAHES S (Bl F107) )
i HAEL N AT BSOS IR (B [cut]) BRFFIEAFR.

M URERAL TR IR AT e FAB SRR IR B stk =R Ak iy U e
J& Tl A R 46 H — T0VA I I gl IR AR e R b i 4% H ok B
e .

ER: BRATEAX D KNG,

XFREASEG], AT RUE SGRAAE SO P AT R . SRR AR, ik
s FEWISEEIh R AR (Y BN IXEEAFR, sRAMEE OO0 TR
) o P RCFRITR IR, EW LR TR S (), JaHE TR
A FH A P2 P

FIT A G 1 4 F sh b RS e iR b Ol RS RL  BrE T. Bldn,  dn
Ui AR B — MR MATERIAL 280 ({24 STEEL) , W4 s
B354 HA A ) ) 2 BRI

A LUK s R A B HAE B . “SEFI4ZFR” (Instance Name) 5145 7E
TR BN R FFrT Lo

¥4 Pro/ENGINEER Wildfire 5 Windchill Bt &1 ] Windchill # ) Pro/ENGINEER #4545 # 6 R



HERA KK PDM &3]
PAR U B 1 W a7 5 R AT 5C 1) PDM #24F

1F Windchill th & & ik %
Windchill 24t T 280l b i ok o, At P EEE R . Sk

CASEINRES ey
« BRINIREH
o BIERE

o ARG
- mit

HR: BORA R EA R T LR IRRATE ) 2 E AR . A
I, FFEAE Windehill 8.0 " RAEFI_ LI B MRS, LUEER AR
EATTH A BB AR A . [SPR 1129382]

FAE Windchill 7 R i

1 fETAER T, ERFE—NERIE (S aim e .

2. i “AFE” bR, FHEIH MG B TR ST

3. fEfERTUH L, &P “THEX - K&” (Workspace Family). {5 5 UL K
SHEPIRN, DR AT RIFIRPIR S Z 450 (R T “HRE” (Family
Table) CGEHFBERSLH)D 58D o ErpRATH FrEAT I %R

WHAER R e T 20 H
BH G # 39 wE. [FE |5
& ¢, 2, ¢,
=HEF EH =HE &
T EEE RIERE | ®S || & |BE | mazup | me7 pLATE |
I ¥ Dalunch_tray.asm LUNCH_TRAY.ASM @ lunch_tray.asm A1 Y i
I [Mgone asm  Unverified  OME ASM @ one.asm Al i
r [Ogtwo agm  Unverified  TWWO ASN @ two.asm A1 N M

1 Windchill 71 4b ¥ 15 4-19



BRI A ] FLRR
L& — AT AT box.prt (TR LR . B HA =AS L EA A,
PR

. JUTBH:

D1

S IREE S

Hame Type (Vale | Designate | Access Source
DESC  [String| My Beee| ¥ Fall User-Dafmed
COLOER [String]ELUE | ¥ Restricted | User-Diefmed
WEIGHT [Feal (27000 [ M Locked Relation

o SRR AR

Type|Inst. Hama D] (D2 COLOE
BOXE 30|30| BLUE
BOX_1 |10{30( RED
BOX 2 |20j20{ TELLOW

¥ Box &£ 32 Windchill 2327 PDM s 4 rh @18 LU CAD SCAY

Wil -
Attributes
Icon | MModel Content COLOE | DESCEIPTION
Iame File
s Box prt hoxprt ELUE My Box
g Box lptt | bhox 1.pst RED v Box
= Box 2t | hox 2.pit YELLOW | My Box
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HR: ELHM CAD STRRR “KEIbr” Fid, RATRE B RN SRR
RN CGRITAR N BRI S ) « 4 RiEad R
i, HEELUREN T, 35581 Pro/ENGINEER S04 242 7F Windchill
W B CAD SCARY I H A2 -

© TR ERENSEMAREE, AAEERTEE X
o
o RS EAFAEAT TR E RIS BN @ M8 S ) B WIS .

ER: BB URREAE CRAAD K], LUNRIIEE B T4
F 35 Box AL DA 145 B U1 -

H1L{EK - box.prt P24
BE boxprt AIEEEE

Ogbox.prt [FmETHER =l
#]£7 ID: Demo Organization
@ 5 8 8 0 HEFan: Windchill POM
£HS: BOXPRT _ _
8, boprt ﬂzi: . .
Atk boxprt ®E: EAELE - 287 - 2EE
B AT . _
T PTC Productyiew iﬂ%& Eﬁﬁﬁﬂ s . g:g; 322::10”1 17:48
Express Eﬂﬁi Eg% - FhE| A (R R R .8 FEE: demo

LEiREH: 200511013 16:19

BEERRIEE: fiEw RRLESRN? . &

R HER: Pro/ENGIMEER
frH: Aindchill POM

W
M- [vAE =]
THEH i HENH THx LREN oEE
LI AR a box. prt =) PROE_UGC 29.07 kb 20051043 16:18 dermo
TAEEL - cAD kst
I#E -AT
IR -8%
IHE -#E5 [V Kk = ]
T —
|VEt‘t ] |
Ef# 1§ WM ¥
COLOR BLUE [}s Rtk e
DESC My b {Rutk - He A

7E Windchill H 42T H 4-21



FEARATIR R DA (145 6

ﬁ‘m\

Workspace Copy of box.prt

e )om]

General

Workspace Related Parts
‘Workspace CAD Document Structure
‘Workspace Used By

‘Wiorkspace References

‘Workspace Referenced By

Workspace Family —

4-22

Ogbox

Responsible Product:
Number:

Name:

File Name:

Version:

Instance Type:
Status:

General Status:
Modified Status:
uthoring Application:
Location:
Description:

b=

U FIERE “HR” (Family) 858052 B S L,
DL 7 i 1) S At e B «

|Edit Properties

UwymTestProduct3
BCOX.PRT

box

box. pri

A

Generic

YWorkspace Server Copy
Mew

Pro/ENGINEER
fuwgmuser3/PRtest0?

] [eo)

Team Name:
State:

Created:

Created By:

Updated By:

Last Updated:
Dependencies Complete?:

In Work - Released - Cancelled

27 Apr0518:21
uwgrnuserd
uwgrnuserd

27 Apr0518:21
true

Family Tree (3 of 3 items)

\,I’iew:l Default IE

& & B %
Expand All Expand Collapse Collapse
All
I Model Name | Verification Status | Nurmber | | Mame | \.-'ersion| DESC | COLOR |
Il V:‘Ehg)(_pr‘t BOX.PRT @ box A My Box BLUE
I Olghox_2.prt Unverified BOx_2.PRT (@ hox A My Box ELLOWY
r Olehoy_1.prt Unverified BOX_1.PRT @ box A Iy Box RED
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FEE: WRCHUE TGN, #ifE. CAD SCRYEs], sl DU H
fr = Cltan, AEHIFERR D gndE 702, DI E S D o WAL, A S D
HiE, SOETECE A TR H SR ARSI R T . (HE, R
property.core.collection.collectall ££ wt.properties 115 B A4 false, I 7E B 4
P e A A IR B R BT A A SR T H

X B LB AR IR B e AN e I H 3103 R IR A7 6 28 2 1R T H

XTGBT AR (10 B T 9 2 B CSGS n 2U35A 21 3 v PR HA 5 PR /N BOAS
Pic B v A0 AN 2 B SO H 8103 R AR B8 S PR H (/NS o

R AT HOFERAE, SO DA IR € I H 1/NRCA, T ANE 4]
URIEEI/NRAS o BEAN, AR Wb B R A R E R I, AR AR R 1
W1, IR E T H 1 /NRASRE AT BUNBAS 1K 0] G55 WG E € K/ MRCAS
ENCIE

PR A B 1 A i v B L R PR B

TR e icE
MERAFTE, T LUR I —Fh 5 2ok o8 s B AR A i i Ay
HRIPEAT, B A ot B “BCE” (Configuration) iy K3 i Hph
I]IREWEEVRE T
AE AR PRI o s G
AP I P SR AE A IR P
Pic B 2 AT a5 PR 300 H AT RE IO ARAE R R o
VIRIEC I H AL “TRFIER” (Item List) 575,

WAEXBAE “TRFIF” (Item List) T iR, XL H BRI T W 2
KIG. B, CAD CAYBRIABEE N “FH” (Required), TIHEEEM
BN EHR “” (None).

WA R A — AN N,
— UL RS RIRRAE, Bl A7 (Parts), LK
- L)LTﬂEP*ID‘i

WIHR — BB RERINE . Tl I PR T & ] SRAGE T
(¥ FCA AL

bR2E — MR TR A BCE R, R ARAE .
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LA N IRIOBCE THRORBCERCE, EHATEL M PR

& “BEE” (Configuration) 7>, & “RKEBEREH” (Set
Configuration from) 751 iks—AME. ERUEIE THIEHLE E (11
H, Wk fpios:

L.

XtT CAD MRS HMIRIE R BRALE R “RIM LK) 7 (Model

Structure)

XTI H (BN P2 BB FIGRIESE R« =i
ZEM)”  (Product Structure)

2. f£ “BCE” (Configuration) N4, EPE—AECE LI, HEDIRE
TAE “HEBEBEB” (Set Configuration from) 7B IEEE, W FHR:

XfF “RIRIZER)” (Model Structure):
o “Blt” (Latest) s/ MRCASHINER G I H 4G I BIAMED
o “JEAEAE” (As Stored) GEHHI/NRATERNED

o ORI TAEXCE” (Per Workspace Configuration) — BEH T 4F X
R LR IO B A5 R

o REHILLIIR AR PHATYIGRE E IUH 1/ A )
RARLEREEL . )

o THIORIANE  CRE PN PTG E E T H K/ NRCAS T I 11
IREETF 5K )

X “rPEhhEif”  (Product Structure):
o “HBt” (Latest) (ERIAED

o MR TAEXECE” (Per Workspace Configuration) — B2H T AE X
R LR L A o

o REMILZNYIER RSP T Y16 IE € T H 1)/ T e
IR EEREZE )

o THIORIANER  CRE P PTAT ARG8T H IR/ NHRCAS BT I 114
IREETF i Ko )

3. fE “BE” (View) FB CUHELEWIERIE E I H 2 bt m H
“WEBEB” (Set Configuration from) MEIW & Ky “F= 4k
(Product Structure), LA “BEE” (Configuration) LI & A “Hofr”
(Latest) 8%, “HRME” (Effectivity) I A A TyG80RAS) , EH—FPc E
L.

7E Windchill #4335 H



4. {F “URIEXZE” (Dependents) 7 513% ik B W ERIK AT S . 1]
MFEDE T “HEBERER” (Set Configuration from) B 113k
e, WFFTR:

— X “BIMEK)” (Model Structure):
o “TEM7 (Required) CERIAED
o “AET (Al
-k
o “IUECE P HIMATXT S (Dependents in Configuration Only) — H
WA TR 2 B B2 BT SR BB ARAA I H (o “ I
7 (Latest) WAL FARIG B R A
— XF “PEREER” (Product Structure):
e “J” (None) CERIAED
. LT (AlD

o AU EHIMAEXNT S (Dependents in Configuration Only) —
WERAE 328 B BE e T R SR P A S IMRAE I H G “ i
H” (Latest) WAL T-AETESPRED

5. fEAEH TICEES G, i “RIFHDFIER” (Refresh Item List) K0
N B0 H 713 SIRKERIEr, CAALTE A kR iR e i H .

6. (k) il “EE” (Reset) Kt &Lk E JERINKHE .
e U 1 s

EH “BLE” (Configuration) = GHEHE MERVER “YBEIRN” (Collect
Items) T HA~H k£ B, “W@EBEBE” (Set Configuration) | FoKf 78 i
Frpaf s nlid A DU B N . R e X e B R E, A
KL F I H B BN

1. “WHEMEH” (Set Configuration from)

—  WERAIGIEE I H & CAD 3CFS, MBS “RERER”
(Set Configuration from) 7B {78 “HiAYgEf)”  (Model Structure).
WA CAD SCRS WP ORBR B AT E , WInT LUEHEE 5 5
gitt)”  (Product Structure) LAEAEPCEIE T RIBRFRAFIH o W2 AR
KK CAD 3CHY, WFBwEN “BMNEH” (Model Structure), Jf
HALTAEE B R .
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WA 6% 2 50 H & T 50 H AR (B =iy i BT
PIECAEAE) , ERAE L “REBCEB” (Set Configuration
from) ZB B8 “PEENEER)” (Product Structure). 41 S FAI H 3
WPOCIE R CAD SO, WP LUIER: “REAUZ5H)” (Model Structure),
DUEAEC B 2 T QUK ) CAD SCRY . Wi ARSI H , 7B
WEHN “F=igit” (Product Structure), Ff H AL THEEPIRE .

WA Z MM FIEB G E E W H , s — ARG 146 1% 52 1
H GE£4EF CAD X)), W “#wEBREH” (Set Configuration
from) 7 BOK S TR, W s

 MTRATALA S “BUULEH” (Model Structure)
o XTFESAEN “TRAZER)” (Product Structure)
o AT CAD UK “BE45H” (Model Structure)

2. “YIIRIEREE” (Initially selected)

WA TR, W L R . AR R E T 2 A
WH, W& “4m” (Al

3. “WEBE” (Set Configuration)

WA “HKBBREBR” (Set Configuration from) 7B k£, 2 g
LS B LI BOIASIZR, a1 s

7E Windchill #4335 H

X “RIRIZER)”  (Model Structure), EIN A :
o “HBt” (Latest) (/& KZ % PDM #AERERIAMED
o “JFfHAE” (As Stored)

o MR¥E TAEXECE” (Per Workspace Configuration) (EzH T AEX
R LR B A B

+ “HECEZF|FE” (Configuration List) &b T ARG IR, HAH
TAE TAEXFC & R U 3 4k

“VLEEIF|F” (View Option List) & T ARG EPIRE, (HiE
AR T AE TAEX S E O AL .

Won “HBME” (Effectivity) fi A 7B HOVETAEX G
I s FBUE TARE SRS

© REFHEELNIIL

[GEN

HR: NV IE eI H 1/NCAS T 1) LS IR R T ik
Ko M “WILRIEER)” (Initially selected) hy “4H5” (Al I, H4s
F AL B BT AR A 1% e T H SRk

*

*

L]

=
%b



—  XF “PEREER)” (Product Structure), BT A
o “BuBt” (Latest) (ERIAMED
o “MIPE TAEXHCE” (Per Workspace Configuration) (zHU T AE X
FE DL BN B4 2D
o R HILZM YR
o THREK

o HSBIAIGAIE I H BN AT 1 LS S L R i oK
M “YIAETEE R (Initially selected) &y “43” (AlD) I, H<s
HIH AL I W AR i I H R 2 .

4. “RE” (State) — EWERE N “Ieli” (Latest) i, 5 E iy BIUR
O ot 2o G/ o T = B (N TR 2 Lo | R B r

5. “PRE” (View) — TR AILR L E 0T H AR UREC & AL . BRIAT 30
T, AW EME . DCYYIRIEE I H AT, T H “WERCE” (Set
Configuration) 7 BUR B & A 52 8 BRI BE L i GE K I, “ L&Y
(View) A kb T-iH3RES

6. “HKFENHR” (Dependents) — Frilfitd 1 4504 (MMRLEARAE X G FTHITK)
LIk “wEBEBCER” (Set Configuration from) 7B B E M ¢, WH
JR:

— EWEN “BIRZHM)” (Model Structure) Y
o “UTEM” (Required) C(ERIAMED
. “AE (A
-k

— JEBEEN “PEMEERY” (Product Structure) i
s “JB” (None) (ERIME)
. AT (Al

7. “NEEEFHFKEXTSR” (Dependents in Configuration Only) — &1t
SEHERT, K LU I A7 20z — BRI H AR G
—  WACAVIERIEEH  (ERA ST S I H D W ERE,
mH “wWERE” (Set Configuration) {H 25 HAREL . T2 iE
SREUFEAFEC R, W SR IR LS & T 48 e Bl B AR 5. iR
“WERE” (Set Configuration) 1A /& 52 & Hl 1) 4 5l J5 il A7 L
B, WAL T RS SR A .
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— WA IR H ERFOCER A R I H A RCE, WA
“WERE” (Set Configuration) i/ /& 524 H (13 £k B IR fifs /7 ic &
N, “NNEEEFHRKENNS” (Dependents in Configuration Only) &
IEHEA AL TG BRA .

P I AEMEIN AR R ISR S R A 401 € I H 1 S5 LR
S5 R T H PP AR AR R

P24 5010518 5 T H =PSRN S5 R 25 H AR A XS 5

J& T I a € T H K55 [R5 H e (A

8. “MABT/EXIMIE” (Apply to Workspace Specification) — & & [ i
EWER O TAEX B E G . R IR A AE B R I H N TAEX
A A FIE IR A .

9. “fNE—_LETFIXHHIN” (Items in the same context only) — & FH T
“Bh)” . WP RIENESS, BE pER D RS Sk e o H B
AR R = b B e R S I H

10. iy “BAE” (OK)o FCEFRE M ek NI BRI H 415

R =4 CAD SR 4R E . BOM

Pro/ENGINEER BOM  CBHENE 5) & 4 e e (1) 1 4L IR BoRe Fi 2R 2 47|
Fo MR TAER, AT VAN AT DU A T BN BUORAE B A
1 BOM (“{/g8” (Info)> “FHENEH” (Bill of Materials)) . 7EILE
Hr, BOM F 2R A A B0 14 2445 B PR T =X,

M QU AL AR, IR EATRI R 10 T E N A Pro/ENGINEER
SCAF CAD 3CHS,  nTBLEUEE a7 (PDM AR GEHH A8 i b ) Al
(53 2450 o 7= B 5 T4 E ) Pro/ENGINEER AR 25 g EA T 545 o

Windchill PDMLink H ¥ “F= #4454 ” (Product Structure) JUH  ( “F=5”
(Product) EIR~ L) “FER45H)” (Product Structure) 1-3%) TR 7/~
rEER . Z U B “FERIRE”  (Related Reports) 47513 o178 A2 ik
DU R Ak

FZ I PRRRS
A IR H
Z R E O

Z HWRHE L ELE

MRS # 5 Pro/ENGINEER BOM R FAHL; {HIE, 7F Windchill
PDMLink ', #&AEW1ERE BOM, IXAEGIEH 107 ShC & B0HT 7 A< B i
RAH .
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CAD CHH45H

fE CAD SCRfE B LI RiEFE “CAD CR445#4” (CAD Document
Structure) FEFERRHNAAE S UL, DLE7n “HERIZEHRE” (Model
Structure Report), MM TCTTHTIT CAD Ju’E N L7 5t B8 A 5 2R fic il
H I CAD it . EFILHEAR Bon “fFRBH” (Where Used) i .
br T AR LA, BRI AT L A

© WERATE CAD ORI TAEXRRAS, Wle Ahidse TAEXACE . WRE
B ECA, AT BLBEE IH R E .

o EMIEE IS R
—  FEPEH TR B LRI R
— IR R ERGES CAD SCRYORIBE M A1
— A SR BRI T HE
—  (EAIERR) “ALE” (View) NP ILIE Eor
o JAEhgREE SRR, A4nHE Pro/ENGINEER SI4E 155 H 1) & 1k
o ERRETEIRE S 2 ERE
o ERETPIIE AT R
HE: “BRZHIRE” (Model Structure Report) 71 Windchill ProjectLink
FARTT
AR IR 50 B 7 e i 1 A P S 20 5 R 4R 7 «

MTAEX CAD ICHIHIME R GREgIMEED T, sy “THER - CAD X
4458”7 (Workspace CAD Document Structure). 15 S WHShH, LLE
N “RERIZERIRE” (Model Structure Report) %, JF7EH FEor “fERTE
H” (Where Used) <.

BRGEMRE 5T % 5T wE. [FoE =
: o = &l
1A L g B E il & =
BRF—1- =TEF i ST EREET fath iR i FERE 5%&;‘]}‘&
SN [ss %= ows wewen (om [es
C |~ nch_tray asm ® LUNCH_TRAY ASMA 1 EETE
r Fyaypn  ® TRAYPRT A # E = EFELHE
r bOigpr ~ ® LDPRT A2 # iR z L
r b-Oeppt  ®CURPRT Al # T £ hans
I w b Dplatept @ PLATE PRT A3 B R " EETE
b M D 2]
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BOATEDLR, “HEEBRIZEHIRE” (Model Structure Report) K 7E B /R Iy A
USIF

o (EE) — AN EEMEE RN TR AAT . T (AR
HAR7s) BRHER] T+ / BUHIE BT AAT

o OREY— Wor “ILEE” (Share). “HHL” (General) FIl “ACH TAEX”
(Local Workspace) JR %

« BRI (Model Tree) — s BB SCAFZ AR 0 H 88 E 5L
L JETT | B ft

o “YHFEZFR” (Component Name) — (EFR 2 P 7R 7715 A (R ME— 00 H b
BT

o “BAE” (Actions) — o n] T IUH BUERAE

« “4%'5” (Number) — Z/RIUH KI5

o “IRAE” (Version) — WoRIHRIRA (EITHR / DA

« “EBE&” (Suppressed) — W R EE AN (ABIRED

o “UKFFERZRIA” (Dependency Type) — 77 3 S IR I0 2 1] (1) B o Ik
J¥ CAD &k ffR &

o “ORE” (State) — W H B 2T A Ay B HTIRAS

“BREIZE IR ” (Model Structure Report) [FTER U B KR T R (3 H

e R “AHEZFR” (Component Name) 5% “4g5” (Number) 1)1 %)
Frdlo) R I H AT H R . N s T HF DI RE R EAN 1 B

o HEF ORI SRR AR

o HPREAN R T WU, ARIRY U AP T H B AT
BATHEY -

o HAEXI A THE Y : “4HF4LZFK” (Component Name) Fl “455”
(Number).

“RRAEIZEFIIRE” (Model Structure Report) H!) INilfE “FE” (View) %
PR AL T AL, ZARRWTTE PR

o “BRRICER” (Hide Unplaced) — —Fi2RAL T ERAM K KIALE, &
0 BB A TR0 TR 24

o “EBIRFTBREM” (Show Suppressed) — — PR T ERIANLIE AL,
AR R A
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“IYPRHE LR ” (BOM Members Only) — — Bl [, & Bk Tk o
MBI AUET R, JEMBR “ UK (Suppressed) JURI “fkAz X 5%
#” (Dependency Type) #1J, [FIINESHN “H&E” (Quantity) 41,

] T TR AR P R s AN TR (9 A ) 5 AN AT o FCAl IR AT T A R LT
JE PRI e PR AR

5 R BER SRR m bk

INFRAS (1 Jeg 1

PR /N BUAS (1 Je

Pty CAD SCRS R G0 s PE AR AL Je Pk
JIfT CAD SCR R S Js 1k

“RRAIZERIARE” (Model Structure Report) [ T H A0 5 H T A& 451
b PR &5 Ry (0 R AR R AR, BUR A T DR BT A
i B FEUE B«

“REFF—A” (Expand One) o — K5k 1015 SR TT 2.

“SFRIF” (Expand All) B — JEFFHTLE T 0T 2K

“Yi&” (Collapse) ~+ — 1AL 4.

“ BIRUAE” (Show Parts) B8 — /5 5L CAD SCRY F20F S50 O 1
“BAREEDLE” (Hide Parts) T8 — B2k 5 Tkt CAD SCRY L HOEBLE.

“RIFT” (Refresh) ] — g7 AT AR BTV ) 7= i 254 S AL A (XA BE
IR G o

HR: ERIF-REHN, FESWES: AN WM, 2N %5
ARG S o F sl A N AE IS S V5 1) 65 4 e A5 gl ieg, - )
ANSEIRIEEN . F)E, 7EHE “RIF” (Refresh) i, 7= gify&ik
MR TR RE, JEH, ERITer, SBREE (B M.

FEGHE R I H _ESAT A

“PREIGEMIRE” (Model Structure Report) 11 o] fLEF7EITH _EJAT I#AE
I TR AR AT T TAEX R I H IRRA, IS AR T H A a8
ERRAS o FTAETH H AT R AT R XS (0% AN T H o T A4 A
A EANTCERWIE (iR LR EAE.

AN “PERIZERIIRE ” (Model Structure Report) (1) LA X A AT
SRS EC (DR AP
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“F8” (Information) 7y — (£ “#AE” (Actions) #|HH) Bk
SE T H 45 B TR

“Miti” (Check Out) 8y — (FE T EAEF) JFah FUR H 3% 2 10 H (1)
BAE O Wom TSR At AR X 5 (0 FH P St

“UiR” (Edit) 7 — (FETRAEA) HEIBI S R gnR s . D0k
AT H A RedwdE eI “fi i Bk

o T “REEIZEFIIR” (Model Structure Report) 123 3145 [a] i A< H o
AT H AR

FERSERS ey b A it i

“f58” (Information) @ — (f£ “#1E” (Actions) #") Worik
SE T H 45 B TR

“USInB| THEX” (Add to Workspace) P FETH & F) BorH
TR TAERBINI K “UimE] T/EX” (Add to Workspace) 7 [

“Ftgg” (Promote) B — ({ET HALID) Gk “QIBFEER”
(Create Promotion Request) % I, #1] DLZE RS T+ TR 464 0 H T
25 20 (1) A i IR A B R AR

“FEEN” (Save As) W — ((ETHAT) SR A VFEAS S0 A
SE BRI “BEER” (Save As) F T

“Bzh” (Move) 1 — (FE T HAA) WoR RVFECK IR H B 2087
B “B3)” (Move) &

B BU N A TR — AN MR G by vh AL iR i, i R s :

“rEH4E” (Single Level Report) i Box “CAD XRFHFR”
(CAD Document Parts List), X 2#ERE b R RE B 81K . CRANER
P 2 I A A I HAE D — A H RS . O

= CAD M HE#H#II5R

7R #HeEE LUNCH_TRAY.ASM (Demo Organization) - lunch_tray.asm A
xthElF BT RE

lunch_tray.asm A1 1.0

tray. prt A1 1.0
lid. prt AZ 10
cup.prt A1 1.0
plate. prt A3 10

7E Windchill #4335 H
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“ZZ%AME” (Multi Level Report) Bl — 5k “CAD CARY4EE L7
(CAD Document Indented Structure), IXJ&YRNG B R0 2513 .

® = CAD EHBEGH

HPHEH #HeF LUNCH_TRAY.ASM (Demo Organization) - lunch_tray.asm A
g I L B EE

a

1
1
1
1

... lunch_tray.asm A1 1.0
...... tray. prt A1 1.0
...... lid. prt AZ 10
...... cup.prt A1 1.0
...... plate.pt A3 1.0

%t CAD 3CRYHFT WTPart 8H4T 67 % Flds =

H PR AT e R AR M ke % 00H . Kk, Pro/ENGINEER
Wildfire SCHFPURN SR, I LA i Fr 8@ iy H - (CAD SCRaliAl
AR AT AT . H IR TS 7 2 A A TP SRR PR AE A I 0
H iy & A 5 10 578, A 3 H P SR 0558 24 1 H

SN E M IE TR Y e A ol N = L R s W (ER BN N T

AT B S8 S A I A T LUK T (1) 1 44 B8 5 1 B, AF A I 1
(Ml 55 52 e 25 7 PRI G B

TX VUit 44 AN 5 SRS T LA SR 4
BRI TR

CAD U4 5 H CAD X% 5 £ ity (OOTB Bt s 2 i)
Fefit

CAD CRY4 FRIFIER B M Pro/ENGINEER #5584 B S skl ok . AT LA
FRAf 5 2 52 3O e 44 (prt) CHEREAN B PERERD .

ANV BB A4 5 WTPart 45 42 B a4 41t

A A 42 FR BRI AN G ALl AR I F) CAD SR 44 5 F4 24 iy
EHE BN WA CAD SCR IR P AR SO e 44, Wy RASE #
KA AR T B Sy A GRS B ERERD .

FEATA A M gm FH - S, CAD SCRY AL AR “ 27”7
(Name) 7B 0] gm (1)

TEATAT B Mg H] P S b, “9%5”  (Number) 7 Boe ANl 4
B
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7E Windchill #4335 H

H 5145 /& OOTB fir 44 4 5 5% o

FRIKEN

CAD X F4%i"5 M\ Pro/ENGINEER A7 Z FREZ Hifok (i LAEFF L
P R4 — EEEA B D

CAD SCRYZ PRI ERIAE M Pro/ENGINEER #5:8 &Z Fr G il sk (nf
LEFE Y R4 — AN @ ED

AV AE G BRI CAD SCRY g 5 =Mk (T RLE S0 F
Vs — hEA B D

AV A A2 TR AT ER AR M B AN 48 15 ) CAD SCRY 44 Bk 1R 24 i
HEHIMR (TUAEF U R4 — A EEEEED

TEATA G gmta 7 i, CAD SCRYAIMN ) “ZFR”
(Name) fl “#455” (Number) 7B n] i ) gnti

SIS

CAD SCFi%i 5 )\ Pro/ENGINEER 487 {1241 (1 INI il
PROENumberingParameter {51 ) [ & il 1 2K

CAD SR A FRIIMEM Pro/E $82 1S40 (i INI Ii
PROENamingParameter {51 & 11K

ANV G 5 B IBA - CH INT 33
AutoAssociateNumberingParameter 151D FI{E & il 2K o

A2 FRIAE M IBA CH INI 5l AutoAssociateNamingParameter
PO IR K

FEATA] G A g F 7 AL, CAD SCRYFIANE BRI “ 48R
(NAME) fl “%q*5” (NUMBER) 7Bt 0l th H /- g o

ER: DRSNS LS S X REHI AT H SK s H B, R
XU H LI H QU o 7ERTaG B3 CAORIERR SR a1
Bt CAD SCRSIN ) AEBIOCHE CAOfRYE CAD ST AIEUFT Al S
D I RE, A L5

Custom

AlIE SR FNE RS ” (Object Initialization Rules
Administrator) 5 7€ & B H dr 4 Mg 5, XA T oAb REE
i H R Jm e e BOME I . 2 )5, & Windchill fi# 477 24
BEZRR I H I, R BRAE . X SSRRTEFR A o A 45 )
AV B — it H S R B . S H T2 50 H 1) Windchill fi#
YT ARV B N AR, A2 N W & R
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— B E R SORBEE R, I AR R SCERAEAS R 1 iy 44 R
Gii 5 S

— AN, b ST B AT LLSE H Windehill #4484 (fdFH Windchill A
SZRIRMLED » LAASVFR BT CAD SCRY R LR N2

. G5
. 4
.

HR: “XZYIAHNZEHESS” (Object Initialization Rules
Administrator) th T3 & H 8% 5 50, 1A FRIRS)FI S 500K 5 S s
7F Windchill INI 3Cf: 35 5E

ANEAE APl 42 RN 2 5 SR, U QIR I H I, RGEME—TELR S
Bk CAD SCRY I g5 R SCA 44 Bk J& P 34 4 25 #F. Windchill Foundation
A1 PDM ¥k £, Windchill PDMLink 3 55840 Windchill ProjectLink
T H rhE—

BRI S WVEAE R, WS W (Windchill FHEPEZIFH) 1“5
il F1%5 2L Pro/ENGINEER Wildfire” —ZH 1] “4# CAD SCAYF! WTPart
[ % Mg s —15.
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HVCER

CAD 3(#4
7E Windchill 1, CAD SCRY 2T 52 B# 0] Axdn A2 & I H ,
‘B S CAD B, Hi—A ok —4140 3 CAD W FHREP #2015 B S
-,

Windchill TEX
Windchill F11#% X3, F 70 AR BRAT 55 (1) [R] i A A (1 SC k. T4
X A VF#EAE Pro/ENGINEER H P FHif R EE AT e 2 AT H - LR
ATIEAR R B & B . TAEX AR B 247 H S FH P eSS 2% -
[ F DX R SO Rl e — AN IRGS 4 Bl Re LA TAEIX

A
FAARVGBAE REAT ORI/ NRAS . iltun, T0H (1) A2 BUARTR R 28 1T
A TS AN INRCA

R SERHTH
7E4% Pro/ENGINEER SCAF 3 A 2R 7 5] Windchill TAEX I, Fr{Rff
()L SCAE T BEE A AR LS T KRR B TAEX g se - (fian, a7
RERS S T 3E/C P 0 AN T 00, DRyl AR A7 2 TAEIX D

IXLEZ BT ZRRI SO RO AN TSR CAD SCRY AN 52 H , FFAE
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